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1-1

Introduction

The MA4000 Installation Manager User Guide provides the information
needed to operate the Installation Manager application.

The following topics are included in this chapter:

Chapter Topics ® MA4000 Installation Manager Overview
e How This Guide is Organized
e MA4000 Installation Manager Application Abbreviations

MA4000 Installation Manager Overview

The MA4000 Installation Manager application is designed to assist our
NEC Associates/Partners and our NEC customers in gathering,
correlating, customizing, validating and implementing their installation
plan. This tool expedites the process of gathering this information,
customizing it, and then turning the information into system
programming. The number of hours required by a system technician
using Maintenance Administration Tools to program the system is
greatly reduced using the MA4000 Installation Manager. The larger the
system, the greater the benefit.

The MA4000 Installation Manager contains a high level of import and
export capabilities allowing sharing of information with many other
types of applications. Using these capabilities makes it possible to easily
re-use the information in other NEC Unified Solutions, Inc. products, as
well as common tools such as Microsoft Excel.
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1-2 Introduction

How This Guide is Organized

Chapter 1
Introduction

Chapter 2
Getting Started

Chapter 3
Graphical User Interface

Chapter 4
Project Information

Chapter 5
Hardware Information

Chapter 6
System Information

Chapter 7
Advanced Features

Chapter 8
User Assignments

Chapter 9
Group Assignments

Chapter 10
Circuit Card Assignments

Chapter 11
Install

Chapter 12
Reports

Chapter 13
Productivity Features

This chapter outlines how to use this manual, including actual manual
organization, chapter layout, keyboard conventions, function keys, and
basic terminology for the MA4000 Installation Manager application.

This chapter explains the hardware and software requirements of
MA4000 Installation Manager, and lists the steps needed to install the
application.

This chapter provides an overview of the various interfaces of the
MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Project
Information section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Hardware
Information section of the MA4000 Installation Manager Software.

This chapter describes the fields and buttons contained in the System
Information section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Advanced
Features section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the User
Assignment section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Group
Assignments section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Circuit
Card Assignments section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Install
section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the Reports
section of the MA4000 Installation Manager software.

This chapter describes the fields and buttons contained in the
Productivity Features section of the MA4000 Installation Manager
software.
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MA4000 Installation Manager Application Abbreviations

CCIS

CSR

DM

DTl

FCCS

FCH

GUI

IM

IM Project (or just Project)

IM Project Template

LCN
LDM
LMG
MAT
mc
MG
MPS
MSDE
NCN
NDM
UMG

Common Channel Inter-office Signaling
Customer Service Representative

Data Memory

Digital Trunk Interface

Fusion Call Control Handling

Fusion Call Handler

Graphical User Interface

Installation Manager

A project is the set of data that is associated with a specific installation.
It is assumed that an installation corresponds to a single customer.
Therefore, each customer/installation should have its own project.

A project is not stored in a single file as you might expect (as it is in
Microsoft Access or Microsoft Excel). As data is collected, the
information is stored in the Microsoft Desktop Engine (MSDE) which is a
server-based database. The management of this information will require
some features within the application to access, remove, and backup this
information.

This is the database containing all information for a particular
installation. It includes all templates, all customer users, and related
information to the installation.

Local Control Node

Local Data Memory

Local Module Group

Maintenance Administration Terminal
Media Converter

Media Gateway

Multi-Purpose Server

Microsoft Desktop Engine — a mini SQL Server
Network Control Node

Network Data Memory

Ultra Module Group
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Getting Started

This chapter lists the hardware and software requirements necessary to
operate the MA4000 Installation Manager. The chapter also provides the
steps needed to install the MA4000 Installation Manager application.

Chapter Topics e Requirements
e MA4000 Installation Manager Installation

e Inijtializing the Flash Card and Installing the System Software
(SV7000 MPS Only)

Requirements

MA4000 Installation Manager contains a feature called Localization. This feature is
——— transparent to the user. When a user installs MA4000 Installation Manager, the user

will be prompted for different markets (language, basic data, etc.). For example, in

IMPORTANT order to have a different language, NEC will need to send to the user a package of
files containing a utility to translate all the English descriptions to the new language.
The user will then need to perform the language translation and modify the basic
data to the files, then send it to NEC. After NEC receives the updated package, NEC
will re-complle the MA4000 Installation Manager with the new language and basic
data.

MA4000 Installation Manager requires Microsoft SQL Server Desktop Engine
—— (MSDE) 2000. If a database server is already installed then you might be required to
remove any conflicting database servers. Keep in mind the MA4000 Installation
IMPORTANT Manager will be compatible with SQL Server 2000 but the operating systems
identified in Table 2-1 will not support MS SQL server. A server class operating
system is required to support SQL Server 2000.

MSDE 2000 is available to install from the MA4000 Installation Manager CD.

In order for the MA4000 Installation Manager to operate properly, your
operating environment must meet the requirements listed in Table 2-1.
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Table 2-1 System Requirements

Minimum Recommended

Operating System
Windows 98

Note:This is the bare minimum operating system.
Windows NT 4.0 (Service Pack 5 or later)

Windows 2000
(Service Pack 3 or later)

Window XP Professional
(Service Pack 1 or later)

Note:This is the preferred operation system.
Note: Other Windows operating systems may work, but will not be supported because of testing

limitations. Users of Windows ME and Windows XP Home Edition will probably be able to
successfully run MA4000 Installation Manager but these are not considered business operating

systems.
Processor
Pentium 400 MHz Pentium 700 MHz
Memory
64 MB 128 MB, or more
Hard Drive Space (available before installation)
250 MB 300 MB, or more
Monitor
800x600 SVGA 1024x768 SVGA
Web Browser (for support only)
Any HTML 1.1 compliant Internet Explorer 5.5, or greater
Ethernet Port
10/100 MB Ethernet Port for connecting to SV7000-T and SV7000S
Serial Port
For configuration of Peripheral Hardware (MC, MG, VS)
Modem
For SV7000-T software registration
PCMCIA Card Slot
Intel compatible PCMCIA card slot for use when initializing SV7000-T Flash Card

Database
Microsoft MSDE 2000 (Included on CD-ROM)
Additional Hardware
CD-ROM CD-ROM 2x, or higher

Mouse and 101 Keyboard Mouse and Keyboard
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MA4000 Installation Manager Installation

To install MA4000 Installation Manager for the first time, use the
installation CD included in your MA4000 Installation Manager package.
You must run Setup from within Windows.

pa3%) Be sure to close all open Windows programs and screen savers and disable any
é virus detection programs before using the Setup program.
NOTE

The following procedure walks you through the MA4000 Installation
Manager installation. The Setup consists of a series of dialogs that
supply you with default answers to questions regarding the installation
of files to your hard disk. To accept the default answers, click the Next
button. To make changes, click the Browse button and select a different
directory, then click OK button to return to the dialog box.

The following procedure assumes you are starting the Setup program
from your computer’s CD-ROM drive D:. If you start from a different
drive, substitute the letter of that drive in this procedure.

Step 1 Launch Microsoft Windows 98, Windows 2000 or Windows XP
Professional.

Step 2 Place the MA4000 Installation Manager CD in the CD-ROM drive.

Step 3 Click the Windows Start button and select Run.... from the pop-up menu.
The Run (Figure 2-1) displays.

Figure 2-1 Run

Run @El

= Type the name of a program, Folder, document, or
Inkernet resource, and Windows will open it Far you,

8] 4 H Cancel H Browse. .. ]

Step 4 Type D:\Setup in the Open text box (as shown in Figure 2-1) and click
the OK button. The Installation Manager R25 - InstallShield Wizard
Welcome displays (Figure 2-2).
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Figure 2-2 Installation Manager R25 - InstallShield Wizard Welcome

Installation Manager R25 - InstallShield Wizard %]
Inztallation Manager B25 [Yerzion 25.0.1)

The InstallShield® wizard will install Installation kM anager
R 25 on vour computer. To continue, click Mest,

et » | Cancel

Step 5 Follow the prompts in the Setup program to accept the software licensing
agreement, to enter your customer information, and to select the setup
type. The Setup program copies the required files to your hard drive.

Step 6 The Installation Manager R25 - InstallShield Wizard Complete displays
(Figure 2-3) after the Setup program has finished copying files to your
hard disk.
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Figure 2-3 Installation Manager R25 - InstallShield Wizard Complete

Installation Manager R25 - InstallShield Wizand

InstallShield Wizard Complete

Setup haz finizhed inztaling Installation Manager B25 on vour
conputer.

Finizh |

Step 7 Click the Finish button. The Installation Manager R25 - InstallShield
Install Feature(s) displays (Figure 2-4).
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Figure 2-4 Installation Manager R25 - InstallShield Install Feature(s)

Installation Manager R25 - InstallShield Wizard
Install Feature[s]
Select the dezired feature(z] to install

v Reqistration "izard
[v License Verfication Tool

[v LIC Suite Service Component(z)]

¢ Back | et = | Cancel

Step 8 Select the appropriate check box to install the desired feature. After
MA4000 Installation Manager finishes installing each selected feature,
you can now run the MA4000 Installation Manager program.
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Initializing the Flash Card and Installing the System Software
(SV7000 MPS Only)

The following procedure contains a step which can result in the loss of existing data
on your computer if performed improperly. This step is indicated with a Caution
symbol. If you are unsure whether you understand the step completely, contact the

CAUTION NEC Technical Assistance Center (NTAC) before proceeding.

Introduction and Requirements

The SV7000 MPS ships with an empty ATA flash card. Before you start

the server, you must initialize the card and load it with system software
the server requires to run. Then, you use the flash card to transfer the

system software to the server itself.

This procedure requires the system software CD (supplied with your
system) and a laptop PC with a PCMICIA card slot. Your laptop PC must
be configured to boot from the CD drive.

To configure your PC to boot from a CD, you may need to change the boot drive
= order in your computer’s BIOS. You can usually display the BIOS settings screen by
pressing a specific key during the boot sequence.

For specific information on configuring your laptop to boot from a CD, consult your
computer’s documentation.

The SV7000 MPS runs the Linux operating system. When you boot from
the supplied system software CD, your laptop will also be running Linux.
You can then use Linux to initialize the flash card and transfer the MPS
system software to it.

You should also be familiar with the NEC Maintenance and
Administration Terminal (MAT) application. For specific information on
using the MAT, consult its online help documentation.

Major Tasks

The following lists the major tasks you will complete when you initialize
the flash card and load system software on the MPS:

¢ Boot your laptop from a CD containing the Linux operating system.

¢ Use the Linux command line interface to format the flash card.

e Copy the MPS operating system files to the flash card.

¢ Insert the flash card in the MPS server.

e Connect your laptop directly to the MPS.

e Copy the system software from the flash card to the MPS.

¢ Specify the MPS’ new TCP/IP network settings.

e Restart the MPS using the new network settings.
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Step-by-Step Procedure

To initialize the flash card, install it in the server, and load the MPS
system software do the following:

Step 1 Insert the MPS system software CD into your computer, then reboot.

—Linux status messages display, followed by a video mode prompt.

Step 2 Press Space to accept the default video mode. A keyboard selection

prompt displays.

Step 3 Press Enter to accept the default keyboard configuration. A Linux

command prompt displays.

Step 4 Enter root as the login ID, then enter xxxx as the password (the

IMPORTANT

password entry will not display on the screen).

—The Linux command prompt changes to #, indicating you are logged in
as a root user.

You must enter these values exactly as they are shown here because the Linux
operating system, unlike Windows, is case-sensitive. That is, root and Root are not
identical.

Be careful to enter the values in the remaining steps exactly as they are shown,
including spaces.

Step 5 Type the following at the command prompt, then press Enter:

/bin/dmesg | grep hd

—A list of configured devices on your PC displays, designated hda, hdb,
hdc, etc.

Step 6 Use the list of displayed devices to locate your laptop’s hard drive and

IMPORTANT

CD-ROM drive. Write down their designations (hda, hdc, etc.) so you will
remember them.

It is critical you correctly identify your CD-ROM and internal hard drive from the list of
displayed devices. You will need the correct designation in later steps to select which
device will be formatted.

Linux identifies drives on your computer with the hd designation, plus a letter starting
with a and continuing alphabetically. Commonly, the internal hard drive is hda and
the internal CD-ROM is hdc. However, your configuration may be different. You can
identify your drives using the information displayed after the previous step. For
example, here is a possible drive listing:

hda: HTS54809349, ATA disk drive

hdc: Samsung CDRW-DVD, ATAPI CD-ROM drive

hda: HTS54809349, 76319MB w/ 7877kB cache

hdc: ATAPI 24X DVD-ROM CD-RW drive, 2048kB cache
hda: hda1, hda2

This listing shows the internal 80MB hard drive as hda. You can easily identify the
CD-ROM drive as hdc.
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Step 8

Step 9

Step 10

Getting Started 2-9

Type the following at the command prompt, the press Enter:
mount /dev/hdc /mnt/cdrom

Replace hdc in the command, if necessary, with the designation your
laptop uses for the internal CD-ROM device.

—Linux mounts the CD-ROM and informs you the device is read-only.

Type the following at the command prompt, then press Enter:
Imnt/cdrom/MKINIT

After a few moments, the MKINIT finish message displays.
Insert the flash card in your laptop’s PCMCIA card slot.

—Linux reads the card and displays its size and drive designation (hde,
etc.). You will need this drive designation in Step 11.

Press Enter to return to the command prompt (#).

This next step will destroy any existing data on the specified device. Be certain you
have not entered the designation for your laptop’s hard drive when typing this
command.

CAUTION

Step 11

Step 12

Step 13

Step 14
Step 15

Step 16
Step 17

Type the following at the command prompt, then press Enter:
MK_FLASH hde

Replace hde in the above command, if necessary, with the drive
designation your laptop displayed for the flash drive after you inserted
the card.

—You can ignore the DriveReady and DriveStatus error messages.

—The write finish status message displays when the flash card
initialization completes. This process may take 20-30 minutes.

Remove the flash card from your laptop.
—You can ignore the resulting error messages.

Type the following at the command prompt, the press Enter:

exit

Remove the MPS system software CD from your laptop.

Reboot your laptop in the normal manner.

—After it reboots, it should be running the Windows operating system.
Be sure the MPS is OFF, then insert the flash card in the appropriate slot.
Turn the MPS ON.
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Step 18 Connect an ethernet cable between your laptop and the Ether1 jack on
the front of the MPS.
—You must use a crossover Ethernet cable, not the more common
straight-through type.
Step 19 On your laptop, open the Network (or Network Connections) control
panel.
Step 20 Change your laptop’s network settings to the following:
IP Address: 192.168.0.5
Subnet Mask: 255.255.255.0
Default Gateway: 192.168.0.254
Step 21 Close the network control panel to save the new settings.
Step 22 Launch the PC Pro by doing one of the following:
—Open Installation Manager, then select PCPro... from the Tools menu.
—Locate the PCPro application on your hard drive (if previously
installed) and launch it.
Step 23 Log on to the MPS using its default IP (192.168.0.1), leaving the user
and password fields blank.
Step 24 Enter the ADTM command in the PCPro to display the default switch
configurations.
Step 25 Change the MPS’ IP address, subnet mask, and default gateway
address to the appropriate values for your network.
Step 26 Click Apply.
gD Even though the values appear to revert to their default values, they have in fact
= been changed. This is because although you have changed their value in the MPS’s
NOTE memory, they have not yet been stored to the flash card.
Step 27 Enter the SINZ command in the MAT, then select System Initialize
(Reboot).
Step 28 Click Execute. A confirmation dialog displays.
Step 29 Click Yes. The MPS reboots.
—During this time the ACT light flashes GREEN and the Load light is
RED.
—The MPS is not ready until the ACT light remains solid GREEN.
Step 30 Change your laptop’s TCP/IP network settings back to their original

values for use on your network.
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Graphical User Interface

This chapter provides an overview of the components of the MA4000
Installation Manager software.

The following topics are included in this chapter:

Chapter Topics e General Graphical User Interface Features
Startup Dialog

Pull-Down Menus

Primary Sections

General Graphical User Interface Features

Data Navigator

The Data Navigator control allows you to easily go from item to item in a
list. There are buttons allowing you to go to the beginning and the end
of the list using a single button click.

The Data Navigator always displays information in the form [last
selected row] of [total rows] (see Figure 3-1).

Figure 3-1 Data Navigator Single Select example

Last Mame ° | First Mame | Organization
A0 HIEE Accounting - Rec
A0 STEVE E ngineering - Har
ADARMS JOHH Accounting - Finar
ADARS JAMES Accounting - Pay:
BILL JOHM E ngineering - Soft
BILL JAMES E ngineering - Soft
BLDG-A COMFEREMCE ROOM

BLDG-B COMFEREMCE ROOM

BREAK. ROOM

COD, FIMLEY Arccounting - Fec
SKMITH SamMDY Accounting - Final
SMITH BETTY Accounting - Pay:
SKMITH JOHM E ngineering - Hare
SKMITH MIKE Arccounting - Fec
WALLIAR S MARGARET Accounting - Final
WS TARAS J&STIN & remnmbinn - Fikan
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If multiple rows are selected the display will be listed in the form [last
selected row] of [total rows] (see Figure 3-2).

Figure 3-2 Data Navigator Multi Select example

Last Mame ° | First Marme | Organization

MIEE Accounting -
ADAM STEWE Engineering - Hard
ADAMS JOHH Azcounting - Finan

Accounting -

BILL JOHM Engineering - Softy
BILL JaMES Engineening - Softy
BLDG-A COMFEREMCE ROOHK

BLDG-E COMFEREMCE ROOM

BREAK ROOM

CODA, FIMLEY Accounting - Rece
SAaMDY Accounting - Fi
SMITH BETTY Accounting - Payal
Engineering -

SKITH kIEE Accounting - Rece
WLLIAR S Accounting - Fi

Sl LA RAC ATk Mot bmm Chmmen

Example: If the list is displaying Row #1 at the top of the list, and the
user has made the selections from top to bottom, the last row
selected would have been Row #12.
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Selecting

All list boxes will support the ability to multi-select items. There are two
ways to multi-select items:

Step To select a range of rows that are consecutive:

—Select the first item in the range

—Hold the Shift key and select the last item in the list. All items in
between will be selected. In Figure 3-3, the fourth item in the list and
then the seventh item were selected while holding the Shift key. All
items between were selected.

Figure 3-3 List Box Contiguous Select example

Last Mame ° | First M ame | Crganization
ADAM kIK.E Accounting - Rec
ADAM STEWVE Engineering - Har
ADAMS JOHM Accounting - Fina
ADAMS JAMES Accounting - Paw
BILL JOHH Engineering - Sofl
BILL JAMES Engineering - Sofl
BLDG-A COMFEREMCE ROOHK
BLDG-B COMFEREMCE ROOK

EHE.-“—‘-.K ROOM

FIHLEu

WILLIAMS MﬂHGﬁHET
WA TARAS &SR & rren abitn - Fika
Step Another method is to choose multiple items by selecting rows while

holding the Control key. This allows the selection of non-consecutive
items. In Figure 3-4, the fourth, sixth, and eighth items were selected.

Figure 3-4 List Box Multi-Select example

Lagt Mame | Firzt Mame | Organization
AL MIKE Accaunting - Rece

STEY E nagineering -
ADAMS JEIHN Aocounting - Finar

Accaunting - Pay:

BILL JD H N Engineering - Safk,
AE S Engineering - 5af
BLD G- I:EINFEFIENEE ROOK

BLDG-B COMFERENWCE ROOHK

BREAK ROOM

COD, FIMLEY Aocounting - Rece
SkITH SaMDY Aocounting - Finar
SkITH BETTY Accounting - Paya

If you choose an operation, such as clicking the Edit button, you will be
editing all the selected records in a smaller list. Figure 3-5 displays how
this would appear if you chose four items from the list, and then clicked
the Edit button.

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



3-4 Graphical User Interface

Figure 3-5 Edit Multiple Records example

> |51 | | |

Edit Information here

List Box Sorting

All lists will have the ability to sort. Clicking on the title bar of a column
causes the list to be sorted alphabetically by that column. A second click
will reverse the sort order. Clicking in a different column will cause the
list to be sorted by that column. There will be an arrow in the column
currently being sorted. Figure 3-6 indicates the Status field is being
sorted alphabetically. Another click on the title would cause the sort to
reverse and the arrow would be pointing UP instead of DOWN.

Figure 3-6 List Box Sorting example

St. | Description | Phase
Closed Meed more Zone Transcevers in Warehouse )

Bob Vaughan wants to have a\Whits 160 Senisz i, |1 |
Open Meed to check waith FKathy in the HR department re... 1
Started Meed to replace their exsting Bogen Amplifier (100... 2

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



Graphical User Interface 3-5

Startup Dialog

MA4000 Installation Manager projects are not comprised of a single file
like a spreadsheet or document. Instead, the project is consists of
information contained in a database. To support this, your are given the
Installation Manager Startup (Figure 3-7) to perform basic management
on MA4000 Installation Manager projects.

Figure 3-7 Installation Manager Startup

Installation Manager E|

Frojects l Templates ]

Select Project
MName | M odified Categary Created =T
[rpart
Delete
Delete Al

@ Projects created from this tab uze the MEC default template. To create a

project bazed on another kemplate, zelect a template from the Template tab. Fefrezh

ak | Cancel |

¢ Projects tab
The projects listed here were created using the default template.
e Templates tab

The projects listed under this tab were created using a template
based on criteria other than the default template.

You have the ability to have multiple instances of MA4000 Installation
Manager running. However, each instance will only be allowed to edit a
project that is not already opened.

Once the user opens a project Figure 3-7 disappears. To open another
instance of MA4000 Installation Manager, you must return to the
shortcut used to launch MA4000 Installation Manager. The MA4000
Installation Manager installation will place a shortcut on the Windows
Start Menu.
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Projects Tab

Figure 3-8 Projects Tab

Import Project @ @

Loak, in: |_,'|l Projects ﬂ I'ji *

A Intial.imp

by Recent
Documents

—

¥

Maclban

New button

You will have several choices to make. Some of the most powerful
features of MA4000 Installation Manager is the ability to re-use previous
data. When a new project is defined, it can be defined from an existing
project so you do not have to start with an empty project. Clicking the
New button displays the Welcome to the Create Project Wizard (Figure
3-9).

Figure 3-9 Welcome to the Create Project Wizard

Create Project Wizard E|

Welcome to the Create Project
Wizard

Thiz wizard will guide you through the project creation
process

being inztalled. Pleaze be prepared to answer

@ Some bazic information i needed about the systemm
questions about the hardware being installed.

| et » | Cancel
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Create Project Wizard

Step 1 The Welcome to the Create Project Wizard greets you and informs you
that the wizard will be guiding you through the steps necessary to create
a new project. The panel also warns you that some basic information will
be needed to complete the wizard. Click the Next button to continue. The
Create Project Wizard - Project Name and Type dialog box (Figure 3-10,
Figure 3-11, Figure 3-12, Figure 3-13 or Figure 3-14) displays.

Figure 3-10 Create Project Wizard - Project Name and Type - NEAX IPX and NEAX IPX DM

Create Project Wizard

Project Hame and Type *::I""
Pravide a unique name ta identify thiz praject and bpe of sustem. {:I_'"
Project Mame ||

Example: ComparyMame_06_08_03

Spstem Type |Business Supstem

Lo

Hardware Type |NE.-i'->< IF

L

Phzical Chazsis Count |1

Led Lo

Wirtual Chazziz Count | 1]

[ Usze Phazed lnstallation

¢ Back | Mext > | Cancel
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Figure 3-11 Create Project Wizard - Project Name and Type - NEAX IPX UMG

Create Project Wizard

Project Hame and Type Lo
Provide a unique name to identify thiz project and tepe of system, i

Froject Mame |

Example: CompanyMame_06_08_03

Syztem Type |Business Syztem j

Hardware Type |NE.-'1'-.><{|F‘?>< MG j

[ Use Phazed Installation

< Back | M et > | Cancel
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Figure 3-12 Create Project Wizard - Project Name and Type - UNVERGE IPX

Create Project Wizard

Project Hame and Type {_}_.T
Frovide a unique name to identify this project and type of system. {:}'

Project Mame |

Example: Companyiame_06_03_03

System Type |Eusiness Custern

L

Hardware Type |LINI‘-.IEF|I3E [F

L

Phyzical Chasziz Count |1

L Lo

Yirtual Chasziz Count | I}

[ Use Phazed Installation

< Back | M et > | Cancel
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Figure 3-13 Create Project Wizard - Project Name and Type - UNIVERGE SV7000

Create Project Wizard

Project Hame and Type
Pravide a unique narme ko identify thiz praject and twpe of susten.

Project Mame |

Example: ComparywMame_06_08_03

Systemn Type |Business System j

Hardware Type |[RI2[E=S=]E] =

Phsical Chazsis Count | 1] ﬂ

System b aximum Capacity | 300 ports j

[ Usze Phazed |nstallation

< Back | Mest » |

Cancel
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Figure 3-14 Create Project Wizard -Project Name and Type - UNIVERGE SV8500

Create Project Wizard E|
Project Hame and Type 4:_1.
Frovide a unigque name to identify thiz project and type of system. {:1_""
Praoject Mame |

Example: CormpanyMame_06_03_03

System Type |Business Syztem ﬂ

Hardware Tope |(HI81E%
Phyzical Chaszziz Count |EI j
System b aximum Capacity | 384 ports ﬂ

[ Use Phazed Installation

< Back | M et > | Cancel

Step 2 The Create Project Wizard - Project Name and Type dialog box allows
you to enter a name for the project.

—Enter the project name in the Project Name field. The name must be
unique. There must not be any other projects using this name.

—Select the system type from the System Type drop-down menu.
* Business System
* Hospitality System
—Select the system type from the Hardware Type drop-down menu.
* NEAX IPX
+ NEAX IPX DM
* NEAX IPX UMG
* UNIVERGE IPX
+ UNIVERGE SV7000
* UNIVERGE SV8500

—Select the physical chassis count from the Physical Chassis Count
drop-down menu.

+ NEAX IPX/NEAX IPX DM / UNIVERGE IPX: 1 to 16
* UNIVERGE SV7000 / UNVERGE SV8500: 0, 1, 2, 3, and 4

) Select the 6U Physical Chassis check box if your system uses a 6U-size physical
= chassis. (Not available on NEAX IPX, NEAX IPX DM, or UNIVERGE SV8500)
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« NEAX IPX UMG: None

—Select the maximum chassis count from the Virtual Chassis Count
drop-down menu.

+ NEAX IPX/NEAX IPX DM/ UNIVERGE IPX: 0, 1, 2, and 3.
* NEAX IPX UMG: None

—Select the maximum system capacity from the System Maximum
Capacity drop-down menu.

* NEAX IPX/NEAX IPX DM / NEAX IPX UMG / and
UNIVERGE IPX: None

+ UNIVERGE SV7000: 300, 750, 1000, 1500, 2000, 2500, 3000,
3500, 4000, 4500, 5000, 5500, and 6000

+ UNVERGE SV8500: 384, 768, 1152, 1536, 1920, 2304, 2688, 3072,
3456, 3840, 4224, 4608, 4992, 5376, 5760, and 6144

—Select the Use Phase Installation check box to enable the phased
installation.

» All Systems Types: Available.
Click the Next button to proceed. Figure 3-15 displays.

Figure 3-15 Create Project Wizard - Project Category and Notes

Create Project Wizard E|
Project Category and Hotes 4:1.
Provide zome infarmation to help describe this project. {:}""
Cateqaory
Motes

@ Y'ou can categorize thiz project with a descriptive name and

provide notes by entening infarmation in the fieldz abowve.

< Back | et » | Cancel

Step 3

Step 4

The Create Project Wizard - Project Category and Notes allows you to
provide additional information about the project, and permits you to
categorizing the project.

Click the Next button to proceed. Figure 3-16 displays.
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Figure 3-16 Create Project Wizard - Customer Locations

Create Project Wizand

Customer Locations :1. .
Provide customer site information to help with the placement of telephones. {,1"
™ Building Level 1 |City
(" Building, Floar Level 2 |Building
(" Building, Floaor, Section Lewvel 3 |FI|:u:|r
{e" City, Building, Floor, Section Lewvel 4 |Sectiu:un
" Other Level 5|
¢ Back | Mext > | Cancel

Step 5 The Create Project Wizard - Customer Locations is similar to the
Customer Organization (Step 6). It allows you to specify locations for all
telephone so they can be accurately delivered to the necessary
locations. This information is also very important when cabling personnel
have to complete the end to end connectivity from the telephone to the
Voice Server system.

Click the Next button to continue. Figure 3-17 displays.
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Figure 3-17 Create Project Wizard - Customer Organization

Create Project Wizand

Customer Organization :1. .
Provide organization chart information to help manage large amounts of uzers. {,1"
" Group Level 1 |Eu:um|:uan_l,l
(" Department, Group Level 2 |Divisi-:un
" Divizion, Department, Group Lewvel 3 |Department
f» Company, Divizion, Department, Group Lewvel 4 |Gru:uup
" Other Level 5|
¢ Back | Mext > | Cancel

Step 6 The Create Project Wizard - Customer Organization allows you to name
the levels in a customer's organization. It is very similar to naming the
levels in a company's organizational chart. These levels are used heavily
to sort out relevant data. This is particularly powerful when there are
large numbers of phones/employees and the user is trying to set up hunt
groups based on a department within the company.

Click the Next button to continue. Figure 3-18 displays.
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Figure 3-18 Create Project Wizard - Voice Mail

Create Project Wizand E|
Voice Mail :1. .
Select the type of voice mail syztem for this project. {:}""

Select the vaice mail svztem to be used in this project. A default terplate will be
uzed far all voice mail uzers. Additional voice mail templates can be created later.

Yoice Mail Sestemn || R AR

< Back | et » | Cancel

Step 7 The Create Project Wizard - Voice Mail allows you to choose from any
supported voice mail system. Current selections include:

<None>
<Other Voice Mail>

NEAX Mail AD-64 - A voice messaging system providing ViewMail®,
ViewMail for Microsoft® Messaging, ViewMail for Lotus® Notes®,
ViewMail for GroupWise®, and ViewCall® Plus (Windows 2003-based).

UM8500 Exchange Message Store - A voice messaging offering
powerful productivity features such as VideoMail, Find Me Follow Me and
Desktop Call Control (IP-based).

UM8500 SQL Message Store - A voice messaging offering powerful
productivity features such as VideoMail, Find Me Follow Me and Desktop
Call Control (IP-based).

UNIVERGE UMA4730 - A voice messaging system providing
TeLANophy® modules, ViewMail®, ViewMail for Microsoft® Messaging
and ViewCall® Plus (PC-based/Linux OS).

Click the Next button to proceed. Figure 3-19 displays.
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Figure 3-19 Create Project Wizard - Customer Contact Information

Create Project Wizand

Customer Contact Information Lo
Provide information to help identify the cuztomer contact, {'}'
Compary || Address |
Contact | |
Title | |
Fhore | Ext City |
Fax. | State ZIP
E -t ail | Country |
Motes
< Back IWI Canicel

Step 8 The Create Project Wizard - Customer Contact Information allows you to
enter details about the customer that is custom to this new project.

Click the Next button. Figure 3-20 displays.
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Figure 3-20 Completing the Create Project Wizard

Create Project Wizard @

7% Completing the Create Project
Wizard

You have successfully completed the Create Project 'wizard.

To cloge thiz wizard, click Finish

< Back | Finizh | Cancel

Step 9 The Completing the Create Project Wizard is the last panel you will
encounter as part of the Create Project Wizard.

Click the Finish button to end the Wizard and return to Figure 3-7.
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e Import button
Step 1 Click the Import button as shown in Figure 3-21.

Figure 3-21 Projects Tab

X

Installation Manager

Frajects l Templates ]

Select Project
Mame | t adified Farmily | Categary Created Hew
Irpart
Delete
Delete Al

@ Projects created fram thiz tab use the MEC default template. To create a

project bazed on another template, zelect a template from the Template tab. Fefrezh |

] | Cancel |

Figure 3-22 displays.
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Figure 3-22 Import Project

Import Project

Look in: |l.f,\ Projects j cF EF-
_2 Inkial.irmp
by Recent
Documents
FT__:
Desktop

7,

iy Documents

ky Cormputer

-

My Metwaork. File name: | ﬂ ﬂl
Placez
j Cancel

Filez of type: |Installatinn Manager Project*.imp]

Step 2 Select an existing project and click the Open button. The selected
project now appears in the Select Project: section of the Installation
Manager Startup.

o Delete button

Step 1  Select a project from the list located in the Installation Manager Startup
(Figure 3-7).

Step 2 Click the Delete button. Figure 3-23 will display.

Figure 3-23 Delete Project Confirmation

Confirm Delete X

\:‘i) Are you sure ywou wank ko delete Inkial?

Yes Mo |
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e Delete All button
Step Click the Delete All button. Figure 3-24 will display.

Figure 3-24 Delete All Projects Confirmation

Confirm Delete [%|
?) Are you sure wou want ko delete all Tkems?
- / ¥ ¥ .
Yes Mo |

¢ Refresh button

Clicking the Yes button deletes a project entirely and removes the project from the
database. The project cannot be recovered.

WARNING

The Refresh button performs a new search in the database to
discover all projects defined on the current personal computer. The list
will be updated with the latest information.

e OK button

The OK button will open the selected project and make it available for
editing.

e Cancel button

The Cancel button is used to abort opening any project. You will need
to re-launch the application using MA4000 Installation Manager
shortcut.
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Templates Tab

Figure 3-25 Templates Tab

X

Installation Manager

Projectz Templates ]
Select Template
Mame % | Family | Categony M e
Import
Delete
Delete Al
Refrezsh |
k. Cancel |

e New button

Highlighting a template listed in the Select Template: section, and
clicking the New button, will show the same Figure 3-9 through Figure
3-20 dialog boxes as the Project Tab displayed. This option provides
you the opportunity to modify the imported template to meet your
specific requirements.

e Import button
Step 1 Click the Import button. Figure 3-26 displays.
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Figure 3-26 Import Template

Import Template @

Loak ir: ||.f,\ Templates ﬂ Iff -
4 2 Standard.imk
ky Recent
Diocurnents
;[':
Desktop

P Metwork, File narme: || j
Flaces
Filez of type; |Installatin:-n M anager Template(”. imt) ﬂ ﬂ

Step 2 Select the template to import from those templates listed, and click the
Open button.

e Delete button

Step 1  Select a template from the list located in the Installation Manager Startup
(Figure 3-7).

Step 2 Click the Delete button. Figure 3-27 will display.

Figure 3-27 Delete Project Confirmation

Confirm Delete X

\_'.‘:) Are you sure you wank ko delete Standard?

Yes Mo |
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e Delete All button
Step Click the Delete All button. Figure 3-28 will display.

Figure 3-28 Delete All Projects Confirmation

Confirm Delete [%|
:{/ Are yau sure you wank ko delete all Tkems?
Yes Mo |

e Refresh button

Clicking the Yes button deletes a template entirely and removes the template from
the database. The project cannot be recovered.

WARNING

The Refresh button performs a new search in the database to
discover all templates defined on the current personal computer. The
list will be updated with the latest information.

e OK button

The OK button will open the template project and make it available
for editing.

e Cancel button

The Cancel button is used to abort opening any template. You will
need to re-launch the application using MA4000 Installation Manager
shortcut.
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Pull-Down Menus

File Menu

Edit Tools Help

Create Project...
Open Project, .. I_ _

Project...
Template, ..

The File pull-down menu contains these file functions:

¢ Create Project...
e Open Project...
e Save As

— Project...

— Template...
o Exit

Edit Menu

The Edit pull-down menu (Figure 3-29) contains the common functions
typically found in stand-alone applications.

Figure 3-29 Edit Menu

File B8 Tools Help

Cut (Ctrl+X)

Step 1  Select an item (this could be the context of a text box, or it could be
multiple items in a list).

Step 2 After a selection is made, press the Ctrl and X keys to place the contents
in the Windows Clipboard.

Step 3 You can now paste the contents to another location, such as another
windows application, or to another location within MA4000 Installation
Manager.
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Copy (Ctrl+C)

Step 1  Select an item (this could be the context of a text box, or it could be
multiple items in a list).

Step 2 After a selection is made, press the Ctrl and C keys. A copy of the
selected item(s) is placed on the Windows Clipboard.

Step 3 You can now paste the contents to another location, such as another
windows application, or to another location within MA4000 Installation
Manager. See Paste (Ctrl-V)

Paste (Ctrl-V)

Step 1  Place the curser in the field or in the row below where the contents of the
Windows Clipboard is to be pasted.

Step 2 If an item is selected, then the past operation will replace the selected
item. In the case of a list box, the contents of the clipboard will be pasted
above the cursor location.

The contents of the clipboard must have the same number of columns as
the destination list box. If it does not have exactly the same number of
columns, the operation will not occur.

Tools Menu

The Tools pull-down menu (Figure 3-30) contains the Flash Card
Wizard, Registration Wizard, PCPro, License Verification Tool,
Clipboard, and Network Manager functions.

Figure 3-30 Tools Menu

Flash Card Wizard. ..

Reqistration Wizard,., (ver.1.20.0.2)
PCPra...

License ‘erification Toal...

Clipboard. ..

Metwork Manager. ..

Flash Card Wizard ...

The Flash Card Wizard does not work on MPS due to MPS being Linux-based. See
Registration Wizard ... for procedure to upgrade the system.

WARNING

UNIVERGE SV8500 is not supported by the Flash Card Wizard function.

The Flash Card Wizard option provides the tools to:

e Format and write new program files to a new flash card
e Upgrade the program files by reading program files to the personal
computer and modifying the files using Explorer to write to the flash
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card, or backup data by reading data from the flash card to the
personal computer. See Figure 3-31.

To launch the Flash Card Wizard, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation
Manager 24 > Flash Card Wizard.
OR

Step From the Installation Manager Menu Bar, click Tools > Flash Card
Wizard ....

Figure 3-31 FLCVTR Initial

#7+ FLCVTR Initial

1.Initial Installation

*Flash card is formatted and written new program files. Execute ‘

2.Program Upgrade

*Head program files from the flash card into the PC and Execute ‘

modify the files via Explorer to write into the flash card.

[Reading/Writing per program data type cannot be available.]

3.Data Backup

*Aead data files from the flash card to the PC. Execute

‘Writing the data files into the flash card is also available.

[Read { Write cannot be performed on a data kind basis.]

The flash card installation needs to be installed using the MPS System CD-ROM.

IMPORTANT

o If the Initial Installation Execute button is clicked, Figure 3-32
displays.
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Figure 3-32 FLCVTR Initial Installation Execute

#+ FLCVTR 1.Initial Installation
File  Opkion

File Converter

Partition Size[MB]

60 M

Flash Card M

Folder j Browse

Step 1 Insert an unformatted flash card into an available PCMCIA slot. Ensure
you insert a flash card prior to launching the FLCVTR program in order to
display the PC’s PCMCIA slot for the Flash Card field.

Step 2 Click the Browse button to locate the file containing the program to be
written to the flash card.

pa3%) If defining the partition size is necessary, select the appropriate size from the pull-
= down menu located in the Partition Size (MB) field. Normally, the Partition Size
(MB) field is not visible, choose the Option menu item and select the PartitionSize
Select option to make the field visible.

Step 3  Select the PCMCIA slot for the flash card.
Step 4 Click the Set button to write the program to the flash card.
Step 5 After pressing the Set button, Figure 3-33 displays.
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Figure 3-33 Setting INITDATA

X

Sefting INITDATA

IP Address |

MetMask |

[ DefaultGYW used

Step 6 Enter the IP Address, Subnet Mask and Gateway of the SV7000, then
click the Set button.

2 This option only applied to the SV7000, and is not available for a NEAX 2400 IPX.
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o If the Program Upgrade Execute button is clicked, Figure 3-34
displays.

Figure 3-34 FLCVTR Program Upgrade Execute

#+ FLCVTR 2.Program Upgrade
File Cption

File Converter

Drive
v A:Program

Flash Card |, - 3

o | .
I+ TT7

Set ‘

Folder | j Browse

v D:Program

Step 1 Insert the flash card containing the program files into an available
PCMCIA slot.

Step 2 In the Drive field, choose the drive containing the program files and the
location where the files are to be written.

U= If the Drive field is not visible, choose the Option menu item and select the Drive
@' Select option.

Step 3  Select the PCMCIA slot for the flash card.

Step 4 Click the Browse button to locate the folder or CD Drive where the
Program Files are located.

Step 5 Click the Set button to load the Program Files to the Flash Card.
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o If the Data Backup Execute button is clicked, Figure 3-35 displays.

Figure 3-35 FLCVTR Data Backup Execute

. FLCVTR 3.Data Backup [=E3
File Option

File Converter

Drive
r
Flash Card  [JNEEERE - | ¥ B:Data
[ C:Data
Get ‘ -
J L 1T

Folder | j Browse

Step 1 Insert the flash card containing the program files into an available
PCMCIA slot.

Step 2 Inthe Drive field, choose the drive containing the office data files and the
location where the files are to be written.

= If the Drive field is not visible, choose the Option menu item and select the Drive
Nis Select option.

Step 3  Select the PCMCIA slot for the flash card.

Step 4 Click the Browse button to locate the folder where the office data files
will be written.

Step 5 Click the Get button to write the office data files located on the flash card
to the location selected.
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Registration Wizard ...

P The Registration Wizard screens that display for the UNIVERGE SV8500 system will
= be different from the screens shown in the following example.
NOTE

The Registration Wizard connects your system to the NEC
Registration Service and obtains your Activation Code. See Figure 3-36.

To launch the Registration Wizard, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation
Manager R25 > Registration Wizard.

OR

Step From the Installation Manager Menu Bar, click Tools > Registration
Wizard ....

Figure 3-36 Welcome to the Registration Wizard

MEC Registration Wizard

Welcome to the Registration
Wizard

Thiz wizard enables pou to activate your System.

'ou will be guided through gatherning the System
infarmation neceszan to activate the zoftware features
that you purchazed. The ‘wizard will prompt vou for
infarmation that allaws ug ba provide pau with quality
TEVICE,

Orice your information is registered, the wizard will guide
wou through the activation of wour system,

Tao continue, chick West,

Mext > ][ Cancel

Step 1  Select the Next button to proceed. Figure 3-37 displays.
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Figure 3-37 NEC Registration Wizard - We Want To Know About You

MEC Registration Wizard

We want to know about you...

The filling out of information required far registration af wour
MEC Solution iz divided inta three parts:

*  Site Information
*  Azzociate [nformation
*  Accredited Techhician Infarmation

Thiz infarmation will be used to provide you with quality
and rezponzive service should the need ever arige.

bl andatory information iz denoted by an astensk, other
infarmation i optional buk can tuly enhance the zervice
that MEC can provide.

information, you will not be able to complete

'j [f you do not have all of the neceszsary
the regiztration process.

To continue, click Mest.

< Back ” Mext » ][ Cancel

Step 2 Select the Next button to continue. Figure 3-38 displays.
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Figure 3-38 NEC Registration Wizard - Site Information

MEC Registration Wizard

Site Information

Fleaze enter the information requested belove zo that we may better zerve you,
Required fields are denated by an asterisk.

“Cuztormer Site Mame [Lse Mame Printed on the Software C0

“Azzociate Contact Mame

“bzzociate Contact Phone Mumber

< Back ” Mext » ][ Cancel

Step 3 Enter the site information requested. Those fields denoted with an
asterisk require an entry.

Step 4 Click the Next button to continue. Figure 3-39 displays.
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Figure 3-39 NEC Registration Wizard - Complete Your NEC Registration

MEC Registration Wizard

Complete your NEC
Registration

Thank. pou far campleting the required infarmation. 'ou
may fiow complete the registration process.

i Y'ou will heed to be connected to a telephone
\r) line via a modemn o continue,

The Wizard will connect ta the MEC Reaiztration Service
to regizter pour information. During this connection, the
MEC Redqistration Server will provide a System Activation
Lizenze [PAL).

- Pleaze shut down ary other applications that
may be uzing vour modem at this time.

To continue, click Mest.

< Back ]| Mext » |[ Cancel

Step 5 Click the Next button. Figure 3-40 displays.
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Figure 3-40 NEC Registration Wizard - Select System to Activate

HEC Registration Wizard

Select System to Activate
Select a Spstem from the list below,

Select a Spstem from the List below, [ pou zelect a Default System, you will be
prampted for connection details in the form af either a COM Part, IP Address or
Fodemn Mame

() Direct Connection ta the System COM Part COm1 i
BAUD Rate: | 4800 "
() IP Connection to the System |FP Address:

(") Modem Connection ta the System
tadem Mame Dialing Murnber

R etrieve or Edit Connection Profile

< Back ” MHext > ][ Cancel

Step 6 Select the appropriate system from the list provided.

—Direct Connection to the System. Enter the communication port and
baud rate.

—IP Connection to the System. Enter the IP address.
The IP address entered here will determine the system information that will display

= when Get System Information is selected in Step 8.

—Modem Connection to the System. Select the modem type, enter
the dialing number, and create, edit or retrieve a connection profile.
Click the Save Connection button to save the modem profile.

Step 7 Click the Next button. Figure 3-41 displays.
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Figure 3-41 NEC Registration Wizard - Gather Security Codes from System - SV7000 Example

Gather Secunty Codes from System
Click the button to connect to pour Syztem and obtain the Hardware and
Software Key Codes.

MEC Registration Wizard

[ et System [nformation

[

Feady

Hardware F.ey Code

Software Key Code

# HECs 1 #5ECs 1 SYSTYPE: 5Y7000

¢ Back ” M et > ][ Cancel

Step 8

Click Get System Information to connect your system and obtain/
update the hardware and software key codes, then click the Next.
Figure 3-42 displays for all systems except UNIVERGE SV8500.

For UNIVERGE SV8500, when Next is clicked, the Choose Options to
Activate Your UNIVERGE SV8500 dialog displays providing options for
obtaining/uploading the needed SVI.zip file or for proceeding directly to
the UNIVERGE 8500 Activation Step.

—If you do not already have a SVI.zip file, use the Obtain SVI File steps
listed in Table 3-1 to retrieve the license file.

—If you have a SVI.zip file and want to upload it to the UNIVERGE
SV8500, use the Upload SVI File steps listed in the same table.

—If you wish to skip the two options above and proceed directly to the
UNIVERGE SV8500 Activation Step, use the Activate steps listed in
the table.
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Table 3-1 Options to Activate the UNIVERGE SV8500

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Obtain SVI File

Login to the License
Management Server
(LMS) and download the
SVi.zip file.

Load the SVI.zip file to the
UNIVERGE SV8500.

Obtain the Key Code File
from the UNIVERGE
SV8500.

Upload the Key Code File
to the LMS and obtain the
Activation Code from the
LMS (either by web
display or e-mail).

Register the Activation
Code to the UNIVERGE
SV8500.

Step 1.

Step 2.

Step 3.

Step 4.

Graphical User Interface 3-37
Upload SVI File Activate
Load the SVI.zip file to the| Step 1. Upload the Key Code File
UNIVERGE SV8500. to the LMS and obtain the
Obtain the Key Code File Activation Code from the
LMS (either by web
from the UNIVERGE display or e-mail)
SV8500. piay :
.| Step 2. Register the Activation

Upload the Key Code File

to the LMS and obtain the g%%% the UNIVERGE
Activation Code from the '

LMS (either by web

display or e-mail).

Register the Activation

Code to the UNIVERGE

SV8500.
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Figure 3-42 NEC Registration Wizard - Registration Information

HEC Registration Wizard

Reqgister Information
The wizard will now connect to the MEC Registration Service and obtain your
Activation Code.

tadem Configuration

todem Mame Registration Server Dialing Mumber

| 8| |

Default; 1-214-262-4336

[ Connect to MEC Reaistration Server ] () By Modem () Ew TCPIP

[

Ready

Activation Code |

< Back ” MHext > ][ Cancel

Step 9 In the Modem Configuration Section, enter or select the correct
information into the Modem Name and Registration Server Dialing
Number fields.

Step 10 Click Connect to NEC Registration Server and obtain the Activation
Code.

—The modem defined in Step 9 calls into the server and retrieves the
Activation Code, or you can select the By TCP-IP option button to
connect using that method.

—The activation code will display in Activation Code field after
successful registration with the NEC Registration Service.

Step 11 Select the Next button. Figure 3-43 displays.
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Figure 3-43 NEC Registration Wizard - Activate Your System

MEC Registration Wizard

Activate your System

[f wour Systemn Activation License was successiully
granted from the MEC Registration Service, it must now be
entered into the System.

The Wizard will connect ta your Systen and enter in the
System Activation License into it's securty system. our
Syztem will then be activated and ready for condiguration
and uze.

& If pou did not connect ba the MEC Registration
\l;) Service and recieve pour PAL, you may
temporarily activate your System for 3 Days by
uzing the Unlock button on the nest screen.

To continue, click Mest.

< Back ” Mext » ][ Cancel

Step 12 To activate your system, click the Next button. Figure 3-44 displays.
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Figure 3-44 NEC Registration Wizard - System Activation

MEC Registration Wizard

System Achivation

[f the Activation License figld iz ermphy vau may either go back and connect ta the
MEC Redistration Server or kemporarnily activate using the Unlock buthan,

FE:

[ Send Activation Licenze é

[

Feady

Hardware K.ey Code

|
|
Software Key Code |
|
|

¢ Back ” Meut » ][ Cancel ]

Step 13 Select the Send Activation License button to activate your system.

Step 14 Select the Next button to proceed. Figure 3-45 displays.

If the Activation License field is empty, you can either go back and connect to the
= NEC Registration Server or temporarily activate your system with the Unlock button.
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Figure 3-45 NEC Registration Wizard - Congratulations

MEC Registration Wizard

Congratulations!

MEC welzames you ta the ECP family.

MEC iz dedicated to prowiding "'Communications without
Compramize’ and customer service bepond compare. YWe
are here to empower you bo provide innovative solutions to
wou customers. |f pou ever have any suggestions or
concerns, do not hesitate to contact us.

MELC iz conztantly enkhancing our zoftware, providing
cutting edge applications and moving towards a truly
Enterprize 0pen Metworl,

Call us, Email Uz, andYisit Us At

1-800-TEAM-LUSA

ME&2400@necunified. com
hittp: # A necunifiedsolutions. com

To exit thiz wizard, click Finizh. Wiew Log

Step 15 Click the Finish button to exit the Registration Wizard.

PCPro ...

The PCPro provides centralized online HTML-based programming access,
allowing administraators to manage terminals, schedule maintenance
and firmware updates, and remotely make moves, additions, or
changes.

Experienced users who wish to use the PCPro to send commands
directly to the switch can launch it from within Installation Manager.

To launch the PCPro, do the following:
Step 1 Launch the Installation Manager. The Startup dialog displays.

Step 2 Select an existing project or create a new project. The Installation
Manager main screen displays.

Step 3 Select Tools > PCPro.... The PCPro launches and displays as a
separate application.
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License Verification Tool ...

SV8500 does not support the License Verification Tool function.

e —

The License Verification Tool provides a brief summary of the primary
licenses that are available (and in use) on your SV7000 system.

This tool is for planning purposes only and should not be construed as any legal
definition of the number of licenses that a customer has purchased or is entitled.

To launch the License Verification Tool, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation
Manager R25 > License Verification Tool.

OR

Step From the Installation Manager Menu Bar, click Tools > License
Verification Tool ....

Clipboard...

Installation Manager now provides experienced users with integrated
access to the MAT Clipboard application. You can use this tool to access
MAT commands and transfer information directly to the Voice Server or
work offline and upload all changes at once.

The Clipboard can save command data from the Voice Server as XML
(Extensible Markup Language) files. You can then edit the XML files
using Microsoft Excel and upload the modified data back to the Voice
Server. Many MAT commands are time-consuming when programmed
individually. Using the Clipboard to download and upload the command
data in a single operation can make many tasks more efficient. For
example:

e Create an off-line XML file containing a large number of new users,
configured using the ASDT and AKYD commands, then upload the file
to the Voice Server.

¢ Transfer data from an old Voice Server to a new Voice Server by
downloading user data, editing it off-line, then uploading it to the new
Voice Server.

For more complete information on using the Clipboard, refer to its user

== — .
%;ﬁ\ documentation.
=\
=

REFERENCE

The Clipboard application (Figure 3-46) speeds system installations and
eliminates errors by importing data from one switch to a destination
switch.
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Clipboard has been enhanced to be able to perform batch downloads.
You have the ability to:

e Download data from the switch based on categories (for example,
Station Data, Trunk Data, Restricted Data, etc.)

¢ Add commands the data needs to be download to a list that would be
run as a batch process.

e Save selected commands in user template files for future access.

This enhancement lessens the work needed when downloading data for
the same set of commands.

To launch Clipboard, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation
Manager R25 > Clipboard.

OR

Step From the Installation Manager Menu Bar, click Tools > Clipboard.

Figure 3-46 MAT Clipboard

B MAT Clipboard - EEX

File Edit  Tools Help E: -.' J |(Work0ﬂ|ine)

Network Manager...

The Network Manager is used to manage existing networks while using
Installation Manager to install and manage new networks.

The Network Manager application is intended to enhance the capabilities
already present within Installation Manager, but it does not require
Installation Manager in order to perform its task. Network Manager can
function in a stand-alone mode and has the capability of integrating
nodes into the Fusion (FCCS) Network whether or not the connecting
node was originally programmed using the MAT, the Installation
Clipboard application, or Installation Manager.

Use of this software is normally conducted as follows:

Step 1 Install NCN PBX using Installation Manager (optional).

Step 2 Install LCN PBX using Installation Manager (optional).

Step 3 Create FCCS Network using Network Manager (optional).

Step 4 Insert LCN node into existing FCCS Network using Network Manager.
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Help Menu

The Help pull-down menu is the place to go for assistance or
information.

Help Index ...

The Help Index... option displays the HTML, context sensitive help for
the MA4000 Installation Manager application.

View Log File ...

The View Log File... option lists the current MA4000 Installation
Manager log build information.

View User’s Guide ...

The View User’s Guide... option displays this MA4000 Installation
Manager User Guide as a PDF.

About MA4000 Installation Manager ...

The About MA4000 Installation Manager... option displays the
application’s version and copyright information (Figure 3-47).

Figure 3-47 About MA4000 Installation Manager

About MA4000 Installation Manager, E|
IM MA4000 Installation M anager
Yersion 25.0.002

Copyright © 2003-2008. MEC Infrontia, Inc.

Wharning: This computer program iz protected by copyright law and international treaties. This
goftware may not be reproduced, distibuted, decompiled, dizaszembled, reverse engineered,
ar modified in any wayw. Yiolations may result in zevere civil and criminal penalties, and will be
prozecuted to maximum extent pozzible under the law.
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Primary Sections

The buttons located along the left side of the graphical user interface in
the Main window (see Figure 3-48) contain the core functions of MA4000
Installation Manager. This is where you will view, manipulate, and
prepare the data to be sent to the system.

Figure 3-48 Primary Sections Tabs

m Installation M4

File Edit Tools H

Project
Information

Hardware
|nformation

System
[nformation

Advanced
Features

IJzer
Azzignments

Group
Azsignments

Circuit Card
Azzignments

Inztall

Repaorts

Productivity
Features

When a button is selected, a tab view appears for each running
horizontally across the top (see Figure 4-2). This information is a logical
break down of the main button selected on the left.

The following chapters will describe in detail every button and its
purpose.
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Project Information

This chapter describes the MA4000 Installation Manager’s Project
Information section (Figure 4-1) tabs.
Chapter Topics e Primary Contact Tab

Company Organization Tab
Tasks Tab

Phased Installation Tab

Figure 4-1 Project Information Tab

m Installation Manager E“§|El

File Edit Tools Help

Project
Information Primary Contact

Company Organization |Tasks| Phazed Inztallation |

Hardware Compary | Address |
Infarmation

Contact | |

Syztem Title: | |

Infiormation
Phare Ext City |
Advanced P State ZIF

Feat
eatures £ il |

Country |

Uzer Motes
Azzignmentz

Group
Azzignmentsz

Circuit Card
Azzignments

Irstall

Reparts

Praductivity
Features
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Primary Contact Tab

The Primary Contact tab (Figure 4-2) is used to provide contact
information for a single person who will be the central point of contact
for the entire installation. Nothing on this tab will be transferred to the
system. It is only provided to centralize the information for the
installation.

Figure 4-2 Project Information - Primary Contact Tab

Primary Contact Company Organization | Tasks | Phazed Inztallation |
Company | Addresz |
Contact | |
Title | |
Phone | Ext City |
Fau | State ZIP
E-tail | Country |
Motes
Company field

Enter the primary contact’s company name.

Contact field

This is the name of the individual who is the primary contact for the
customer.
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Title field
Enter the primary contact’s title.

Phone field
Enter the primary contact's primary phone number.

Ext field
Enter the extension, if any, of the primary contact.

Fax field
Enter the facsimile phone number for the contact.

E-Mail field
Enter the contact’s e-mail address.

Address field

Enter the primary contact person’s address. There are 3 boxes available
for entering the full address (i.e. street, P.O. Box, building number, mail
stop, etc.)

City field
Enter the city where the contact is located.

State field
Enter the state where the contact is located.

Zip field
Enter the zip code for the contact’s mailing address.

Country field
Enter the country where the contact is located.

Notes field

This is a free form text box allowing you to enter any information that
maybe useful. You might want to enter a secondary contact, cell phone
information, or other meaningful information. The field might also be a
convenient spot to place notes concerning dates/times/outcomes of
conversations.
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Company Organization Tab

The Company Organization tab (Figure 4-3) provides you with set
fields allowing you to describe the company. This is usually information
on the company where the system is being installed.

Figure 4-3 Project Information - Company Organization Tab

Primary Contact Company Organization | Tashs | Phaged [nztallation |
Locations
Buiding " | | | | Edi
Mew
Delete
Configure. ..
Organization
Group 5 E dit
M
Delete
Caonfigure...

Locations section

The Location section displays a tree view of the information representing
the placement of telephone stations. The tree view can be thought of as
an address of sorts. To locate where someone lives, the country, state,
zip, street, and street number must be known. In the same fashion, a
telephone station must be easily located. This section provides the
means to break the company down into various locations. Some thought
should be given for the logical break down of the locations where
telephone stations will be installed. This information might be different
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for each installation. In Figure 4-3, the locations are broken down by
Building then by Floor.

The maximum number of levels supported is five.

This information will be used in reports to help identifying locations for
all telephone stations.

o Edit button

Before the Edit button can function, an entry in the Locations tree
view must be selected. After selecting an entry, click the Edit button.
Figure 4-4 displays. You must close this dialog before continuing with
any other tasks.

Figure 4-4 Edit Location

Edit Location

General l

City
|Irving, Texag

Building
|f-‘-.

Floor
|3rd

Sechion

|P'a_l,lr|:|II
Level 5

k. | Cancel

As shown, you are allowed to modify the entry selected.
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¢ New button

The New button will allow you to define a new location.
See Figure 4-5.

Figure 4-5 New Location

Mew Location fz
General l

City

Building

Flaar

Section

Level &

| k. | Cancel

If the location already exists, you will receive an error message stating
the location exists. You will be given the opportunity to make a change
or cancel.

You have the option to add a new location and remain in the New
Location Dialog. You simply click the OK button and the new location is
added.
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e Delete button

To use the Delete button, you must first select a branch or a leaf
element of the tree. Clicking the Delete button will display the
Confirmation - Delete This Item (Figure 4-6). If the user clicks the
Yes button, the node will be removed, and any of its children.

Figure 4-6 Confirmation - Delete This ltem

\__?JJ Are you sure you wank bo delete this ikem?

Yes | Mo |

Selecting the Yes button will remove the element selected, and all
components beneath it, but will not abort the operation.

e Configure button

The Configure button allows you to define the names of the levels
within the customers organization. Figure 4-7 displays the dialog used
to define the organization levels.

Figure 4-7 Edit Location Labels - General

Edit Location Labels

General

|nztallation b anager supports up to & location levelz. These
levels need to be zet to values that match the customers
lozation az close as pozsible. Thiz infarmation will make
lozating phones much eazsier.

Example names for levels in an location chark:
Building
Building, Floar
Building, Floar, Section

Level 1 m

Level 2 |Euilding

Level 3 |F||:u:|r

Lewvel 4 |SE|:tiu:un

Level5|

K, | Cancel
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Organization section

The Organization section allows you to define the company structure
from an organization point of view. You can break the company down
into departments, divisions, and groups. Its flexibility allows you to
break items down in the best way possible.

The bottom half of Figure 4-3 displays a tree view of a defined
organization. This tree view should closely follow the organization break
down in a company.

o Edit button
To use the Edit button, you must select a node in the tree view. When

Edit button is clicked, Figure 4-8 displays. You will be able to modify
the name of that node.

Figure 4-8 Edit Organization - General

Edit ORGANIZATION

General l

Company
Kz

Divizion

|Develupment

Department

|.-i'-.pp|i|:ati|:|ns

Group

|S oftware

Level 5

k. | Cancel

If you change the Division name to a new Division name, that will
create another division.
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¢ New button

The New button is used to create a new entry into the company
organization. You can define a new Division using this dialog. See
Figure 4-9.

Figure 4-9 New Organization - General

NMew ORGANIZATION

General l

Company

Drivizion

Department

aroup

Level &

| k. | Cancel

¢ Delete button

You must select the element in the Organization tree view, then click
the Delete button. Figure 4-10 displays.

Figure 4-10 Confirmation - Delete This Item

\_:;:/ Are wou sure you wank to delete this item?

Yes | Mo |

Selecting the Yes button will remove the element selected and all
components beneath it, but will not abort the operation.
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e Configure button

The Configure button allows you to define the names of the locations
within the customer’s buildings. Figure 4-11 displays the fields used to
define the organization levels.

Figure 4-11 Edit Organization Labels - General

Edit Organization Labels

General

Inztallation kanager suppaorts up to 5 arganization levels.
Thesze levels need to be zet to values that match the
clgtomers organization az cloge as possible. This
infarmation will make lacating phones much easier.

Same example names far various levels in an arganization
chart are:

Divizion

Divigion, Department

Divizgion, Department, Group

Level 1

Leve| 2 |D ivigian

Level 3 |D epartment

Lewel 4 |Gr|:|up

Level B |

(0] 4 | Cancel
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Tasks Tab
The Tasks tab (Figure 4-12) allows you to create a task list to manage
items that must be completed to have a successful installation. Each
row in the list box represents a task.
Figure 4-12 Project Information - Tasks Tab

Frimary Contact | Company Drganization Tasks FPhazed |nstallation |

K] <] BE Edt | Mew | Delele

Statuz  / | Description | Phasze | Eeqin | Due | Completed

£ >
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Project Information

e Edit button

In order to use the Edit button, a task must be selected. The Edit

button will allow you to modify a task. Figure 4-13 displays a task
being edited.

Figure 4-13 Edit Task

Edit Task

General l

Statuz
:

Dezcription

&3

Phaze

S

Begin Date

|Need Additional Desl Labels for 32 button telephone

1104172007

Mates

D Date Complete D ate

.| o220 .| [onoszo07 ]

k. | Cancel

Selecting the Browse button for the Begin Date, Due Date, or Complete Date fields

causes an Edit Date dialog box (Figure 4-14) to appear. Use this pop-up calendar to
select the appropriate date for each field.
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General l

Select Date
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Fri
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e New button

The New button will add the current information to the task list. Click
the New button, and Figure 4-15 displays.

Figure 4-15 New Task - General

New Task [5__(|
General l
Status FPhaze
| Open j |1
D'ezcription

|Need Additional Desl Labels for 32 button telephone

Beqin D ate Due Date Complete D ate
[10/1/2007 .| [1nA2s2007 .| [10s0/2007
Motes

] | Canizel

Once a task has been added, the status selected (Open, Started,
Testing, or Closed), and the Begin, Due, and Complete dates
chosen, click the OK button to return to the Tasks Tab.

e Delete button

The Delete button removes the current task from the task list. See
Figure 4-16.

Figure 4-16 Confirm Delete - Delete The Current Selected Task(s)

Confirm Delete X

L] "_'q Are wou sure you wank ko delete the current selecked bask(s)?
[

Yes | | Mo |
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Phased Installation Tab

CAUTION

The Phased Installation tab is intended for advanced users only!

The Phased Installation tab (Figure 4-17) allows the Installation
Manager (IM) to add additional user station data, MG devices, and
Circuit Cards to an existing Voice Server database. The user can install
the Voice Server data in different phases. The user and circuit card
assignments can be assigned to different phases. The other basic data
(access code, numbering plan, etc.) are for Phase 1 only.

Phased installations are intended for larger installations or Voice Server
conversions projects that must be implemented in distinct stages over a
period of days or weeks. Phased installation differs from a standard
installation in the fact that during a phased installation Installation
Manager will synchronize with the Voice Server and reconcile any
problems before uploading new data to the Voice Server.

If you do not turn on the phase feature, all functions act as they did with
the previous version of Installation Manager.
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Figure 4-17 Project Information - Phased Installation Tab

Phasze 1 User Data + Hardware Installation
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e Edit or New button

When the Edit or New button is clicked, Figure 4-18 displays.

Figure 4-18 Phased Installation - New or Edit Button

General l

Phaze

[ Date Committed

Dezcnption

|F'hase 1 Uszer Data + Hardware Installation

Maotes

3

o ]

Cancel

4-17

— Enter the appropriate information, as needed, in the Description

and Notes fields.

— After uploading the data, the corresponding phase will be marked
as Date Committed. The check box can be cleared to resume the

same phase data upload again.

gonss Once a phase is uploaded, Installation Manager marks the phase as committed and
= enters the date that the phase was uploaded. Remember, this does not mean the
NOTE phase data has been uploaded to the switch.
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Hardware Information

This chapter describes the MA4000 Installation Manager's Hardware
Information section tabs (see Figure 5-1).

Chapter Topics e Options Tab

Media Gateway and Circuit Cards

Voice Mail Tab

Security Tab

Figure 5-1 Hardware Information Tab

m Installation Manager E”E”gl

File Edit Tools Help
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Attendant |.-’-‘«ccess to Attendant (Operator Call) j |EI Syztem Mame |LUMG
[RE
Assignments IP Phane Type | TOM Only =]
o Mame Dizplay |Filst Mame + Last Mame j Mame Dizplay Length | 16 Character -
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Connect Type
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Baud Rate | 4.300 - FPassword Setup IP...
Productivity
Features
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Options Tab

Use Figure 5-2 (Options Tab) to configure miscellaneous system options.

Figure 5-2 Hardware Information - Options Tab

VeeeMsi | Secuiy |
T

UMIMERGE 547000

MCH - Metwork, Control Mode rLizian Poing Coels
Access to Attendant [Operator Call] - Syrona
IF P-F + 5IF

First Mame + Lazt Mame 16 Character

17216 253, 0

Project Name field

This is the name of the project database. You can change the database
name, but is recommended it remain as the name of the database. This
field is used in many reports to identify the installation the data is
associated with.

System Type field

Valid choices are NEAX IPX, NEAX IPX DM, UNIVERGE IPX, UNIVERGE
SV7000, NEAX IPX UMG, and UNIVERGE SVv8500.
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Dual CPU check box

Select to identify when redundant SV8500 and SV7000 T10 processors
are used.

Dual Time Division check box

Select to identify when redundant SV7000 T10 processors are
multiplexing.

6 Unit (6U) Physical Chassis check box

» Checked - Indicates 6U Physical Chassis’s are to be used.

—_—) —

» Unchecked - Indicates 9U Physical Chassis’s are to be used

SV8500 does not support 6U chassis configuration.

System Options section

This section determines how the system will be programmed, and what
commands will be used. It is used in reporting and consists of:

¢ Fusion - Use the Fusion drop-down menu to specify the type of
Fusion network to which your system will connect. The option is not
available on SV7000 MPS. Select one of the following:

— NCN - Network Control Node (Fusion Network NCN)

— LCN - Local Control Node (Fusion Network LCN)

— Standalone - NEAX IPX/IPX DM or UNIVERGE IPX only
¢ Fusion Point Code (LCN Only)

If the system is to be an LCN in a Fusion Network, select an
appropriate Fusion Point Code. It is useful to provide a technician this
information so the system can be configured to support these
features.

e Attendant

— Access to Attendant (Operator Call) - This is the humber of the
company’s operator. This number will be referenced in several
areas as a macro. It is used heavily in templates such as Call
Forwarding.

— Use Monitored Number as Attendant
e System Name field

This is the name of the system. This information will be assigned
internally to the system.
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e IP Phone Type field

Allows specification of the IP Phone support needed in MA4000
Installation Manager. This setting determines what options are made
available in other areas of MA4000 Installation Manager.

Example: If there is no IP Phone support needed, you will not have the
option of viewing IP Phone Models in the Phone Model List on
the User Edit Dialog.

The IP Phone Type options will consist of a combination of the
following:

TDM

Requires a PIR. Time Division Multiplex phones are NEC non-IP, circuit
card based Dterm or analog phones.

IP P-P
IP Peer-to-Peer phones are NEC IP phones not requiring circuit cards.
SIP

Session Initiated Protocol are NEC or other vendor IP phones which
conform to SIP standards.

¢ Name Display and Name Display Length fields

Specify in the Name Display and Length fields the default format for
users with phones having Name Display support.

Connect Type section

This section allows you to specify the communication interface used to
connect to the system.

e TCP/IP option
— Address - IP address of the SV7000 T10 or IPX
— Port - 60000
¢ Direct option (requires serial cable and is not used for SV7000)

— Comm Port - Serial COM port of the PC which the MA4000
Installation Manager is operating on.

— Baud Rate - Default value is 4800
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User ID and Password fields (optional)
The User ID and Password fields can be used if authentication is

required.
pa33) The following options can only be used after the software has been successfully
= installed and the system is online.

Test button

Clicking the Test button performs a verification of the system
connection selected. If the test connection fails, Figure 5-3 displays.

Figure 5-3 Test Connection - Login Failed

Test Connection E|

@ Login Failed:

Device fFailed to Connect,

Setup IP... button

Clicking the Setup IP ... button allows the user to configure the active
and standby IP addresses, subnet mask, default gateway, speed, duplex
mode, and the ARP broadcasting period (no send, 30 sec., 60 sec., or
120 sec.), if applicable. The user identification and backup IP passwords
can also be activated. See Figure 5-4 (UNIVERGE SV8500 example),
Figure 5-5 (UNIVERGE SV7000, UNIVERGE IPX, NEAX IPX, and NEAX
IPX DM example), and Figure 5-5 (NEAX IPX UMG example).

gonss If the Backup IP/Password Settings option is selected, Installation Manager will
= back up the SV7000 after configuring the IP address and password.
NOTE

For the IPX, the Backup IP/Password Setting is not available. Instead, there is a
Total PIMs (Physical +Virtual) field.

The IPX Installation Manager will automatically perform a System Backup and then
reset the Voice Server, after the IP address and password are configured.
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Figure 5-4 Edit IP Configuration - UNIVERGE SV8500 Example

Edit IP Configuration, Basic Configuration and Reset E'
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IP* Configuration
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Figure 5-5 Edit IP Configuration - UNIVERGE SV7000 and IPX, NEAX IPX, and NEAX IPX DM Example

Edit IP Configuration, Basic Configuration and Reset

General
IP Configuration
Speed

(v 10 Mbps
Active |P Addrezs " 100 Mbps

. -
Standby IP Address

Duplex Mode
| {+ Half Duplex

" Auto Negatiate

Subret Mazk, " Full Duplex
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Figure 5-6 Edit IP Configuration - NEAX IPX UMG

Edit IP Configuration, Basic Configuration and Reset

General l
|F Canfiguration
Configure Speed
|5_I,I$tem Proceszsor j * 10 Mbps
Active |P Address 100 Mbps
. -
|Sl:eml:||:uj,I IP Address © Auto Negotiate
Duplex Mode
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Media Gateway and Circuit Cards

The Media Gateway and Circuit Cards (Figure 5-7) tab is where
peripheral devices (i.e, VS-32, MG-PRI, MG-COT, MC-2A), Protocol
Handlers, and Circuit Cards are assigned and configured. By default, all

of the required protocol handlers will be automatically assigned, no user
configuration is required.

Figure 5-7 Hardware Information - Media Gateway and Circuit Cards Tab

Optioh: Media Gateway & Circuit Cards

Yaoice Mail | SecLrity |

VS-32 Media Gatewway for Conferencing, Announcements, and husic On Hald.
MG 1.5M: Media Gatewvay for connecting IP netwark to S0

- MC & MG-COT: Media Converter to connect analog terminal and IP network to
' I=E : analog PSTH
mi ' Dterm IP: IP telephione enshles Peer-to-Peer woice communication
] L SIP phone: [P telephone corresponding to SIP protocol
" — EEE MG-PRIMCS/VS32: When using these units in SIP Made, Run Setup MS after PEX
=1

has been programimed and manually idle the trunks atter I has completed the install

Mame | Type | MACADDRESS | Phase | Kind | B-Ch. A New
Delete
E dit
F 5 Setup...
pa33) The Setup button is disabled for the SV8500 SIP Server setup.
NOTE

When installing a peripheral device, the MA4000 Installation Manager
will both configure the SV7000 and separately the peripheral device. To
configure a peripheral device, a serial cable is required to connect the
MA4000 Installation Manager PC to the device.
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5-10 Hardware Information

Figure 5-8 Female DB9 to Female DB9 Straight Through Cable example

TCF/IP \Sﬁniﬂ

SWT000 Pearipharal
Device

New button

Clicking the New button displays the New Circuit Card dialog
depending on the IP server. See the Figure 5-9 and Figure 5-10
examples.

Figure 5-9 New Circuit Card - IPX Example

Mew Circuit Card E

General l

Dezcription |
Internal PHE

Internal PHI

Media Converter - MC-24 [2 Paort Analog]

kedia Converter - MC3 [3 Part Analog]

Media Gateway - MC-44/MG-28/MC4MG 2

Media Gateway - MG 1,50

Media Gateway - MG 2.0k

Media Gateway - MGE [B COT Trunk Partz]

Media Gateway - VWS-32°05-320] (MOH / COMF / ANMC)
Signaling Server - SIP Server (inchuding MPH).

k. | Cancel
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Figure 5-10 New Circuit Card - UNIVERGE SV8500 Example

Mew Circuit Card

General

Dezcrption %

Media Corverter - MC-24 [2 Port Analog]

Media Corverter - MC3 [8 Port Analog)

Media Gateway - MC-4A/MG-25MCAMG 2

kedia Gateway - kMG 1.50

bedia Gateway - MG 2.0

Media Gatewway - MGE [E COT Trunk Portz)

Media Gateway - ¥5-32/¢5-320¥] (MOH / COMF /£ ANMC)
Signaling Server - 5IP Server [inchuding MPH).

k. | Cancel

Select the Media Gateway or circuit card to be assigned. Figure 5-11 is
an example of the dialog box that displays when selecting the Media
Gateway - MG 1.5M card.
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Hardware Information

Figure 5-11 Example - Media Gateway - MG 1.5M Edit Circuit Card

Edit Circuit Card X]

General l

Media Gateway - MG 1.5M

M ame [Description]

MALC Addrezs

Media Gateway - MG 1.5M

MAC Addrezs iz located on the lower

Kind

left side of Media Gateway Unit

|ATRT

oC

El

|DDigi
IP Address

%« &

Drata Ch. Route Mame

El

M ebwork, Magk

MGATETD

Signal Ch. Route Mame

Hardware Type

|_MGATETO

|5MB032

Inztallation Phaze

ﬂ Hardware Type iz located near the MAC
Addresz label

=

|F'hase 1 Uzer Data + Hardware Installatinnj

Depending on the system type selected, some of the options will install
automatically and will not need to be selected.

The following options require a PIR:

e Attendant Console
e PAD

¢ Physical

e Station

e Trunk

Delete button

Highlight the circuit card to be removed and click the Delete button.
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Edit button

Hardware Information 5-13

Edit the circuit card selected, changing the fields as needed. When you
are satisfied with the changes made, click the OK button to save the

changes.

Circuit Card Field Definitions

Access to Attendant Operator

ANNC Equipment#

ANNC Pattern (ANP)

Connection Duration

Count

DC

Default Gateway Address
Do Not Send RingBack Tone
DRS Address

Hardware Type

IP Address

MA4000 Installation Manager User Guide - Revision 7

The code system users dial to
reach the attendant.

Specifies what the announcement
is to be used for. For Music On
Hold, choose 64-MOH-IP Ext
Hold Tone.

A .wav or .mdt-type file. Enter a
three digit number from 000 -
255. This number correlates to an
existing .wav file loaded in the
VS32, that you wish to be played
for the defined ANNC Equipment
#.

Indicates how long a caller will
remain connected (0 - Disconnect
after 30 seconds; 1 - Remain
connected until the caller
disconnects).

The number of the route that will
be created for this device

The number of digits to be
translated for incoming calls.
Typically, this would be set for the
number of digits in the station
numbers.

The IP address of your network's
gateway router.

Selecting this option box prevents
sending a RBT.

The IP address of the Device
Registration Server.

Media Gateway: MC4A/MG-2A/
MC4MG2/SCA-4LCOTA

MG 1.5M: SCA-24PRIA/SN8032/
SN8110

The Internet Protocol address for
the equipment.
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Installation Phase

Kind

MAC Address

Name (Description)
Network Mask

Number of Attendants Consoles

Operate Unit in SIP Mode

REGMAX

Repeat Pattern

Route Name

Route Restrictions (RSC)

Send Answer Signal

The phase the device intends to
install.

The PRI trunk type selected from
the pull-down menu (NI-2, AT&T
- 41459, and DMS - Nortel
A211).

The Media Access Control address
for the equipment. The address is
located on the bottom of the
equipment.

Circuit card name.

A string of 0's and 1's that mask
or screen out the network part of
an IP address (IP) so that only
the host computer part of the
address remains.

The number of attendant consoles
the system contains.

Initiates an interactive user
session that involves multimedia
elements such as video, voice,
chat, etc.

The registration assignment
capacity (1-6144). This maximum
should not exceed the line
capacity of the system. Default is
256.

Indicates the sequence of the
announcements the caller should
hear.

Note. This field can only be
modified if the Service Type is
ANNC.

The restriction classes in the
system.

Indicates whether Answer
Supervision should be sent when
an incoming Trunk connects to an
Announcement.

Service Feature Restrictions (SFC)The service feature classes built

Service Type
Signal Ch. Route Name

Station Number

into the system.
How the channel is to be used.

The Media Gateway circuit card’s
signal channel route name.

The number of an available
station number conforming to the
numbering plan.
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Media Gateway Setup button

Before a Media Gateway device can be configured using the Setup button, a One-
time Password needs to created. Please refer to the Security Tab section of this
chapter to set the password.

IMPORTANT
e Setup button

Step 1 Configure a Media Gateway device by highlighting a predefined Media
Gateway and clicking the Setup button. Figure 5-12 displays.

Figure 5-12 Media Gateway Setup Wizard - Welcome

Media Gateway Setup Wizard E

Welcome to Installation Manager
Media Gateway Setup Wizard

Thiz wizard will quide you through configuring a Media
[ ateway device.

To continue, click Mest Buttan,

| Mest » | Cancel

Step 2 Click the Next button to proceed. Figure 5-13 displays.
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5-16 Hardware Information

Figure 5-13 Media Gateway Setup Wizard - Select Operation

Media Gateway Setup Wizard E|
Select Operation |
Select the operation you would like to perform. \l
Comm Part MG Setup Script
|COM 1 | | =]
Fropertiez

[+ Enable DHCP

Default Gateway Address |

Speed Cuplex Mode
f* 10 Mbps * Half Duplex
" 100Mbps

C Auta " Full Duplex
~

~

~

~

< Back | Mext » | Cancel

Step 3 Select the appropriate Comm Port, Properties, Speed, and Duplex
Mode, you wish the operation to perform, enter the Default Gateway, if
applicable, and then click the Next button. Figure 5-14 displays.

gonss The option buttons located beneath the Speed and Duplex Mode sections display
é the current selection of Media Gateway hardware type. They are:
NOTE

* Media Gateway - MG 1.5M
* Media Gateway - MC-4A/MG-2A/MC4MMG2/SCA-4ICOTA

Example: SCA-24PRIA, SN8110, and SN8032 all belong to the MG 1.5M hardware
family. Each has a different capacity or firmware.
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Figure 5-14 Media Gateway Setup Wizard - Select Values

Media Gateway Setup Wizard

Select Yalues |
Select all values to be updated. ‘I

Device Mame | DHCP
DRS Address | 172,16 .253. 0 DRS Portd

IP Address | 0.0 .0 .0 SubretMask |255.255.255. 0

Default Gateway Address | o .0 .0 .10

|nterfface Speed: Auto

HOTE
bl ake zure the zenal connection iz setup corectly before you continue the process.

< Back | MHest > | Cancel

Step 4 Update the values before continuing.

Step 5 Connect a serial cable from the COM port on the PC to the RS232C
connector on the Media Gateway unit.

Step 6 \When all the values are updated and correct, click the Next button.
Figure 5-15 displays.
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Figure 5-15 Media Gateway Setup Wizard - Setting Media Gateway

X

Media Gateway Setup Wizard

Select Yalues |
Select all values to be updated. \l

Setting up Media Gateway. ... Thiz may take a little timel

Step 7 When the Media Gateway setup is complete, Figure 5-16 displays.
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Figure 5-16 Media Gateway Setup Wizard - Operation Completed

Media Gateway Setup Wizard

Completing the Media Gateway Setup Wizard

Congratulations. 'ou have Completed the Media Gateway
Setup Wizard. The resultz of thiz operation are shown below,

Operation Campleted.

Wiew Log...

Step 8 Click the View Log button to see a list of the operation results.

Step 9 Click the Finish button to exit the Media Gateway Setup Wizard.

Signaling Server - SIP Server (Including MPH)

The Signaling Server is enabled when:

» System Type = SV7000 UNIVERGE
¢ Fusion = NCN - Network Control Node

UNIVERGE SV8500 is not supported.

The Signaling Server option (Figure 5-17) allows you to define ranges
for the SIP Server. The signaling server helps establish, modify and
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Hardware Information

terminate IP-base calls. You can use Installation Manager to set basic

signaling server communication parameters.

Information entered in the fields on the Signaling Mail tab are for Phase 1
installations only.

IMPORTANT

Figure 5-17 Hardware Information - Signaling Server Tab

Edit Circuit Card

General

Configuring the Signaling Server

The Signaling Server establizhes, modify and terminates YolP callz. To configure the Signaling Server, do
the following:
+ Enter the Signaling Server IP, Hetwork Mask, and Gateway address. Contact vour netwaork
adminiztrator if you are unzure of the proper values.
+ Enter a number inthe Speech Channels field. The default value is 6.
+ Enter your network system's domain name in the Domain Hame field.

M arne [Description]

Signaling Server - 5IF Server i

Signling Server D Speech Channels LG

[+ = E = 0 v

Mew [P Address Metwork, Mask G ateway

| 17216 25310 | 255 285 255 . O 0.0 .00
MPH ID Time Zane

[ = |GMT-0E:00 Central Standard Time -
|DNS IP >|  Domain Name

0.0 .00 |s%7000

Inztallation Phaze
|F'hase 1 Uszer Data + Hardware Installation ﬂ

For the UNIVERE SV8500, the LMG, Time Zone, and DNS IP Address fields do not
= display.
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Name (Description) field

Enter a server description, or use the default shown.

Signaling Server ID field (This name must be unique on the NEAX IPX
UMG)

Enter the Signaling Server’s ID, or use the default value of 1.

Speech Channels field
Enter the appropriate number of channels, or use the default value of 0.

LMG field (UMG System Only)
Enter the Local Module Group total (0 - 3).

New IP Address field
Enter the Signaling server’s new IP address.

Network Mask field
Enter the Subnet Mask for the Signaling Server's IP Address.

Gateway field
Provide the Gateway’s address for routing.

MPH ID field (This name must be unique on the NEAX IPX UMG)
Enter the Multi Protocol - MPH ID, or use the default value of 1.

Time Zone field
Select the applicable time zone.

DNS field

Enter the DNS Data (Signaling Server) address or name. If using the
address format, enter the Signaling Server's IP Address (same as the
'New' IP Address field).

Domain Name field (This name must be unique on the NEAX IPX UMG)
Supply the network system’s domain name for the Signaling server, or
use the default UNIVERGE_SV_7000.COM.

Installation Phase field

Specify the phase in which the signaling server data will be uploaded to
the server. (Phased installations only).
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Voice Mail Tab

The Voice Mail tab (Figure 5-18) allows you to set and configure
information used to link a user to a voice mail system. The Voice Mail
tab will provide information to the MA4000 Installation Manager on how
it can connect to the voice mail system. Any detailed customizing will
require a technician to use existing maintenance interfaces to
completely set up the voice mail system.

Information entered in the fields on the Voice Mail tab are for Phase 1 installations
only.

IMPORTANT

Figure 5-18 Hardware Information - Voice Mail Tab
ME&x Mail AD-E4

RCl - Analog Station

et Elnz

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



Hardware Information 5-23

Voice Mail System

Voice Mail Type field

The available options are <None>, NEAXMail AD-64, UNIVERGE
UM4730, UM 8500 SQL Message Store, UM8500 Exchange Message
Store, and <Other Voice Mail>.

Port Type
UM8500 UM8500
NEAXMail UNIVERGE Exchange SQL Other
AD-64 UM4730 | Message Store | Message Store| Voice Mail
MCI -
Analog Station X X X X
MCI -
Line Side T1 X X X X
Digital
Integration X X X X
(Dterm Ports)
Digital IP
Integration X X X
Address field

Specifies the IP Address of the voice mail system for administration.

User Name field

This is the administrator user name configured on the voice mail
system.

Password field

This is the administrator’s password on the voice mail system.

Pilot Number field

This is the pilot number of the hunt group for the voice mail system.
This will be used for the voice mail macros in Key Button templates,
{VoiceMail}. This field is determined by the first entry listed in the
Voice Mail Station Ports field.

Test Voice Mail Connection button
Clicking the Test button performs a verification of the Voice Mail System

connection.
pA3%) The Test button can only be used by the UNIVERGE UM4730 after all Voice Mail
.éy Ports have been programmed and the UNIVERGE UM4730 is on-line.
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Exchange Information

Server field
This is the Microsoft Exchange server name. Example: Mailbox Store.

Mailbox Store

The Mailbox Store (similar to group) where the mailboxes were created.
Example: First Storage Group.

Active Directory Information

Domain
The active directory domain name. Example: cantonad120.com.

Container

The container name where users are added. Example: Users.

Voice Mail Station Ports

New button
When the New button is clicked, Figure 5-19 displays.

Figure 5-19 Edit Voice Mail Port

Edit Voice Mail Port

[<] < | ;) | > | &dd Port Delete Port |

Station Murnber

Phone Mame Dizplay
aice Mai

Foute R estrictionz [RSC]
|RSC-1 ~|

Service Bestrictions [SFC]

|SFC-1 |
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Enter the applicable station number and the phone name to be
displayed. Select the Route Restrictions and Service Restrictions (use
the default, or create a new configuration) from the Route
Restrictions (RSC) and Service Restrictions (SFC) drop-down
menu. A port can also be removed by clicking the Delete Port button.

Edit button

Select the port to be edited and click the Edit button. A display similar
to Figure 5-19, containing the information for the selected port,
appears.

Delete button

To delete a specific port, select the port and click the Delete button.
Click the OK button to verify deletion of the port.

Move Up and Move Down buttons

Use the Move Up or Move Down buttons to arrange the sequence of
each port.
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Security Tab
The Security tab (Figure 5-20) allows you to set and configure a one-
time password that will prevent unauthorized access to the SIP
terminal/equipment.
p33%) The following equipment are compatible with the one-time password authentication:

* Media Converter - MC* (8 Port Analog)

NOTE * Media Gateway - PRI (SP-3884, Issue-5A or later)
» DtermIP(SIP) (1.4.3.0 or later)

» VS832-V (SP-3901)

Information entered in the fields on the Security tab are for Phase 1 installations
only.

IMPORTANT

Figure 5-20 Hardware Information - Security Tab

EARfE |
T2zl Enspricy |

T 2rimirzl ALtz
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Terminal/Equipment Security

One-Time Password field

The one-time password is a disposable password that can be used only
one time. The password becomes invalid when the time period indicated
in the One-Time Password Expires field is exceeded. If the system is
initialized or the effective timer expired, the password will need to be
reassigned. Passwords must be 4 to 10 digits in length, consisting of the
characters 0 through 9, the * sign, or the # sign.

Expires field

The options available are Never, 1 hour, 8 hours, 24 hours, 2 days, 3
days, 4 days, 5 days, 6 days, or 7 days.

Terminal Encryption field

The options available are Partial Data Encryption or Full Data
Encryption.

Terminal Authentication field
The options available are Disabled or Enabled.
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System Information

Chapter Topics

This chapter describes the MA4000 Installation Manager’s System
Information section tabs (see Figure 6-1).

e Station Ranges Tab

e Access Codes Tab

e Speed Calling Tab

Figure 6-1 System Information Tab

m Installation Manager,

File Edit Tools

Project
Infarmation

Hardware
Infarmation

Syztem
Information

Advanced
Featuras

User
Azzignments

Group
Azzignments

Circuit Card
Azzignments

Install

Reports

Froductivity
Features

Help

Station Ranges | Access Codes Speed Calling |

Station Range

Dezcriptian Fram % | To | Edit

MNew

Delete

d

Feserved Stations

From ° |T|:| Dezcription | Edit

:

MNew

Delete

d
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Station Ranges Tab

The Station Ranges tab (Figure 6-2) allows you to define ranges for
various types of phone extensions and to also reserve numbers so the
tool will not automatically be assigned to those ranges.

Figure 6-2 System Information - Station Ranges Tab
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Station Range section

The Station Range section lists all the station ranges that have been
defined.

e Edit button

You must first select a record in the Station Range list, then click the
Edit button. Figure 6-3 displays allowing you to modify the entry
selected.

Figure 6-3 Edit Station Range - General

Edit Station Range

General l

D'ezcription
|F'ru:uieu:t Developrent

Station Range

From To

1000 11100

Subline [ TEC: 18]

Oifzet From To
101 | |
Office Code

Area Code + Office Code

k. | Cancel

Description field

The Description field is any description you want to use to identify the
Station Range. It is used for informational purposes when assigning
users. On the basis of ranges assigned here, and applied in the user
assignment dialog, the MA4000 Installation Manager will automatically
assign an unused station humber from the appropriate range.

Station Range section
The Station Range fields contain the defined range.

Subline section

The Subline is used to assign an offset value, a group of humbers that
will be allocated for use as sublines. The offset value can be a negative
value.
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System Information

Office Code section

The Area / Office Code field allows you to specify the Telco
information associated with the range of station numbers.

Select the OK button to accept the changes, or the Cancel button to
ignore the modifications specified.

e New button

The Station Range New button allows you to define a new Station
Range. See “Edit button” on page 6-3 for a complete explanation of all
the fields available.

¢ Delete button

You must first select a row in the Station Range list, then click the
Delete button to remove the record. Figure 6-4 displays asking you
whether or not you want to delete the selection.

Figure 6-4

Warning - Delete Station Range(s)

Warning |£|
) "_-. Delete Station Rangels)?
L

Yes | Mo |

Reserved Stations section

The Reserve Stations section allows you to instruct the MA4000
Installation Manager not to automatically assign users to specific
numbers or sets of numbers. A good example would be for voice mail
systems and operators. Extensions to these items are generally
manually assigned to maintain commonality with a previous system, or
to make the extensions easy to remember.

Later in the Users section, there is the ability to manually assign a user
to a specific extension. The user’s name will be inserted into the Reserve
Station list, removing the number from the pool of extensions available
for automatic assignments.

e Edit button

You must first select a row then click the Edit button. Figure 6-5
displays providing you the ability to edit the selected record.
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Figure 6-5 Edit Reserved Stations - General

x]

Edit Reserved Stations

General l

Dezcription
|F'r|:u:| Dl Btd Cube 0403FES

Station B ange

Fram Ta

35

0k, | Cancel

Description field
Enter a meaningful description of the range being defined.

Station Range section

Enter the range of extensions to be reserved. If it is a single number,
then set the From and To fields to the single humber. The From
number must be less than the To number.

Select the OK button to accept the changes, or the Cancel button to
ignore the modifications specified.

e New button

The Reserved Station Range New button allows you to define a new
Reserved Station Range. See “New button” on page 6-5 for a
complete explanation of all the fields available.

¢ Delete button

You must select a row in the list, then click the Delete button. Figure
6-6 displays asking you whether or not you want to delete the
selection.
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Figure 6-6 Warning - Delete Reserved Station Range(s)

' E Delete Reserved Station Rangels)?

[
Yes | Mo |
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Access Codes Tab

Special Access Codes allow access to additional system-wide features
that may not exist on individual telephones. This feature may be
restricted using the Service Feature Restrictions (SFC) settings. See
Figure 6-7.

Information entered in the fields on the Access Codes tab are for Phase 1
installations only.

IMPORTANT

Figure 6-7 System Information - Access Codes Tab

Station Fanges  Access Codes | Speed Calling

Special Access Codes

Special Access Codes allovwy access to additional system wide festures that may not exist on individual phones.  This
Feature may be restricted through the Zervice Feature Restrictions (SFC) settings.
Data on this Panel is for Phase 1 Installations Only.

[ Enable Aiccess Codes

Code / | Dezcrption E dit
=80 Speed Calling System - Access
a0 Call Back - Set
=40 Call Forwarding ['m here - Set e
=30 Call Forwarding-Logaout - Extry
=20 Call Forwarding Busy - Set
=10 Call Fanwarding Mo Answer - Set Delete
=00 Call Fonwarding - Al Set
e Call Fickup - Group
#a0 b uilti Area [Ma-D] Setting
#50 Call Back - Cancel
40 Call Forwarding ['m here - Cancel
Ha0 Call Forwarding-Logout - Cancel
20 Call Forwarding Busy - Cancel
#10 Call Fonmarding Mo Ansveer - Cancel
R®OO Call Forwarding - All Cancel
HHH Call Pickup - Direct
Rezstore Defaults. .

When the Edit or New buttons are selected, Figure 6-8 displays.
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Figure 6-8 Edit Access Code

Edit Access Code

[< | < | ¥ |>I| e Delete |

Feature D ezcription SI0:3 CLhH.B

Access Code
A0

| k. | Cancel

Step 1  Select the desired feature for the new or edited access code from the
Feature Description drop-down field.

Step 2 Enter the code to be used for this feature in the Access Code field.

Step 3 If editing an existing feature, click the OK button to accept the changes. If
this is a newly defined feature, click the New button to create the feature.

Step 4 You can remove a feature either by selecting it from the Access Codes
tab, or the Edit Access Code window, and clicking the Delete button.
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Speed Calling Tab

The Speed Calling feature allows a user or attendant console to call
frequently dialed numbers using fewer digits (Abbreviated Call Codes)
than normally required. This feature may be restricted using the Service
Feature Restrictions (SFI-12) settings. See Figure 6-9.

Information entered in the fields on the Speed Calling tab are for Phase 1
installations only.

IMPORTANT

Figure 6-9 System Information - Speed Calling Tab

Station Fanges | ticcess Codes  Speed Calling

System Speed Calling

This festure alloves & uzer of attendart conzale to call freguently Disled Mumbers uzing fevwer digits (Abbrevisted Call

Codez] than wwould normally be reguired. This festure may be restricted through the Service Feature Restrictions (ZF1-12)
zettings.

Data on this Panel is for Phase 1 Installations Only.

" Mo Systemn Speed Calling
" 2 Digit System Speed Calling
[+ 3 Digit Systern Speed Calling

Code # | Mumber

Edit

e

Delete

The options available are No System Speed Calling, 2 Digit System
Speed Calling, and 3 Digit System Speed Calling.

When the Edit or New buttons are selected, Figure 6-10 displays.

pA3%) To be able to access System Speed Calling, a System Speed Calling key must be
= assigned to the Dterms, or a System Speed Calling Access Code must be assigned.
NOTE
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6-10 System Information

Figure 6-10 Edit System Speed Calling

Edit System Speed Calling

|| < | * |>I| = Delete |

Speed Calling Humber
[

Ahbbreviated Call Code
i

Step 1  Enter the desired number in the Speed Calling Number field (a
maximum of 24 digits).

Step 2 Enter the code to be used for this feature in the Abbreviated Call Code
field.

Step 3 If editing an existing feature, click the OK button to accept the changes. If
this is a newly defined feature, click the New button to create the feature.

Step 4 You can remove a feature either by selecting it from the Speed Call tab,
or the Edit System Speed Calling window, and clicking the Delete button.
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Advanced Features

Chapter Topics

This chapter describes the MA4000 Installation Manager’'s Advanced
Features section tabs (see Figure 7-1).

System Features (ASYD) Tab
Feature Restrictions Tab

Route Restrictions Tab

Least Cost Routing (LCR) Tab
Automated Call Distribution (ACD) Tab
Open Application Interface (OAI) Tab
Monitor Number Tab

Figure 7-1 Advanced Features Tab

m Installation Manager
File Edit

Tools

Froject
Infrmation

Hardware
Infrmation

Spatem
Infrmation

Advanced
Features

User
Azzighments

Group
Azzighments

Circuit Card
Azsighments

Inztall

Reports

Productivity
Features

Help

Swystem Features

Specifications Manual for details,

Feature Festrictions

Foute Restrictions | LCR | ACD | O | tanitar Mumber |

System Features (ASYDILIN)

This section is imtended for advanced users only! Installation Manager assigns Default System settings
which are the NEC recommended assignments. Any changes to these settings can cause unpredictable
results. System Data is necessary for the CPU to recognize the system. ASYD assigns Data Memory (Dhd), ASYOL is
for Local Deta Memary (LD, and ASYDM is for Metwork Diata Memory (MDM). Data for each index is entered in
hexadecimal format (00 to FF). Each bit (in binary, 0 or 17 has itz owwn unigue meaning, refer to the Office Data

Data on this Panel is for Phase 1 Installations Only.

[ 4ze Default System Features

CHD | 5SS | Index | Data | Motes | -~ Edit
ASYD 1 1 m # Processors

ASYD 1 4 19 1zt Party Release Mew
ASYD 1 5 03 Four CFD Hops

ASYD 1 16 1F E Digit Station Mumbers Delete
ASYD 1 17 m Hooking Enabled for S4L

ASYD 1 a0 0s Mounting Capacity of Data Memory

ASYD 1 A s Commeon Memam

ASYD 1 32 EE SMOR Settings

A5TD 1 33 j=i0] SMOR Settings

A5TD 1 4 m Enable 5FI-E3

ASYD 1 59 a4 Enable Intercom Service / DID Hears Busy

A5YD 1 G0 10 Mail Diovar Enabled

ASYD 1 ] 20 MIS Parity

ASYD 1 [X] m Blind Transfer far Stations

A5TD 1 B4 a0 MOH Enabled

ASYD 1 o] na On-Hook Queus Cancel “ Restore Defaults. ..
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System Features (ASYD) Tab

The System Features (ASYD) tab (Figure 7-2) defines the ranges of
station numbers the Installation Manager will use to assign phone
numbers to users. Also, the feature allows administrators to designate a
range or numbers that will not be assigned to users.

Information entered in the fields on the System Features (ASYD) tab are for Phase
1 installations only.

IMPORTANT

This tab is intended for advanced users only.

IMPORTANT

Figure 7-2 Advanced Features - System Features Tab

System Features

Feature Restictions Route Restrichionz | LCR | ACD | ) | taritar Murnber
System Features (ASYDILIN)

This section is imended for advanced users only! Installation Manager assigns Default System settings
which are the HEC recommended assignments. Any changes to these settings can cause unpredictable
results. System Data iz necessary for the CPUto recognize the system. ASYD azsignz Data Memary (D), A5Y0L is
for Local Data Memory (LDM), and ASYDN i for Metwork Data Memory (MDR). Data for each index is entered in
hezxadecimal format (00 to FFY. Each bit (in kinary, 0 or 11 has its ovwn unique meaning, refer ta the Office Data
Specifications Manual for details.

Data on thiz Panel is for Phase 1 Installations Only.

[ Usze Default System Features

CHD | 545 | Index | Data | Motes - E dit
ASYD 1 1 0 # Processors

ASYD 1 4 19 1zt Party Release [P
AsYD 1 ] 03 Four CFD Hops

As5YD 1 16 1F G Dhigit Station Numbers Delete
AsYD 1 17 ]| Hooking Enabled for 5/L

ASYD 1 an ] Mounting Capacity of Data Memory

AsYD 1 K1l & Commion kemary

ASYD 1 32 ER SMODR Settings

ASYD 1 a3 1] SMDR Settings

ASYD 1 11 01 Enable SFI-63

AsYD 1 A3 a4 Enable Intercom Service / DID Hears Busy

A5y 1 (=] 10 Hail D'owin Enabled

ASYD 1 E1 20 IS Parity

ASYD 1 B3 01 Blind Trangfer for Stationz

ASYD 1 B4 a0 tMOH Enabled

ASYD 1 5] ] Or-Hook Queus Cancel " Resztore Defaults. .

Your system, in its initial state, contains no configuration information
and must be loaded with data which lets the CPU recognize the system
type and configuration. The ASYD commands assign values for data
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Advanced Features 7-3

memory (DM), local data memory (LDM), and network data memory
(NDM) (see Figure 7-3). By default, Installation Manager supplies initial
values for these necessary parameters and uploads them to the CPU
during the installation process.

Experienced users can alter these values, as well as delete or create
new commands. Be aware that deleting required values may cause your
system to be non-functional. For complete information on using ASYD
commands to configure Voice Server features, consult the Office Data
Specifications Manual.

Data for each index is entered in hexadecimal format (00 to FF).
Example: Data = 19. Bit 0, 3, and 4 are set.

Example:

Each bit (in binary, 0 to 1) has its own unique meaning. Refer to the
Office Data Specifications Manual for details.

To use the default features, select the Use Default System Features
check box. Restore the default settings by clicking the Restore
Defaults button.

When the Edit or New buttons are selected, Figure 7-3 displays.

) These buttons are only enabled when the Use Default System Features option is
= not selected.

NOTE

Figure 7-3 Edit System Features

Edit System Features

__|[&3

[<| « | ¥ |>I| M e | Delete
Command Syghem |ndex

|BSYD B = =

Data Bt ¥ B & 4 3 2 1 0

lnni I

Mate

Cancel | ok |

Step 1  Select the desired command (ASYD, ASYDL, and ASYDN) from the
Command drop-down field.
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7-4 Advanced Features

Step 2 Enter the appropriate information to the System, Index, Data, Bit, and
Note fields. The information contained in the Data field is in hexidecimal
format.

Step 3 If editing an existing feature, click the OK button to accept the changes. If
this is a newly defined feature, click the New button to create the feature.

Step 4 You can remove a feature either by selecting it from the Systems
Features (ASYD) tab, or the Edit System Features window, and clicking
the Delete button.

Deleting a selecting System Feature record does not disable the selected feature,
= but, instead, restores the original System Default settings.

To disable a feature refer to the Office Data Specification Manual.

Step 5 Use the Cancel button to return to the Systems Features (ASYD) tab
without making any editing changes.
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Feature Restrictions Tab

IMPORTANT

Information entered in the fields on the Feature Restrictions (ASYD) tab are for
Phase 1 installations only.

The Feature Restrictions tab (see Figure 7-4) allows you to provide
meaningful names to the Service Feature Classes built into the system.
It is anticipated that as installation personnel use MA4000 Installation
Manager, they will develop default templates that are used for the
majority of their customers and end users. This feature defines and
selects system-wide features and, optionally, allows you to enable or
disable them using day/night modes.

There are 16 Route Restriction Classes (RSC) and 16 Service Feature
Classes (SFC) available on your system. You can use Route Restriction
Classes to prevent, for example, lobby phones from making outgoing
calls. You can use Service Feature Classes to assign a group of phones a
Class of Service feature, such as providing call forwarding for all guest
phones.

Your system, by default, lists each restriction class with a numeric code,
such as RSC-0. Installation Manager lets you create meaningful text
descriptions for each level, such as "Guest Phone RSC-0", making it
easier to administer and maintain restriction classes.

You can use the Restrictions tab to enable or disable individual classes,
and to specify whether they apply to Day or Night service, or both. You
can also specify whether route restrictions should apply to incoming/
outgoing attendant or direct-dialed calls.
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7-6 Advanced Features

Figure 7-4 Advanced Features - Feature Restrictions Tab

Resemed for Trunks

0
]
2

-3

-4
5
5
7
5

-9

-10

-1

-12

-13

-14 Conferencing
-16 ACD

e Edit button

When you select a Service Feature Class, then click the Edit button,
Figure 7-5 initially displays.
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Figure 7-5 Edit Service Feature Restrictions (SFC) - Day Tab

Edit Service Feature Restrictions (SFC)

Day ] Might |
SFC Mumber Drezcription
| ISFC-1

[ Use Default Service Features

—_

- Qutgaing Trunk Queling ﬁ
: Call Back

. Executive Right-af-way [Calling)

: Ewecutive Right-ofway [Called)

- Call 'wfaiting - Originating [Calling]

- Call 'wfaiting - Originating [Called]

: Call Forwarding - All Callz

. Call Farwarding - Don't Answer

3: Call Forwarding - Busy Line

10: Call Hald

11: Data Line Privacyfattendant Camp On [0 = Privacy /1 = Camp On)

12: Speed Calling System

23 Woice Mail Pazzward Dizplay Elimination

29: Direct Call Fickup

44 Last Mumber Call Redial

52 Voice Call uzing an Access Code

A3 Meszzage Reminder uzing an Access Code

67: Call Park-&ccess and Answer w

[v Only Show Selected Features Clear all
| k. | Cancel |

EEEEREEERREEE
L ) L ]

You are then allowed to provide a description of the SFC number
selected, and the service features to be assigned to the SFC number.

— Selecting the Use Default Service Features check box limits the
service features to those features annotated with a check mark in
the list.

— Selecting the Only Show Selected Features check box allows
you to only display those features chosen for that particular SFC
number.

— Clicking the Clear All button will remove all previously selected
service features for the listed SFC number.

When the Night tab is selected, Figure 7-6 displays.
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Figure 7-6 Edit Service Feature Restrictions (SFC) - Night Tab

Edit Service Feature Restrictions (SFC)

Drap Hight
v Ao Dap and Might Service Feature Bestictions

[ Use Default Service Features

1: Outgoing Trunk Gueuing ”
2 Call Back

3 Executive Right-of-/ay [Calling]

4: Executive Right-of 4w ay [Called)

B Call™ aiting - Onginating [Calling]

E: Call™aiting - Onginating [Called)

7. Call Forwarding - Al Call:

8: Call Forwarding - Don't Answer

9: Call Forwarding - Busy Line

10 CallHold

11: Data Line Privacy/dttendant Camp On [0 = Privacy /1 = Camp On)

12: Speed Calling Systern

13 Trunk Anzwer [TAS)

[ 14 Systern Message Detal Recarding (SMOR] - Trunk Basis

1s -

] 16: Line Load Cantral

a7 -

O1s - w

[ Only Show Selected Features Clear All
k. | Cancel |

— Selecting the Allow Day and Night Service Feature
Restrictions check box allows the service feature restrictions to
be available day or night.

— Selecting the Use Default Service Features check box activates
the default service features.

— Selecting the Only Show Selected Features check box allows
you to only display those features chosen for that particular SFC
number.

— Clicking the Clear All button will remove all previously selected
service features for the listed SFC number.
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Route Restrictions Tab

Information entered in the fields on the Route Restrictions tab are for Phase 1
installations only.

IMPORTANT
There are 16 Route Restriction Classes (RSC) and 16 Service
Feature Classes (SFC) available on your system. You can use Route
Restriction Classes to prevent, for example, lobby phones from
making outgoing calls. You can use Service Feature Classes to assign
a group of phones a Class of Service feature, such as providing call
forwarding for all guest phones.

Your system, by default, lists each restriction class with a numeric code,
such as RSC-0. Installation Manager lets you create meaningful text
descriptions for each level, such as "Guest Phone RSC-0", making it
easier to administer and maintain restriction classes.

You can use the Route Restrictions tab to enable or disable individual
classes, and to specify whether they apply to Day or Night service, or
both. You can also specify whether route restrictions should apply to
incoming/outgoing attendant or direct-dialed calls.

The Route Restrictions tab (Figure 7-7) defines criteria which
determine how a call will be handled when originating or terminating
over a specified route. The feature also lets you specify different
restrictions when your server operates in day or night mode. It is
utilized to define templates that will be used for each phone to describe
the characteristics of each user’s phone. It specifies templates for those
users who have access to the rich features of the system.

PR3 The routes are defined in the Hardware Tab using the Media Gateway definitions
= located in the Media Gateway and Circuit Cards Tab.
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Figure 7-7 Advanced Features - Route Restrictions Tab

System Features | Feature Festictions Route Restrictions

Data on this Panel is for Phase 1 Installations Only.

LCR | ACD | 0l | Maritar Number |

[ Load Default Route Restnction Data [ Allow/Restrct All Data

MGEATTT - Media Gateway - MG 1.50

| Route  °° | "-T| M ane | At [ncoming | Att Outgoing | Direct Inco... | Direct Qukga. .. E dit
1 _DUMMY 0 RSC-0 Mo Mo Mo Mo
MGATET 1 HSC-1 Mo Mo Mo Mo
2 RSC-2 Mo Mo Mo Mo
3 RSC-3 Mo Mo Mo Mo
4 HRSC-4 Mo Mo Mo Mo
5 RSC-5 Mo Mo Mo Mo
E RSC-B Mo Mo Mo Mo
¥ RSC-7 Mo Mo Mo Mo
8 HRSC-8 Mo Mo Mo Mo
9 RSC-3 Mo Mo Mo Mo
10 ASC-10 Mo Mo Mo Mo
11 ASC-11 Mo Mo Mo Mo
12 R5C-12 Mo Mo Mo Mo
13 ASC-13 Mo Mo Mo Mo
14 HSC-14 Mo Mo Mo Mo
15 ASC-15 Mo Mo Mo Mo
Tall % Type E dit
[HEw
Elete
< >
The Route Restrictions (RSC) (see Figure 7-7) provides a list of
restriction classes in the system. The list is provided as an
enhancement. It allows the MA4000 Installation Manager user to name
the 16 available restriction templates (classes) with a meaningful name.
pa3%) Media Gateway circuit cards listed in the Routes section are created using the
= Media Gateway and Circuit Cards section of the Hardware Information tab. See
NOTE “Media Gateway and Circuit Cards” on page 5-9.
P37 Installation Manager will program ANY class that is assigned to a station. If only
= RSC-1 is assigned, then that is the only class programmed. But if all 16 classes are
NOTE assigned to the various phones, then Installation Manager will program all 16

classes, etc.
Classes that are assigned a Description but are not assigned to a phone will not be
programmed by Installation Manager.

e Load Default Route Restrictions Data check box

(Optional) Click the Load Default Route Restriction Data check
box to instruct your system to use pre-programmed default routes.

e Allow/Restrict All Data check box
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Advanced Features 7-11

(Optional) Click the Allow/Restrict All Data check box to instruct
your system whether to allow or restrict Attendant Incoming,
Attendant Outgoing, Direct Incoming, or Direct Outgoing Calls.

e RSC Edit button
When you select a Route Restriction Class, and click the Edit button,

Figure 7-8 displays. You are then allowed to assign a class name and a
detailed description for that class.

Figure 7-8 Edit RSC - Day Tab

Edit Route Restrictions (RSC)

Day ] Might |
RSC Mumber D ezcription
| IRSC-1
Route
At [ncoming Atk Outgaing
| Resztricted j | Restricted j
Direct Incoming Direct Outgoing
[Restcted <l .
(] | Cancel |

— The RSC Number field displays the RSC selected for editing, while
the Description field provides you the opportunity to enter a more
descriptive label, if desired.

— The Route field displays the Media Gateway circuit the RSC being
edited is located.

— The Alt Incoming, Alt Outgoing, Direct Incoming, and Direct
Outgoing drop-down fields allow selection of either the Allowed
or the Restricted options for those features. The Direct Outgoing
drop-down field also allows the selection of the Toll option.

P33 When the Toll option is selected, the Toll section located below the RSC section
= becomes active allowing editing.
NOTE

Figure 7-9 displays when the Night tab is selected.
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Figure 7-9 Edit RSC - Night Tab

Edit Route Restrictions (RSC)

Day  Might |
[v Allowe Day and Might Foute Bestictions

At lncoming Atk Outgaing

| Restricted ﬂ | Restricted ﬂ

Direct | ncoming

Direct Outgoing

| Restricted j | Restricted j
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¢ New Toll button

Select a Route Restriction Class, and click the New button, Figure 7-
10 displays.

Figure 7-10 Edit Toll - Outgoing Connection - Day Tab

Edit Toll - Outgoing Connection

Day ] Night |
Fioute RSC Dezcription

Maotes: Once a DC [Digit Code] iz defined, all other digits beginning
with the zame DC will be denied unless otherwize soecified.

DC Restriction

DC | Restricted | Add |

_Edt |
_Delet |

k. | Cancel

— The Restriction drop-down field allows selection of either the
Restricted, Allowed, 3/6 Toll Restriction, or Operator
restrictions.

Figure 7-11 displays when the Night tab is selected.
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Figure 7-11 Edit Toll - Outgoing Connection - Night Tab

Edit Toll - Outgoing Connection

Dray Might

[v &llowe Day and Might Tall Boute Restrictions

Restnchion

/6 Tall Restriction

k. | Cancel

— Using the Day tab, when the 3/6 Toll Restriction option is
selected, Figure 7-12 displays.
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Figure 7-12 Edit Toll - Outgoing Selection

Edit Toll - Outgoing Connection

Raoute

Day | Night |

RSC Description

R estriction

Maotes: Once a DC [Digit Code] iz defined, all other digits beginning
with the zame DC will be denied unless atherwize soecified.

| Restricted

Add |

_Ed_|
_Delee |

o ]

Cancel

— Selecting the Add button displays Figure 7-13.
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Figure 7-13 Edit Route Toll Restriction

Edit Route Toll Restriction

[eneral

Destination Restricted

Yes j

| 2k | Cancel

— Enter the destination and whether their is a restriction or not.
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Least Cost Routing (LCR) Tab

IMPORTANT

Sywstem Features

This festure alloves the system to be programmed to route outgoing calls over the most economical facility 0WATS, FX,
DD, Bazed on the area code and office code dialed, the zystem examines the programming tables and choozes the
facilities in the order specified.

Refer to the Office Data Specifications Manual for details.
Data on thiz Panel is for Phase 1 Installations Only.

Information entered in the fields on the Least Cost Routing (LCR) tab are for Phase
1 installations only.

Use the Least Cost Routing (LCR) tab (Figure 7-14) to configure the
server to route calls over the most economical facility available, such as
WATS lines, foreign exchanges, or direct dial lines. Based on the area
code and office code entered, the system refers to the programming
tables which determines, in order, the most economical route for the
call.

Using Installation Manager, you can configure your system to use a
supplied set of default LCR routes, edit them to your own requirements,
or create new routes. You can also specify conditions (or number
patterns) that determine when the routes will be used, as well as certain
times of day when they are in effect.

Figure 7-14 Advanced Features - LCR Tab

Feature Restrictions R oute R estrictions LCH I.&ED | ) | tdanitar Murnber

Least Cost Routing

[ Load Default Least Cost Bouting 0'ata

MNurnber % | MHD | Local Pattern [for CCIS) | Metwork, Pattern [for all ath... | E dit
300 3 Local Pattern 3 Metwork, Patter 3

am 24 Local Pattern 1 Metwork, Pattermn 1 e
a0z 12 Local Pattern 1 Metwork Pattern 1

903 12 Local Pattern 1 Metwaork, Patterd 1 Delete
904 12 Local Pattern 1 Metwaork, Patterd 1

05 12 Local Pattern 1 Metwork, Pattermn 1

06 12 Local Pattern 1 Metwork Pattern 1

07 12 Local Pattern 1 Metwaork, Patterd 1

08 12 Local Pattern 1 Metwaork, Patterd 1

09 12 Local Pattern 1 Metwork, Pattermn 1

910 16 Local Pattern 1 Metwork Pattern 1

911 3 Local Pattern 3 Metwork, Patter 3

1z 12 Local Pattern 1 Metwaork, Patterd 1

13 12 Local Pattern 1 Metwork, Pattermn 1

3140 12 Local Pattern 1 Metwork Pattern 1

410 12 Local Pattern 1 Metwaork, Patterd 1

1411 8 Local Pattern 2 Metwork, Patters 2

N4z 12 Local Pattern 1 Metwork, Pattermn 1

1413 12 Local Pattern 1 Metwork Pattern 1 e Restore Defaults. .
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You can enable the Least Cost Routing by deselecting the Load
Default LCR check box.

Step 1 Choose the LCR number to be programmed and select the Edit button.
Figure 7-15 displays.

To create a new LCR entry, select the New button.

) —

NOTE

Figure 7-15 Edit System Features

Edit Least Cost Routing

< <| >|>I| Mew | Delete |

Call Patterm b axirum Mecessary Digits
3] | 2

Local Pattern [for CCIS]

|L|:u:al Fattern 1 jJ

M etwork, Pattern [For all ather trunks]
| Metwork, Pattern 1

Toll Code [dentification

| ..
|Local Code -]

[

[

Account Murmber
| Out OF Service

Line Data

|.-’-‘-.r'|aln:|g

Carizel | ak |

Step 2 Enter the Call Pattern information. The system will then use this pattern
to match a user's dialed digits and invoke LCR for the call.

Step 3  Select the number of digits from the Maximum Necessary Digits drop-
down field that the system will scan. The Maximum Necessary Digits
number is the number of digits (from left to right) the system waits before
sending a call for further processing. If the number contains fewer than
the Maximum Necessary Digits, the system waits as follows:

—Interdigit Timeout (typically 10 seconds) x the missing digits number

—For example, if the Maximum Necessary Digits is 12 and the system
receives 10 digits, it waits 2 x 10 = 20 seconds before processing the
call.

2 (numDigits missing) x 10 (interdigit timeout) = 20
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At this point, the user may need to configure a local or network pattern.
If so, the user can optionally specify whether the LCR is invoked only
during certain time periods. The user must specify the number of digits
(in the dialed stream) the system will strip out (digits to skip). For
example, deleting 9 and 1 for a long distance call. The system looks at
digits from left to right and begins stripping “on the left".

Step 4 Choose the desired option from the following drop-down fields:

—Local Pattern (for CCIS): Local Pattern 1, Local Pattern 2, Local
Pattern 3, None, or New. This option specifies the sequence of routes
a call matching the pattern will use. You can use an existing pattern or
create your own.

—Network Pattern (for all other trunks): Network Pattern 1, Network
Pattern 2, Network Pattern 3, None, or New. This option also
specifies the sequence of routes a call matching the pattern will use.
You can use an existing pattern or create your own.

—When the Browse button located next to the Local Pattern (for CCIS)
or Network Pattern (for all other trunks) is selected, Figure 7-16
displays.

Figure 7-16 Edit Least Cost Routing Pattern

Edit Least Cost Routing Pattern

<] < | > |>I| Mew | Celete |

Pattern Mumber  Pattern Description Time af Day

| Lacal Pattem 3 00:00 - 00:00 =l

tedia Gateway - kG 1.5

Route Route 5 | 5. | To. | Pattern | Clazs | Trurk | FC

MGMI-20 N Heezls

3 Move Down
_< |
<« Edt |
Cancel | ] |

Step 5 The Time of Day field allows the user to define the time of day patterns.
Select the Browse button located next to the Time of Day field. Figure
7-17 displays.
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Figure 7-17 Edit Time of Day Patterns

Edit Time Of Day Patterns @

Start Time End Tirmne
0700 Jhd
| R [ R
| I B R
| I B R
| o] [zam o
| o] Joo <
| [ [
| ] [

:

Cancel 2k,

—Enter the desired time sequences, not to exceed 24 hours.

Step 6 To edit a circuit card’s routing, choose a circuit card (or cards) listed in
the Route field and use the Right Arrow button to move the card to the
editing section.

Step 7 To edit a specific card, choose the card and select the Edit button. Figure
7-18 displays.
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Figure 7-18 Edit Least Cost Routing Data

Step 8

Step 9

Step 10

Edit Least Cost Routing Data

Foute Hame
Mumber OF Digits To Skip Owerflow Tone
0 = Mo -

Diigitz To Add Friority Bestriction Class
|< Hane » j J I 1] :I

FKind OF Trunk. Faint Code

IP TRK - [+ =

Cancel | ak. |

Using the Number of Digits to Skip field, the user must specify the
number of digits (in the dialed stream) the system will strip out (or digits
skipped). For example, deleting 9 and 1 for a long distance call.

—The system looks at digits from left to right and begins stripping on the
left.

Specify whether the user will hear an overflow tone if all lines in the
selected trunk are full using the Overflow Tone field.

Use the Digits to Add field to enter a number that will be added at the
beginning of the number sequence. For example, if the Number Of
Digits To Skip Number is 5, and the Digits To Add number is 214, then
a starting number of 91817-479-9986 would be translated to 214-479-
9986.

—When the Browse button next to the Digits to Add field is selected,
Figure 7-19 displays.
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Figure 7-19 Additional Digit Translation (AADC)

Step
Step
Step
Step
Step

Step

Step

Step

11
12
13
14
15

16

17

18

Additional Digit Translation (AADC) [X]

Fattern Additional Digits

Cancel | Ok, |

Enter the additional digits and select the OK button.

Select the Priority Restriction Class.
Use the Kind of Trunk field to specify whether the trunk is IP or non-IP.
If IP was selected, use the Point of Code field to set the point code.

The configured route now appears on the list. It can be moved up or
down, which determines the sequence in which the calls attempt to find a
trunk. For example, a call matches the LCR pattern, then attempts
completion using the first trunk listed. If that is full, it then goes to the next
trunk and so forth. Each choice is less desirable than the preceding one.

Use the Toll Code Identification field to specify whether the call should
be identified as a toll call or local call.

Use the Account Number field to specify whether an account number is
necessary to access the selected trunk in the LCR.

Use the Line Data field to specify whether the line data is digital or
analog.
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Automated Call Distribution (ACD) Tab

IMPORTANT

NOTE

The ACD tab (Figure 7-20) is used to configure the ACD system to
connect large amounts of incoming calls automatically to groups
composed of ACD agent positions. These calls are processed in the order
of their arrival, and are distributed evenly among the ACD agent
positions in order to optimize personnel and save cost.

Information entered in the fields on the Automated Call Distribution (ACD) tab are

for Phase 1 installations only.

The ACDP software must first be installed in order to use this feature. The
Installation Manager is currently not assigning the ACD database (i.e., Splits, CCVs,
efc.), only the System Data.

Figure 7-20 Advanced Features - ACD Tab

System Features | Feature Restictions

Route Restrichionz

the ACD agent positions in order to aptimize personnel and save cost.

Reter to the Office Data Specifications Manual for details.

Basic System Data iz assigned for Internal ACD. The system will be configured as a stand-alone ACDP node wwith & ports
SMFR enabled. Some of the system data may need to be changed in order to fit your need. The ACOP software must first
ke installed in order to use this feasture. Currently Installstion Manager iz not assigning the ACD databasze (e, Splits, CCWVs,

etc), only the System Data.
Data on this Panel is for Phase 1 Installations Only.

[ Dizable ACD [Automated Call Distribution

LCF  ACD Ium | Maritor Nurmber
Automated Call Distribution

The ACD (Automatic Call Distribution) 2ystem can connect large amount of incoming callz automatically to groups
compozed of ACD agent pozsitionz. These calls are processzed in the order of their arrival, and are distributed evenly among

Fep 5 | Type | Chirne | P-Code -~ E dit
1 kSF Yes 187 - Break Mode

2 ThF Yes 202 - Automatic Answer /M anual Answer

3 MSF Yes 186 - Multi-work Delete
4 THF Yes 203 -whark Maode

] kSF ez 188 - Might Mode

G ThF Yes 200 - Trunk, Trouble

7 kSF ez 189 - Tally

g THF Yes 204 - Azzistance

9 ThF Y'es 2865 - Emergency

10 kSF ez 190 - Log On/0Ff

12 MSF Yes 191 - Maonitar/Ovemde

14 THE Ve 249 - |ICD) Call wiaiting | amndEnd vg | sz Dl
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You can disable the Automated Call Distribution by selecting the
Disable ACD (Automated Call Distribution) check box.

e Edit button

When you select a OP Code Key, then click the Edit button,
Figure 7-21 displays.

Figure 7-21 Edit ACD

Edit ACD X

General l

F.ey Code Chime

Yes

Facility Type

OP-Code

| [

— Modify the Chime field. The other fields cannot be changed from
this ACD panel.

PR3 The TMF (Terminal Multiple Information Transfer Facility) and MSF (Terminal Mode
= Set Facility) are facilities that Voice Server supports for communicating with the
NOTE Dterm Single-Line phone.
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Open Application Interface (OAl) Tab

The OAI Systemtab (Figure 7-22) is the interface joining a variety of
facilities in the switch to the application programs in an external
computer in accordance with the basic reference model of the Open
Systems Interconnection (OSI) standardized by the ISO. The switch can
be controlled by the external computer through the OAI system and
offer users unique added values.

Information entered in the fields on the Open Application Interface (OAIl) tab are
for Phase 1 installations only.

IMPORTANT

PR3 The user is responsible for adding OAl keys to the user button templates.

NOTE

Figure 7-22 Advanced Features - OAl Tab

System Features | Feature Restictions Foute Restrictions | LCR | ach OAl I b oritor Mumber
Open Application Interface
Open Application Interface (DA System is the interface that joins a variety of facilties in the switch ta the application

programs in an external computer in accordance with the basic reference model of the Open Systems Interconnection

(D=0 standardized by the 150, The switch can be cortralled by the external computer through the QAL system and offer
uzers unigue added values.

HOTE: OAl keys must be manually added to the user button templates.

Refer to the Office Data Specifications Manual for detailz.
Data on this Panel is for Phase 1 Installations Only.

[ Dizable 04l [Open &pplication Interface}

kep & | OP-Code | Code | Chirne | Tupe E dit

1 128 fes MSF

13 128 es MSF Mew
Delete
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You can disable the Open Application Interface by selecting the Disable
OAI (Open Application Interface) check box.

e New button

When the New button is selected, Figure 7-23 displays.

Figure 7-23 Edit OAl - New

Edit DAI

General l

K.ey Code

]

Facility Type

MSF -

OP-Code
I 128 3:

3

Access Code

Cancel

o]

— Enter or select the desired information in the Key Code, Chime,
Facility Type, OP-Code, and Access Code fields.

e Edit button

When the Edit button is selected, Figure 7-23 displays.

Figure 7-24 Edit OAI - Edit

Edit DAl

General l

F.ey Code

I -

Facility Type

MSF -

OP-Code

I 128 3:

3

Cancel

o |
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— Modify the Key Code, Chime, Facility Type, and OP-Code fields,
as needed.

e Delete button

To delete an existing OAI, highlight the OAI to be removed and click
the Delete button. Figure 7-25 will display to confirm whether you
want to delete the OAIL.

Confirm Delete X

L] "_'. Are vou sure you want bo delete this ikem?
L

Yes | | Mo |

Figure 7-25 Confirm Delete
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Monitor Number Tab

AMNO assigns monitored numbers in the PBX. In a ACD system, the
monitored numbers programmed in AMNO are the entry points for pilot
numbers. Monitored Numbers are also used in OAI applications for call
deflection. In the case of Attendant console, Monitored Number specifies
the number the attendant dials to log on or log off the system. See
Figure 7-26

Figure 7-26 Advanced Features - Monitor Number Tab

Sywstem Features

AMMC i uzed to assign monitored numbers inthe PEX. In case of a ACD system, the monitored numbers programmed in
AP gre the entry points for pilat numbers. Montored Mumbers ate alzo uzed in 04 applications for call deflection. For
Attendant con=ole, Monitored RMumber zpecifies the number the attendant swill dial to log on and log off the system.

Refer to the Office Data Specifications Manual for details

[ Disable Monitar Hurnber

Feature Restrictions R oute R estrictions | LCR | ACD | 04l Monitor Number
Monitor Number

M onitar Murnber | UCD | LCD Group | Attendant | Fhaze | E dit
5555 Mot Fallow Mo 1
5556 Mot Follow Mo 1

Delete

You can disable the Monitor Number by selecting the Disable Monitor
Number check box.

e New button
When the New button is selected, Figure 7-27 displays.
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Figure 7-27 Monitor Number - New or Edit

Edit Monitor Humber

X

E dit kanitar Mumber l

l<| < | 5 |>|| Add | Delete |

b amitar Mumber

LICD [Fallow UCD) [

|N|:|t Follow ﬂ
| = L

Phaze
|F'hase 1 Uzer Data + Hardware Installation j

ak | Cancel |

— Enter, modify or select the desired information in the Monitor
Number, UCD (Follow UCD), Use as Attendant Console, UCD
Hunt Group, and Phase fields.

e UCD Hunt Group field

To modify the UCD Hunt Group, select the Browse button.
Figure 7-28 displays.
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Figure 7-28 Edit UCD Group Template

X

Edit UCD Group Template

Group l Infarmation |
M ame
I

tembers: [0 of 100 uzers azzigned]
Last Mame | First Marne | &dd

Delete

kove Lp

Al

Maowve Down

s | Cancel

e Delete button

To delete an existing Monitor Number, highlight the Monitor number to
be removed and click the Delete button. Figure 7-29 will display to
confirm whether you want to delete the Monitor Number.

Confirm Delete X

L] E Are you sure you wank bo delete khis item?
L

Yes | Mo |

Figure 7-29 Confirm Delete
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User Assignments

This chapter describes the MA4000 Installation Manager’s User
Assignments section.

The User Assignments (Figure 8-1) allows you to manipulate a large
number of users from an easy to use graphical user interface. Import
and Export, from and to CSV formatted files can be handled easily, no
matter the size. In fact, the larger the import file the greater the time
savings that can be achieved due to the efficiency and powerful
capabilities afforded by the MA4000 Installation Manager.

Figure 8-1 User Assignments Tab

m Installation Manager E]|E|E|

File Edit Tools Help

Project -
Infgﬂ?;gn ﬂ ﬂ 1ot ﬂﬂ E dit ‘ Mew ‘ Delete ‘

Hard Last Name  ° | First Marne | Organization | Location | Phase | Ext | FhoneType |
|nf2[,mb:;:jen iDoe John Froduction - E... i S|

Suztem
Infarmation

Advanced
Features

User
Azsignments

Group
Azzighments

Circuit Card
Azzignments

Irstall

Reports

Productivity
Features

Impart.. Export... Update Wwizard...
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e Edit button

You can select one or more records, then click the Edit button.
Figure 8-2 and Figure 8-3 (Business system type) or Figure 8-4 and

Figure 8-5 (Hospitality system type) displays. You can then edit all the
records selected, one at a time.

Figure 8-2 Edit User - Business (except UMG)

Edit User X]

[<| < | b Station: LEM: Add Uzer | Delete User |
Lazt Hame Firzt Mame Phone Hame Display E -mail
I | |
Organization
|< Mone » j
Location
|< MHone » j
Phore
todel Button Template Station Fange Type
IPPP DtermiP [ITRLCA6]  w| .| [Defaul 16 Button | | [station Riange -]
Raoute Restrictions [RSC) Station Mumber
|HSE -1 j |< Auto Select Station Number » j
Service Restrictions [SFC] Station MAC Address: (Required For Auta Loging
e | ll
Call Fanwarding Woice b ail
|<Nu:|ne> ﬂJ |<Nu:|ne> ﬂJ
Group Memberzhipz Mizc Motez
Fickup Jack D
|< Maone » ﬂ J |
Hunt [ Circular £ Pilat ] 0ld Phone Mumber
|< Maone » ﬂ J |
Hunt [ UCD ] Phone Hardware Accessonies
|< Mone » j J |Default Hardware Accessonies j J
Cancel | Save |
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Figure 8-3 Edit User - Business (UMG only)

Edit User

x]

| < <| B Shation: LEHM: .&ddUser| DeleteUser|

Last Marme First Mame Phone Mame Display E-mail
I |

|
LMG

|< MHare » j |D

Location
|< MHahe »

Phone
tdadel Button Template Station Range Type

B
=l
|DTF|-8D -Seresi 8 Button j J |Defau|t 8 Buttaon j J |Stalion Range j
El

Organization

Foute Restrictions [R5C] Station Mumber

|F|SEI -1 j |< Auto Select Station Mumber »
Semvice Restrictions [SFC)

e =l |

Call Fonwarding Yaice Mail
|< Maone » jJ |< Mone » jJ
Group Memberships tisc MHates
Pickup Jack 1D
|< Mane » j J |
Hunt [ Circular / Filot 0ld Phone Humber
|< Mane » j J |
Hunt [ UCD ] Fhone Hardware ficceszones

: Installation Phaze
M = Ciefault Hard A | .
|< e J _] | il J _J |F'hase1 Uzer Data + Hardware Install-j J

Cancel | Save |
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Figure 8-4 Edit User - Hospitality (except UMG)

Edit User (X
I<| ¢ | el Statian: LEM: Add Uszer | Delete User |

Lazt Mame First Hame Fhone Mame Dizplay E-mail

I | |

Phaone Type Roaom Class Organization

|.t’-‘-.dministlatinn j |D j J |< Mone »

Annes Floar

| ocation

|Main Building j J I 1 ::"Gmund j
Fhane
Model Button Template

|< Mone »

Station Range Type

IP PP DtermlP (ITR-LCA6] +| ...| [Defaul 18 Button

=

=

jJ |Stati0nHange j
B

Route Restrictions [RSC] Station Murnber

|F|SC -1 j |< Auto Select Station Mumber »

Service Restrictions [SFC) Station MAL Address: [Reguired For Auto Login)

|sFC -1 =i

Call Fonwarding Yoice Mail

|< Hare » jJ |< Hare » jJ
Group Membershipsz tizc MHotes
Fickup Jack D

|< MHane » jJ |

Hunt [ Circular £ Filat | 0ld Phone Mumber

|< MHane » jJ |

Hurt [UCD ]

Fhaone Hardware Accessones

|< MHone » j J |Defau|t Hardware Accessonies j J

Cancel Save
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Figure 8-5 Edit User - Hospitality (UMG only)

Hunt [ UCD ) Phaone Hardware Accessonies

: Installation Phaze
N =l . Default Hard A LI
|< = J J | Saloatae e J J |F'hase'| Uzer Data + Hardware Install.j J

Cancel | Save |

Edit User X
I<| < | el Station: LEM: Add User | Delete User |
Lazt Hame Firzt Mame Phone Hame Display E -mail
I | |
Phaone Type Room Class Organization LG
|.t’-‘-.dministration j |EI j J |< Hone » j |EI j
Anhes Floor Location
|Main Building j J I 1 jl Ground j |< Maone » j
Fhone
M odel Button Template Station Fange Type
IP PP DtemiP (ITRLCAE) | .| [Defaut 16 Buton | .| [station Riange -]
Route Restrictions [RSC) Station Mumber
|HSE -1 j |< Auto Select Station Number » j
Service Restrictions [SFC] Station MAC Address: (Required For Auta Login]
|SFC -1 =l .|
Call Forwarding
|< Maone » ﬂ J | J J
Group Memberships Mizc Motez
Fickup Jack D
|< Maone » ﬂ J |
Hunt [ Circular £ Pilat | 0ld Phone Mumber
|< Maone » ﬂ J |

e Add User button

The Add User button allows you to quickly add users while remaining
in the Edit User dialog. When the Add User button is clicked, the
user’s name fields will blank out. All other fields will remain. You can
quickly add users with common information.

¢ Delete User button

The Delete User button deletes the current record. Figure 8-6 will be
display.

Figure 8-6 Warning - Delete User Profile

L] E Delete User Profile?
L
Yes | Mo |
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User Assignments

User Assignments - New or Edit User

Last Name field

Last name of the user.

First Name field

First name of the user.

Phone Name Display field

Displays when you call another station. The length of this string, and its
location, is dependent on the system settings. See “Station Ranges Tab”
on page 6-2.

E-mail field

The contacts e-mail address. This information will be programmed in the
UM4730 Voice Mail system mailbox, if applicable.

Phone Type field (Hospitality Only)
Select either the administration or guest room telephone type.

Room Class field (Hospitality Only)

Enter the room class (0 through 14). Each class label can be changed by
selecting the specific class, clicking Browse, and entering the new label
in the Edit Room Class dialog box Description field.

Organization field

Describes the organization of the user. The organization is defined in
“Organization section” on page 4-8.

LMG field (NEAX IPX UMG Only)

Use the LMG drop-down menu to specify the Local Module Group to
which you are assigning the signaling server. (This step is only available
on the NEAX IPX UMG.)

Annex field (Hospitality Only)

Enter the annex location. Each annex label can be changed by selecting
the specific annex, clicking Browse, and entering the new label in the
Edit Annex dialog box Description field.

Floor field (Hospitality Only)

Select the floor number and elevation. The floor number is selected by
using the field’s scroll arrows. The elevation choices are Ground and
Underground.
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Location field
Used to identify the location of your phone.

Phone Model field

The models listed will be based on the IP Phone Type option selected in Chapter 6,
= System Information, Station Ranges Tab.

¢ Phone Model Browse button

Clicking the Browse button located next to Phone Model field allows
you to access additional information addressing the phone model as
shown in Figure 8-7. This dialog provides a detailed description the
phone and a list of its features.

Figure 8-7 Phone Model - General Tab

Phone Model X

General l

Phaone Model
P P-P Series E [ DTP-1ED )
Description:
Multiline digital phone, TOM phone but can be connected

wia P with adapter. &l zenies E phones have 3 function
ez,

Features:

+ Dizplay Phone

+ 1B Programmable Line Keyz
2-Color LED per key for call status
2 Lines 24 characters of LCD
Call / Meszage Indicator Lamp
Built in Headzet Jack
Hands-Free Speakerphone
Yalume and Contrazt control

3 Softkeps for desktop productivity

k. | Cancel

— Phone Model field

You can select a model and view detailed information on that
particular phone.
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Button Template field

The Button Template field allows you to select a button template. This
template contains definitions for the buttons for that particular phone
model.

e Phone Model Browse button

You may edit the template by clicking the “...” button. In this case,
editing will effect the template for all users assigned that template.

The Button Layout editor is a single application that handles the
button layout template editing for 2, 8, 16, 24, and 32 button phones
in the E Series, I Series, Dterm IP (ITR), and INASET (ITR-LC) phone
models.

Figure 8-8, Figure 8-13, and Figure 8-14 display the Button Template
editor.

Figure 8-8 Button Template Editor- Edit Button Template Tab

Button Template Editor, E|
Edit Button Template l.ﬂ.dvanced] Infu:urmatiu:un]
M arme Feature Type
|Default 16 Buttan |Statiu:-n j
K.y | Dezcription | Label Buttan Label
01 {MYLINE = FRIMELIME} ML}
02 Station % al
03 1: Call Forwarding-Busy Line FDEB 2on « aue
04 22 Call Foward Dont Answer FON |{MYLINE = PRIMELINE} =
05 2 Call Forwarding-all Calls FDA, .
0 Ring Type
07 |?: D/M Ring. Mo Delay ﬂ
na 5 Call Back. CB
09 Bh: Page PAGE
10 B Mezzage Reminder MS5GE-R
11 132 Call Redirect/Quick Transfer REDIR
12
13
14
15
16
4 »
HEPN ST Dz able Flex Eeps Clear Keysz F3~F11 does naot apply ta Series-E
] | Cancel
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User Assignments 8-9

All template editors make heavy use of macros. When the project
is compiled, the MA4000 Installation Manager provides a value for
each user wherever the macro is used. See Table 8-1.

Table 8-1 Macros

Macro
{MYLINE = PRIMELINE}

{MYLINE}

{PRIVIELINE}

{SUBLINE}

{ADDITIONAL SUBLINE}

{USER NAME}
{MANUAL ENTRY}

{DSS ENTRY}

Description

This is the primary physical phone number
(assigned to the hardware LEN with a physical
station number) of the user and is to be set as the
Prime Line.

This is the primary physical phone number
(assigned to the hardware LEN) of the user but it is
not set as the Prime Line.

This is the line which is selected by default when
the station is off-hook This number is assigned from
the OFFSET Station Range.

A Subline applied to a button of a phone would not
be automatically placed in a Pilot Hunt Group with
the MyLine/PrimeLine of the phone. Only one
SUBLINE is allowed per key Data Template. This
number is assigned from the OFFSET Station
Range.

This is used in configurations with more than one
defined {SUBLINE}.

Provides pull-down menu to select user

Provides an edit box to enter a numeric value for a
station

Provides DSS information for a station

TEC
TEC=12

TEC=12

TEC=18

TEC=18

TEC=18

TEC=3 12,18
TEC=3, 12,18

TEC=3, 12,18

— Button Template Editor - Edit Button Template Tab
e Name field

The name of the button layout template is the value shown
in the list of button layout templates on the Edit User dialog.

e Feature Type field

The Feature Type field provides a list of available features.
Available options are displayed in Figure 8-9 through Figure

8-11.

e Key Data Programming list

The list located below the Name field (see Figure 8-8)
displays each key, a description of the programming for that
key, and the label. This area does not provide direct editing
capabilities. You can select a key and assign a value using
the data entry boxes to the right of the list.

o Flex Keys field
This field allows you to either show or hide the Flex Keys.
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e Clear Keys button

Clicking the Clear Keys button eliminates all the key
definitions currently existing in the Key Data Programming
List.

Figure 8-9 Button Template Editor - Feature Type: Not Assigned

Feature Type

M at Azzigned

Figure 8-10 Button Template Editor - Feature Type: Function

Feature Type

Furction

Functian

Buttan Label

putonibel

Features By Mame

| Show All Features ﬂ

: Call Forwarding-Busy Line Y
: Call Forwarding-all Calls

: Executive Right-OFf-w ay

: Call "W aiting

: Call Back.

. Meszage Reminder

: Save And Repeat

- Lazt Humber Dialed

: Bozs-Secretan Mag W ait-Set

10: Call Hold

11: Boss-Secretany Maq 'Wait-Cheol

12 Call Fickup-Group

13: Three-way Calling

14 Voice Call

15: Speed Calling-System [Senes i) v

b I P PPN R | pa Y I

L0000 =) O L1 e D o —2

e Button Label field
The suggested, editable label for the function selected.
e Feature By Name field

The Features By Name combo box is a filter for the list.
The user is able to simply select from a list of Call
Forwarding features rather than search through hundreds of
other features.

A user can assign a feature to a key by selecting the key in
the listing and then double click the feature in the Features
list. The result is that the feature is assigned.
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The numeric value of the function as specified by the
SV7000, R16 manual. You can display all the features
available, or just by the ACD, AD64, Call Forwarding, CALL
PICKUP/PAGE, or FLEX group.

Figure 8-11 Button Template Editor - Feature Type: Station

Feature Type

station
Button Label

|Statiu:un Yalue J
Ring Tupe

|7: DM Ring, Mo Delay

L

R oute R estrictions [FSC]
|< [1ze Muline Settings >

L

Service Bestrictions [SFC]
|< [1ze Muline Settings >

L]

Call Fanmarding

L

|< Ilze Muyline Settings »
Mame Display

L

|< [1ze Muline Settings >

e Button Label field

The suggested, editable label for the function selected.
e Station Value field

You can select from those items listed in Table 8-1.
e Ring Type field

You can select from a list of seven different ring types to the
user:

: No Ring

: Day Ring, No Delay

: Night Ring, No Delay

...Not Used...

: D/N Ring, 30 Second Delay
: D/N Ring, 20 Second Delay
: D/N Ring, 10 Second Delay
: D/N Ring, No Delay

NoOuhrhwWNHO

Each selection has a number associated to it for quick data
entry. For instance, a 7 results in a No Delay ring type.

e Route Restrictions (RSC) field

You can select either Use Myline Settings or RSC - 0
through RSC - 15.
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e Service Restrictions (SFC) field
You can select either Use Myline Settings, SFC - 0
Reserved for Trunks, SFC - 1 through SFC - 13, SFC -14
Conferencing, or SFC - 15 ACD.
e Call Forwarding field
You can select either the Default Call Forwarding, None,
Use Myline Settings, or New option.
e Name Display field
Select the None, Use Myline Settings or Custom option.
pA3%) If the Custom option is selected in the Name Display field, the Custom Name
é Display Value field displays.
NOTE

Figure 8-12 Button Template Editor - Feature Type: Station - Name Display: Custom

Feature Type

| Station j

Button Label

Station W alue

Ring Type
|7 D/N Ring, No Delay

L4

L

Fioute Restrictions [RSC)
|< dze Myline Settings »

L]

Service Restictions [SFC]
|< dze Muline Settings >

4]

Call Farwarding

L]

|< dze Myline Settings »
Hame Dizplay

L]

| ¢ Custorm >

Cuztom Mame Dizplay Walue
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— Button Template Editor - Advanced Tab

The Advanced tab (Figure 8-13) consists of system specific data or
data that is typically defaulted for 90% or more of the user.

Figure 8-13 Advanced - Button Template - Advanced Tab

Advanced - Button Template

Edit Button Template Advanced ]Infurmatic.n]

k.ey Preferences W ezzage W aiting Dizplay
Line Preference |T|:||:| Line [Default] j
|Set For Other Buttons ﬂ OffHook Supression
Speaker ey |N':' (Drefault) ﬂ
| Prime: Line Pickup [Default] |

Saft-Key
Anzwer Key Pattern
| Prime: Line Pickup [Default] | |0 (Defaul) |
Originating Key Scrall Key
| Prime: Line Pickup [Default] - |On #th Key of SoftKeys Defaul] |

Ok | Cancel |

Table 8-2 Advanced Button Template Options

Field Options

* Line Preference Pattern for Speaker Button (Default)

* Dial ICM, Line Preference Pattern for Speaker Button

« Automatic ICM, Line Preference Pattern for Speaker Button
* Manual ICM, Line Preference Pattern for Speaker Button

« Automatic ICM, Manual ICM, Line Preference Pattern for Speaker
Button

Key Preferences

Priority of Answering Call
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Field

Options

Line Preference

Speaker Key

Answer Key

Originating Key

* Prime Line Pickup (Default)
+ Set For Other Buttons

Note: Speaker, Answer, and Originate Preference areas are only
configurable if the Line Preference = "Set For Other Buttons"

* Prime Line Pickup (Default)
* ldle-Line

* Incoming-Line

* Ringing-Line

* Prime Line Pickup (Default)
* Incoming-Line

* Ringing-Line

* Prime Line Pickup (Default)
* ldle-Line

* Prime/ldle-Line

Message Waiting Display

* Top Line (Default)
* Bottom Line

Off-Hook Suppression

* No (Default)
* Yes
Note: Selecting Yes enables support for ofthook suppression.

Pattern

Scroll Key

Soft Key

* 0 (Default)
«1to 15

Note: The Soft Key Pattern offers the user a choice between pattern
0to 15. These patterns are stored in the switch. The patterns
themselves will not be programmed by MA4000 Installation
Manager.

Important: There may be some models that do not have Soft Keys.
In those cases, the Soft-Key Pattern and Scroll Key
controls will be ignored.

+ On 4th Key of Soft-Keys (Default)
+ Allow on Line/Feature Keys
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— Button Template Editor - Information Tab

Figure 8-14 Button Template Editor - Information Tab

Button Template Editor,

Edit Buttan Template I Advanced  InFormation

Button Layout Motes

Ok I Cancel

The graphic of the phone is provided to the user to show
them the button layout. This helps the user match up a
particular button with the key number in the list to the right.

The graphic is static and provides no interaction. The picture
simply displays the location of each button by number.

o Notes field
The notes are displayed in the Manage Template listing.
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Station Range Type field
This section changes depending on the Type selection.

e Manual Option

You can manually assign an extension number to this user. The user
enters the station number in the Station Number field.

Station R ange Type

| b aral ﬂ

Statior Murber Subline Statian

e Station Range

Allows the automatic selection of the station number or creation of a
new number.

Station A ange Type

|Statin:-r'| Range ﬂ
Station Mumber
|< Auto Select Station Mumber = ﬂ

— To create a new Station Range, select the <New... > option. When
Figure 8-15 displays, enter the desired information.

Figure 8-15 New Station Range
HMew Station Range PX|
General l

D'ezcription

Station Range
Frorm To

Subline [ TEC: 18
Oifzet From To

Office Code
Area Code + Office Code

k. | Cancel
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Route Restrictions (RSC) field

The Route Restriction numbers in the system. There are only 16
available, numbered 0 through 15.

Service Restrictions (SFC) field

The Service Feature Class numbers in the system. There are only 15
available, numbered 1 through 15. Figure 7-5 displays when the
Browse button is selected.

Call Forward field

The Call Forward Template allows the user to select a template that
will be used to apply the call forwarding behavior for this user.

Selecting the Browse button will display a dialog behaving slightly
differently depending on the system setting for Call Forwarding. Figure
8-16 and Figure 8-17 are the same for either type of Call Forwarding
setting.

Figure 8-16 Edit Call Forwarding Template - General

Edit Call Forwarding Template

General l Infarmation ]

M ame

|Default Call Fanwarding

Call Farwarding &l
[{ND ENTRY}

Lo

Call Formarding Busy
[{WOICEMAIL}

L«

Call Fonwarding Mo Answer

[{WOICEMAIL} |
Lag Out
[{ND ENTRY} |

| k. | Cancel
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Table 8-3 Edit Call Forwarding Template Options

Option Description

{NO ENTRY}
{VOICE MAIL}

{ATTENDANT}
{SUBLINE}

USER NAME

MANUAL ENTRY

Do not program this call forwarding option.
Assign the voice mail pilot number here.

Assign the attendant console number as defined in the System
Options tab.

Allow call forwarding to subline.

Provides a display area and user interface mechanism for assigning
a user to this call forwarding feature. During compiling, the user
name is replaced with their actual station number they are provided.

Provides an edit box for the user to enter a numeric value for a
station.

Figure 8-17 Edit Call Forwarding Template - Information

Edit Call Forwarding Template

General

M otes

Information

Drefault Call Forwarding Template.

R estrictions

Split Call Fonwarding iz not supported.

k. | Cancel

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



User Assignments 8-19

Voice Mail Template

Figure 8-18 New Voice Mail Template - General

Mew Voice Mail Template

General l [ nFarmatiarn ]

Template Properties

Shation {STATION} ”~
M e {USER MAME}

Secunty code N

Arccess PCEF

Yoice name i

Language

Hold megz
Archive mags

M ew mzgz

Tatal

Tranzfer options
S creening ophions
Tranzfer
Tranzfer number
Tranzfer type
Tranzfer rings
Screening
Halding

Gather |0V intro
Standard

Busy

Alternate

EEEEZEZ = T A roomo

Synchronize with Wi Server Fezet Yalues to Default |

ak | Cancel |

Synchronize with VM Server button
Select this button to the match the current template properties with the

VM server.
paad This option is not available unless the Voice Mail is programmed and on-line.
NOTE
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Reset Values to Default button

Select this button to reset the current template properties to the default
values.

Figure 8-19 New Voice Mail Template - Information

Mew Voice Mail Template

General  |nformation

MHotes

Thiz iz the Wb Template 1
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Group Memberships section

Understanding the Group Assignments

The Group Assignments lets you define call handling for groups of users.
Groups should contain at least two members. If you create a new group
containing fewer than two members, Installation Manager displays a
warning dialog and will write an error notice to the installation log during
a compile. You can create five types of group assignments:

e Hunt Group - Circular: An incoming call proceeds through a group
of up to 100 stations until it reaches a not-busy station. Calls to any
member of this group will be processed the same way. The secretary
station is optional. If it exists, the call will be directed to the secretary
station if all the stations in a hunt group are busy.

¢ Hunt Group - Pilot: Incoming calls to the pilot number begin the
hunting sequence. Calls to busy stations, other than the pilot number,
receive a busy tone. The secretary station is optional. If it exists, the
call will be directed to the secretary station if all the stations in a hunt
group are busy.

¢ UCD Group: Incoming calls are distributed to a group of up to 100
stations. Calls are distributed to idle stations in a circular pattern, in
the order in which they arrive.

¢ Pickup Group: A group of stations with the ability to pick up calls
made to any other member of the group.

e Secretary: A user can be defined as a secretary allowing that user to
be used by the group assignment. A secretary can be assigned to
multiple groups (multiple secretary feature), but not as a member of
the Pilot or Circular Hunt groups.

Figure 8-20 Edit User - Group Memberships

Group Membershipz

Pickup

|<N|:une> ﬂJ

Hunt [ Circular / Pilak ]

|<N|:une> ﬂJ

Hunt [ UCD )

|<N|:une> ﬂJ

Pickup field

In the event a member is already assigned to a hunt or pickup group,
selecting a different template from the list will have the effect of
removing them from the prior hunt/pickup group and adding them to
the new one (only allowed in the case that the new hunt/pickup group is
not already full). In the case where the new hunt/pickup group is full
already, the user will be prompted to either edit the newly selected
pickup group to make room for this member, or add a new pickup group
template. See Figure 8-21, Figure 8-22, and Figure 8-23.
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Figure 8-21 New Pickup Group Template - General

Mew Pickup Groups Template

General l Information |

MHame

Memberz [0 of 100 uzers azsigned]

Lazt Mame | Firzt Mame | Add

Delete
Move Up

Move Down

i

K, | Cancel

e Add button

The Add button creates a new entry. Figure 8-22 displays.
e Delete button

The Delete button removes a selected entry.
e Move Up button

The Move Up button moves an entry up until the entry is located
where you want it to be.

e Move Down button

The Move Down button moves an entry down until the entry is
located where you want it to be.
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Figure 8-22 Select Users

MHate

Y'ou can zark the ligt by clicking on the column title.

“'ou can zelect more than one entry by holding down the [Cl] key when zelecting entries.

Y'ou can zelect conzecutive entries by first zelecting a starting entry, holding the shift key
down, and select the ending entry. All entries in between will be selected.

Last Mame ° First Mame ORGAMIZATION
Johhzan John #1e - Development...

Ok | Cancel
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Figure 8-23 New Pickup Group Template - Information

Mew Pickup Groups Template

General  Information

Motes

R estrictions

Only 100 extenzions can be azsigned to one pickup
arap

A extenszion can anly be azzigned ko one pickup
qQroLp

Expanded pickup groups are not supported.

(04 | Cancel

— The Notes field allows the user to enter any free form text
associated with a user.
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Hunt Fields

When a hunt group template is chosen the user is automatically added
to the hunt group. The template determines whether the hunt group is
Circular, Pilot, or UCD.

In the event that the hunt group already has 100 members, the user will
be notified and given the option to create a new group or edit the
selected group to make room for this member.

In the event a member already is assigned to a hunt or pickup group,
selecting a different template from the list will have the effect of
removing them from the prior hunt group and adding them to the new
one (only allowed in the case that the new hunt/pickup group is not
already full). In the case where the new hunt/pickup group is full
already, the user will be prompted to either edit the newly selected
hunt/pickup group to make room for this member, or add a new hunt/
pickup group template.

The user can select the Browse button to launch the Hunt (Circular/
Pilot) and Hunt (UCD) field editors.

Hunt (Circular/Pilot)

Options:

¢ None

e New Circular Hunt Group (see Figure 8-24)

e New Pilot Hunt Group (see Figure 8-25)
e Secretary (see Figure 8-26)
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Figure 8-24 Edit Hunt Group - Circular Template Option

Edit Hunt Group - Circular Template

Group l Infarmation |
M ame
I

Secretary [naot reguired]
| Add| Del

&

bembers [0 of 100 users azzigned)
Lazt Name | Firzt Marne | Add

Delete
kMowve p

b ave Down

el

s | Cancel
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Figure 8-25 New Hunt Group - Pilot Template Option

Mew Hunt Group - Pilot Template

Group l Infarmation |

Mame

Secretary [nat required]

| ﬂ Del

Memberz [0 of 100 uzers azsigned]
Lazt Mame | Firzt Marne | Add

2

Delete
tove Up

bave Down

el

] | Cancel
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Figure 8-26 Secretary Option

Select groups

x]

Hate

'ou can zart the ligt by clicking on the column title.

Y'ou can zelect more than one entry by holding down the [Cl] key when selecting entries.
Thiz lizt dizplavs all of the hunt grouplcircular/pilat] and secretary assignment.

To azsign secretamy, select the group and click Add. To remowe secretary azzignment,
zelect the group and click Remove.

Group Type Azzigned

Add Remove
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Hunt (UCD)

Options:

¢ None

¢ New (see Figure 8-27)

Figure 8-27 New UCD Group Template

Hew LICD) Group Template

Group l Infarmation |

MHame

b embers [0 of 100 users aszigned]
Last Marie | First Mare |

Add
Delete
Move p

tove Down

il

X

o]

Cancel
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Misc Section

Figure 8-28 Misc.

Mizc

Jack 1D

0Id Phone Mumber

Phone Hardware Accessones

|Default Hardware Accessaries ﬂ J

Jack ID field

The Jack ID is used only for reporting purposes. It is useful when it
comes to cable management, phone placement and running of cross-

connects.
Old Phone Number field

The user’s previous phone number.

Phone Hardware Accessories field

The user can select from a list of Phone Hardware Options templates
(see Figure 8-29 and Figure 8-30). If the user clicks the Browse button,
the user will be shown in the Accessories Editor.

This information is used for reporting purposes only. No validation will
be performed. See Table 8-4 and Table 8-5.
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Figure 8-29 Edit Phone Accessory Template - General

Edit Phone Accessory Template

General | Information ]

Template Mame

D efault Hardware Ac

Handzet Cord

|.'-" foak j
Base Cord

|? foak j
Headzet

[No |
W allrmiowt

[No |
Adapter

|< Maone » j

K, | Cancel |

Table 8-4 Edit Phone Accessory Template Options

Option Description

Template Name

Handset Cord

Base Cord

Headset

Wallmount

Adapter

User enters a unique Phone Accessories Template name here.

This is the length of the cord from the handset to the base. The user
has the choice from 7 foot, 12 foot, or 25 foot cords.

The user has a choice of 7 foot, 14 foot, and 25 foot cords. This is
the cable length from the phone to the wall.

The user has the choice of Yes or No headset.
The user has the choice of Yes or No for a wall mount adaptor.

The Adapter section only applies to phone types that are Series i or
Series E. If this template is used on a phone that is neither one of
these model, then the reporting will be off. Since this information is
provided as a convenience to the user, and there is no system
programming associated with any of these options, then it is up to
the user to make this information meaningful. It is suggested that, if
needed, the user create separate templates for phone models that
support adapters and those that do not.

The column Common Listing will be the available selections in the
Adapter drop-down box. See Table 8-5.

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



8-32 User Assignments

Table 8-5 Phone Adapters

Series i Series E Common Listing Remarks
AD(A) ADA-U ADA Ancillary Device Adapter
AP(A) APA Analog Port Adapter w/o Ringer
AP(R) APR-U APR Analog Port Adapter w/Ringer
HFU-U HFU Hands Free Unit
CT(A) CTA-U CTA Computer Telephony Adapter
CT(U) CTu Computer Telephony Adapter (USB)
IP-R IPA-U IPA IP Adapter
LLA LLA Long Line Adapter

Figure 8-30 Edit Phone Accessory Template - Information

Edit Phone Accessory Template

General  Information

Mates

F actaory Default Phone Accessones,

K, | Cancel

e Delete button

The user must first select one or more items in the list shown in Figure
8-1, “User Assignments Tab” on page 8-1. Once they are selected, the
user clicks the Delete button. Figure 8-31 displays. Clicking the Yes
button will permanently delete the data from the project. Selecting the
No button will cancel the operation.
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Figure 8-31 Warning - Delete User Profile

L] E Delete User Profile?
[ ]
Yes | Mo |

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



8-34 User Assignments

Import button

The Import button launches the User Import Wizard. The User Import
Wizard allows the user to import the user information from a text (or
.csv) file. The data format for the import file can be either:

— Tab delimited
— Comma delimited
Both layouts are the standard for Microsoft Excel output format.

Import User Wizard
e Welcome Panel

Figure 8-32 User Update Wizard - Welcome to Installation Manager User Import

User Import Wizard @

Welcome to Installation Manager
User Import

Thiz wizard will quide you through the user import process

| Mest » | Cancel

Step 1  Select the Next button to proceed. Figure 8-33 displays.
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Figure 8-33 User Import Wizard - Import File

User Import Wizard

Import File
Specify the file that containz the user information ta impart,

Select the file to import

Location of file

< Back | Mext > | Cancel

Step 2 Use the Location of file field to specify the complete path and file name
to be used to import users, or select the Browse button to open an
existing file.

Step 3 After the file is selected, click the Next button to continue. Figure 8-34
displays.
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Figure 8-34 Record Separation - Record Delimiter

Record Separation

Record Delimiter
Provide the end of line recaord delimiter for this file

[v Usze First Fow Az Field Mames End of Line Character |New Lire j

S ample Data Delimiter Character ||:|:|mma j
Last Mame | FirstMame | STA_DISP.. | ORGANIZ.. | ORGAMNIZ.. | ORGANIZ... |
Johnzon John JohnJohns..  =YE-Dew.. =BYE Development
< | >

< Back | M et > | Cancel

Step 4 Provide the end of line delimiter to use. The delimiter character choices
are:

—Comma
—Space
—Tab
Step 5 Click the Next button to continue. Figure 8-35 displays.
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Figure 8-35 Select Import Value - Field Names

Select Import Value

Field Hames

@ Figld Mames

On the right iz a lizt of the field names pou are
importing. [ pou want o rename any of these
fields you may dao 2o by zelecting the field and
editing itz name in the box above the list,

Change the name af any of the fields you are imparting

=

Mame

|Last M ame
Field Prevview Data &
Last Mame Johnzan
Firzt Mame John
STA_DISPLAY John Johnzon
ORGAMIZATION #re - Developm
ORGAMIZATIOM LE... =42
ORGAMIZATION LE... Dewveloprient
ORGAMNIZATION LE... Applications
ORGAMIZATION LE... Software

Lacatian

£

ORGAMIZATION LE...

Irving, Texas - A w
»

¢ Back | Mext > | Cancel

8-37

Step 6 You may change the name of any of the fields being imported by
selecting the field name and editing its name in the Name field. When
finished, click the Next button to continue.

Step 7 Click the Next button when finished. Figure 8-36 displays.
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Figure 8-36 Default Values - Field Mapping

Default Values

Field Mapping
Faor each field an the left provide the matching figld name that iz being imparted

Import Fields: [Match import fields on the right with options on the left]

Last Name Last Mame [ex Johnsan] ﬂ ~
Firzt Mame Firgt Marme [ex John]

Phone kModel Phone bModel [ex: DTR-320D - Senesi 3.
E=TEMSION EXTENSION [ex: ]

MAC ADDRESS MAC ADDRESS [ex: ]

Station R5C Station RSC [ex: 1]

Station SFC Station SFC [ex: 1]

Id Extenzion < lgnore »

STATIOM_ROLLOWER STATIOM_ROLLOVER [ex: )

JaCk 1D JACK D [ex: )

Ebdall ErAIL [ jjohnzoni@abc. net]

Motes < lgnore > A

(Tt T T Rl o B | (Tt T o TN R O o [ T ]

< Back Cancel

Step 8 For each field option listed in the left column, use each drop-down box
located in the right column to select the matching imported field. Figure
8-37 displays.
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Figure 8-37 Column Match - Default Values

Column Match

Default Yalues
Az each uger ig added, zpecify default values for important figlds.

Select Default Values

b odel DTR-8D - Seriez i 8 Button L
Buttan Template Drefault 8 Button
Station R5C RSC -1
Station SFC SFC-1
Call Fonwarding < Mone »
STA_DISPLAY Lasgt Mame
Station Range Type Station Range
Station Range Template < Mone »
Yoice Maill Template < Mone »
ErAlL < Mone »
GROUP_HUMT < MNone »
GROUP FICEUP < More » -
ICD Group < Mone »
PHOME_ACCESSORY < MNone »
Phaze Phaze 1 User Data + Hardware Installati.. .
Station SFC
Station BSC

< Back | Mext » | Cancel

Step 9 Specify the default values for each important field for each user. When
finished, click the Next button.

Step 10 The User Import Wizard will begin importing each file and creating new
users. When finished, Figure 8-38 displays.
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Figure 8-38 User Import Wizard - Completing User Import Data

User Import Wizard @

Completing User Import Data

Y'ou have successiully imported 1 records

Cancel

Step 11 After the file is imported, the user is presented with the results of the
import. If there were any errors, they will be reported here as well.

Step 12 Click the Finish button to close the wizard.
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e Export button

The Export button allows the user to export the list of selected users.
The user will first select a set of users and click the Export button.
When the user clicks the Export button, Figure 8-39 displays.

Figure 8-39 Save As - Export Users

Save As E]

Save in: |l.f,\ Templates j ﬁ -
E |%test.csv
by Becent
Documents
[[;
Desktop

by Computer
" File name: || ﬂ
by Metwork, Save az type: ||:5'u' j Cancel
Placesz

The User Export function exports all the information on the Edit User
dialog. The following information items listed are:
e Last Name

e First Name

e Phone Name Display

e Organization

e Location

e Phone Model

e Class Template Name

e Station Number

e Button Template Name

e Call Forwarding Template Name

e Accessories Template Name

¢ Voice Mail Template Name
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e Pickup Group Name

e Hunt Group Name

e Jack ID

e Old Phone Number

After the export is complete, Figure 8-40 displays.

Figure 8-40 Success - Export User

Congratulations! 1 users have been exported to the file
Zi\Program Files\MEC Installationfgr_R200 Templatesitest2, csy

2 When importing from the results of an export operation, there will be some
= information that will need to be specified upon re-importing. Specifically the template
NOTE information is exported but will not be re-used on import. The user will need to

specify a default template for each template as the users are imported.
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e Update Wizard button

Figure 8-41 User Update Wizard - Welcome to Installation Manager User Update Wizard

User Update Wizard @

N Welcome to Installation Manager
User Update Wizard

Thiz wizard will guide you through uzer update process of
updating multiple users with identical infarmation.

Ewample: %'ou can aszign the Phone Model of a set of
selected user wery quickly,

Tao continue, click Mest Buttan,

| MHest > | Cancel

Step 13 Click the Next button to proceed. Figure 8-42 displays.
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Figure 8-42 User Update Wizard - Select Operation

User Update Wizard

Select Operation
Select the operation pau would like to perfarm.

Type Mame or Select from hst

Select Userz |Ipdate M ames

Johnzan, John Add 5 Jahnzan, John
<< Remaove

Add Al
<< Remove All

¢ Back | M et > | Cancel

Step 14 Select the user records to update using the Add, Remove, Add All, or
Remove All buttons, then click the Next button to proceed. Figure 8-43
displays.
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Figure 8-43 User Update Wizard - Select Values

User Update Wizard

Select Yalues p
Select all values to be updated. 'J

Set the default value of each field when the figld iz empty
Organization

< Mo Change »

Location

L]

|< Mo Change >

Phone todel Station Range Type
|< Mo Change > |< Mo Change >

L«
L«

FPhone Button Template Station Humber

Route Restictions [R5C] Call Fonwarding
|< Mo Change » |< Mo Change »

L L
L L

Service Restrictions [SFC] Yoice Mail

|< Mo Change » j |< Mo Change » j
Hunt [ Circular / Filok ] Pickup Group

|< Ma Change > ﬂ |< Ma Change > ﬂ
Hunt [ LUCD ] I arme Dizplay

|< Mo Change > j |< Mo Change » j
Fhone Accessony E Mail

|< Mo Change » ﬂ |< Mo Change » ﬂ
Phaze

|< Mo Change » j

< Back | MHext = | Cancel

Step 15 Set the default value of each field. Click the Next button to proceed.
Figure 8-44 displays.

paY If a user selects a phone model with no button layout (Analog, SIP, etc.), the Button
= Template combo box will change to <Clear>.
NOTE
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User Assignments

Figure 8-44 User Update Wizard - Verify Settings
Venfy Settings r‘,
Pleaze review the specified settings before continuing. d

User Update Wizard

The fallowing settings will be applied ta the selected uzers. IF thiz iz what pou intend ta da,
prezs the Mest Button,

Field M.arne | W alle

ORGAMIZATION < Mo Change >
Location < Mo Change »
Phone Model < Mo Change »
Raoute Restrictions [RSC] < Ma Change »
Service Feature Restrictionz [... < No Change »
Buttan Template < Mo Change »
Station Range Type < Mo Change »
Station B ange < Ma Change »
Call Forwarding Template < Mo Change »
Yoice Mail Template < Mo Change »
FICKLP < Mo Change »
Hunt < Ma Change »

Warning: these settings will be applied to all selected wzers. IF this iz not desired
presz the Back Button and modify the settings or press the Cancel Button to abort
thiz operation.

< Back | M et = | Canicel

Step 16 Review the settings specified. If satisfied with the values, click the Next
button to continue. Figure 8-45 displays.
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Figure 8-45 User Update Wizard - Completing the User Update Wizard
User Update Wizard E

Completing the User Update
Wizard

Congratulations. vou have succezsfully Completed the User
pdate “wizard. The resulks of thiz operation are shown below.

Yaou have successfully updated 1 recards

Cancel

Step 17 Click the Finish button.
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Group Assignments

This chapter describes the MA4000 Installation Manager’s Group
Assignments section (Figure 9-1).

Figure 9-1 Group Assignments

m Installation Manager [:J|E|E|
File Edit Tools Help

<] <] 10f1 BE Edit New | Delete |

MName | Type | Dezcription |
< Woice Mail Group » UCh Drefault Yoice Mail Group

Praject
Infarmation

Hardware
Infarmation

Syztem
Infarmation

Advanced
Featuras

User
Azzignments

Group
Aszsignments

Circuit Card
Azzignments

Install

Reports

Froductivity
Features

e Edit button

The user will select a group from the list box, then select the Edit
button. This will allow the user to edit that hunt group. The dialog that
is displayed (see Figure 9-2 and Figure 9-3) will depend on the hunt
group selected.
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¢ Edit Pickup Group

Figure 9-2 Edit Pickup Groups Template - General

Edit Pickup Groups Template

General | Information ]

Mame

kemberz: [0 of 100 uzers azzigned]

Last Mame | First Mame | Add

Delete

Move Lp

il

Maowve Daown

K | Cancel
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Figure 9-3 Edit Pickup Groups Template - Information

Edit Pickup Groups Template

General  Information

Maotes

R ezstrictions

Only 100 extenszions can be azsigned o one pickup
qQroLp

A extenzion can only be azsigned ko one pickup
QroLp

Expanded pickup aroups are not supparted.

K | Cancel
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e New button
When the user selects the New button, Figure 9-4 displays.

Figure 9-4 Select Users - New Group

Group Tyupe
" Hunt Group - Circular
" Hunt Group - Pilat
" UCD Group

" Pickup Group

] Cancel

Step 1 Use the radio buttons to select the appropriate Group Type, then click
the OK button.

—When the Hunt Group - Circular type is selected, Figure 9-5 and
Figure 9-6 tab screens display.

—When the Hunt Group - Pilot type is selected, Figure 9-7 and Figure
9-8 tab screens display.

—When the UCD Group type is selected, Figure 9-9 and Figure 9-10 tab
screens display.

—When the Pickup Group type is selected, Figure 9-11 and Figure 9-12
tab screens display.

The minimum number of entries for a Group is 2.
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Figure 9-5 New Hunt Group - Circular Template - Group

Mew Hunt Group - Circular Template

Group l I nfarrmaticr ]
M arme
|
Secretary [hat required]

| Add

tembers [0 of 100 uzers assigned]
Last Mame | First M arne | &dd

Del

&
2

Delete

Maowve Up

i

b ovee Diown

k. | Cancel
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Figure 9-6 New Hunt Group - Circular Template - Information

New Hunt Group - Circular Template

Group  Information

M otes

Resztrictions
The magimurm numberz within a Circular Hunt group is 100

A member azzigned to a UCD or Pilat Hunt graup may st
be azzigned to a Circular Hunt group.

Once aszigned to a Circular Hunt group, a member of thiz
hunt group may nok regide in either a Pilat ar a LCD Hunt
qroup.
Secretanes are not counted as ane aof the 100 allowed
members per group. A maximum of 255 hunt groups can
be overflowed to the same secretanial extension.

k. | Cancel
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Figure 9-7 New Hunt Group - Pilot Template - Group

Mew Hunt Group - Pilot Template

Group l Infarmation |

Mame

Secretary [nat required]

| ﬂ Del

Memberz [0 of 100 uzers azsigned]

Lazt Mame | Firzt Marne | Add

2

Delete

tove Lp

i

taove Down

] | Cancel

gonss The same secretary may be included in multiple groups (the multiple secretary
= feature). The secretary can not be a member of Pilot or Circular Hunt Groups.
NOTE
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Figure 9-8 New Hunt Group - Pilot Template - Information

HMew Hunt Group - Pilot Template

Group  Information

Maotes

Festrictions

The maximum number of members within a Pilat Hunt
qroup iz 100

8, mgaml:uer _assig_ned_t_l_:u a_l__ll:D or Circular Hunt group may

Once azsigned o a Pilot Hunt aroup, a member of this
hunt group may not reside in either a Circular or a LCD
Hunt group.

Secretanes are not counted az one af the 100 allowed
memberz per group. & maximum of 255 hunt groups can
be overflowed to the zame zecretarnial extenzion.

k. | Cancel
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Figure 9-9 New UCD Group Template - Group

X

Mew LICD Group Template

Group l Infarmation |
Mame

kMembers [0 af 100 uzers aszigned]
Last Marne | First Mame | &dd

Delete
kove p

M ave Down

il

] | Cance
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Figure 9-10 New UCD Group Template - Information
Mew UCD Group Template @
Group  Informatian l

M otes

Restrictions
The maximum numbers within a JCO group is 100

A member aszigned to a Filot ar Circular Hunt group may
not be azzigned to a UCD Hunt group.

Once azzigned to a LUCD Hunt group, a member of thiz
hunt group may not reside in either a Circular or a Filot

Hunt group

k. | Cancel
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Figure 9-11 New Pickup Groups Template - General

Mew Pickup Groups Template

GEHEFa|lInFDrmaHDn]

Mame

Memberz [ of 100 users azsigned)

Lazt Mame | Firzt Mame

Add
Delete
bove Lp

b ove Diowin

il

K, | Cancel

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.

9-11



9-12 Group Assignments

Figure 9-12 New Pickup Group Template - Information

Mew Pickup Groups Template

General  Information

Motes

R estrictions

Only 100 extenzions can be azsigned o one pickup
qroLp

A extenszion can only be aszigned to one pickup
group

Expanded pickup groups are not supported.

K, | Cancel

o Delete button

The user first selects a hunt group to delete, then clicks the Delete
button. Figure 9-13 displays.

Figure 9-13 Confirm Delete - Delete This User Group Assignment

Confirm Deleta x

L] "j Delete this User Group Assignment?
L]

Yes | | Mo |
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Circuit Card Assignments

This chapter describes the MA4000 Installation Manager’s Circuit Card
Assignhments section (Figure 10-1).

PR3 Right-clicking an existing or blank circuit card assignment slot causes a dialog box to
= display providing you the ability to edit or delete an existing assigned chassis, or
NOTE assign a new Virtual chassis.

Figure 10-1 Circuit Card Assignments Tab

7% Installation Manager

File Edit Tools Help

Froject
st & < | Zoarlh Mew ‘ Delete ‘

Hardware IMG:0 """ e ]

Infarmation

Suztem
Infarmation

Advanced
Features

Uzer
Azzignments

Group
Azzighments

Circuit Card
Assignments

Irstall

Reports

Productivity
Features
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Circuit Card Assignments

Figure 10-2 NEAX IPX /IPX DM / UNIVERGE IPX Circuit Card Assignments

PIM 15 ﬂ ﬂ Zoom In Mew Delete

IMG: 1 [M0G: 2 [G: 3

Yirtual Flkd: &

0320000 - 031317

Wirtual Flkd: 5

022000 - 023317

Yirtual PIk: 11

052000 - 053317

Yirtual Flk: 3

040000 - 041317

Figure 10-3 UNIVERGE SV7000 Circuit Card Assignments

Chagsiz 3

HE

Zoom In

Hew

Wirtual Plk: 13

0E2000 - 083317

Chagsis: 3

12000 - 0137

Chagzis: 2

010000 - 01137

Chagziz: 1

002000 - 003317

Chazziz: 0

000aaa - o137

Wirtual Chazsiz: 7

032000 - 03317

Wirtual Chazsiz: B

020000 - 031317

Wirtual Chazziz B

022000 - 023317

Wirtual Chazsiz: 4

020000 - 021317

Wirtual Chazsiz 11

052000 - 053317

YWirtual Chazsiz 10

050000 - 051317

Yirtual Chassis: 9

042000 - 043317

Yirtual Chaszsis: 8

040000 - 041317
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Yirtual Chaszsiz 15

072000 - 073317

Yirtual Chazsiz 14

070000 - 071317

Yirtual Chazsiz 13

0E2000 - 063317

Yirtual Chazsiz 12

0E0000 - 061317
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Figure 10-4 NEAX IPX UMG Circuit Card Assignments

K| <] FIM 12 BEl Zomm | Mew Delete

LMG 0 LMG 1 LMG 2 LMG 3

[MG: O [k 1
Wirtual Plkd: 7 Yirtual Plk: 11

032000 - 033317 052000 - 053317

Wirtual PlM: 2

010000 - 011317

Wirtual Pk 1 Yirtual Flkd: 3

002000 - 003317 042000 - 043317

Virtual Flkd: 8

040000 - 041317

Creating a New Circuit Card Assignment (UMG)

An Ultra Module Group (UMG) system contains up to four Local Module
Groups (LMGs), each of which can contain up to four Interface Module
Groups (IMGs) and 16 Peripheral Interface Modules (PIMs).

To create a new circuit card assignment, do the following:
Step 1 Launch Installation Manager. The Startup dialog displays.
Step 2 Click the Projects tab, if necessary.

Step 3 Click a project in the list, then click OK. The Installation Manager main
window displays.

Step 4 Click the Circuit Card Assignments tab. A graphic outline
representation of your system displays.

Step 5 Click a location to select where you wish to add a PIM.
Step 6 Click New. The New Chassis dialog displays (see Figure 10-8).

Step 7 Click a radio button to specify whether you are defining a physical (9U or
6U) or virtual chassis (PIM), then click OK. A blank chassis (PIM)
displays in the system outline.

Step 8 Double-click the on-screen, or click Zoom In. A detailed view of the
chassis’s slots displays.
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Circuit Card Assignments

Step 9 Click in the diagram or use the Slot drop-down menu to select a slot you
wish to configure (see Figure 10-7).

Step 10 Use the Card drop-down menu to select the card you wish to configure in
the selected slot. If the card must be configured with additional

parameters, the Edit Circuit Card dialog displays (see “Setup IP... button”
on page 5-5).

You can also right-click a particular a slot in the diagram to display a pop-up menu,
select the Insert Card option, then select the desired card from the displayed list.

Step 11 Complete the Edit Circuit Card dialog with the appropriate values for the
card you are adding.

If you are configuring a physical protocol handler card refer to the following field
descriptions. Some options may not be available, based on the type of MG card you
wish to configure:

* Name - Device name

* Route Count - Number of the route that will be created for this device
* Data Ch. Route Name - The B-channel name

If you are configuring a trunk card refer to the following descriptions:

* Name - Device name

* Default Gateway Address - IP address of your network’s gateway router
* DRS Address - IP address of the Device Registration Server

* IP Address - Device IP address. Each media gateway must have a separate IP address
* Network Mask - Device IP network mask

Step 12 Click Zoom Out to return to the large-scale system view.

Step 13 (Optional) Repeat Steps 5-12 for any additional circuit cards you wish to
assign.
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Figure 10-5 UNVERGE SV8500 Circuit Card Assignments

Pit 2

HE

Zoom |n

10-5

= Delete

PIM: 3

012000 - 013317

FIM: 2

00000 - 011317

Wirtual PIM: 7

032000 - 033317

FIM: &

030000 - 03137

Wirtual Plkd: 11

052000 - 053317

Wirtual Plkd: 10

050000 - 051317

FIM: 1

002000 - 00337

PIM: 5

022000 - 02317

PIM: 9

042000 - 043317

FI: 0

000000 - 037

Pli: 4

020000 - 021317

Yirtual Flkd: 3

040000 - 041317

Wirtual Plk: 15

072000 - 073317

Wirtual Plkd: 14

070000 - 071317

Wirtual PIk: 13

062000 - 063317

Yirtual PIk: 12

00000 - 0R1317

The Chassis LEN numbers (see Figure 10-6) are based on the
information provided by the user when the “Create Project Wizard” on
page 3-7 is performed. Specifically, the number of ports selected in the
System Maximum Capacity field (see Figure 3-10, “"Create Project
Wizard - Project Name and Type - NEAX IPX and NEAX IPX DM” on page
3-7).

Figure 10-6 Chassis LEN Number

Yirtual Chassis: 11

052000 - 053317

Yirtual Chassis: 10

050000 - 051317

Wirhnal Thaseis 9
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e Zoom In button
When the Zoom In button is clicked, Figure 10-7 displays.

Figure 10-7 Circuit Card Assignments - Edit Chassis

K < PIM 3 Bl Zoom Out Mews Delete

LMG IMG Slt|4  v|  Cad|<Empty> |

22l =] 32 32| =] 3
[ Show &
LEN | Port Type | LT [Line... | LT Pair | LT Calar | Statian User A
12000 - Wirtual LEM -
1120 - Wirtual LEM -
m2002 - Wirtual LEM -
2003 - Wirtual LEM -
112004 - Wirtual LEM -
M 2005 - Wirtual LEM -
M 2006 - Wirtual LEM -
m2007 - Wirtual LEM - 7
12010 Sk =11 ChI
PR3 You can not insert, edit, or delete a circuit card in slot #23.
NOTE
gonss Right-clicking any circuit card slot allows you to delete or edit an existing assigned
é circuit card, or insert a new circuit card by selecting it from the Insert Card pop-up
menu.
NOTE

e Zoom Out button
Clicking the Zoom Out button returns you to Figure 10-2,
Figure 10-3, or Figure 10-4.

e New button
When the New button is clicked, Figure 10-8 displays.

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



Circuit Card Assignments 10-7

Figure 10-8 New Chassis

3

Mew Chassis
Create Mew

+ Physical Chassis
" ‘irtual Chassis

k. | Cancel

— Select the Physical Chassis or Virtual Chassis option button to
add the desired PIR to the Circuit Card Assignments panel.

o Delete button

To delete an existing Virtual Chassis from the Circuit Card
assignments, click the Delete button. Figure 10-9 displays.

Figure 10-9 Warning - Delete Virtual Chassis

.3) Delete Wirtual Chassis?

\h_-
Yes | Mo |
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Install

This chapter describes the MA4000 Installation Manager’s Install
section (Figure 11-1).

Figure 11-1 Pre-Installation Check List

T Installation Manager

File Edit Tools Help
Sz Pre-Installation Check List
Infarmation
Before continuing the installation process the following actions must be successfully completed:
Hardware
Information 1 Ifinstaling & Physical PIR, werify all circuit cards are mounted according to the Circuit Card Azsignment takb.
2 A vwalid TCPAP connection must exist between Installation Manager and the Yoice Server.
3 For eaze of use, configuring & DHCP Server on ywour network, with Option 003 and Option 161 wwould be helpful.
System Thig wauld allevigte much of the manual programming for the IP phones.

Imfiarmnation 4 Installation Manager iz designed to perform a one time installgtion to & clean Yoice Server database. You may want
ta perform a compile of your installation database prior to "loading” the installation database to the YWaice Server, in
order to verify via reports and other viewws that everything is set as you desire. The installation process will allaw

.-’-‘«deanced you to perform this action swithout loading information to your Yoice Server and Yoice Mail System.

eatures + Showld additional phones need to be added, major key data changed, elc. ater Instailing the Instaifation
Manager database to your volice server and voicemall system, use vour MALG00 Management System to
User make the aaditional changes to the Yoice Senver and your lraice Mall System management interface to
Azsighments make changes to your lralce Mall Sysitem.
Additional Resources:
Group MEC Suppart Weh Site
Azzighments Configqure DHCP Server pdf
1444000 I User Guide pdf
o 1444000 M User Guide pof
Circuit Card Phased Installation Guide doc
Azzighments Readme.doc
Releasebotes doc
Install
Reports
Productivity
Features

Step 1 Ensure all the actions listed in the checklist are completed before
continuing with installation.

Step 2 Click the Next button to proceed. Figure 11-2 displays.

Figure 11-2 Choose the Features You Want to Install

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



11-2 Install

Choose the features you want to install

Uze the list belosw ta select the features you wwant to uze in the installation. You can
uze the right mouse button to select pre-defined festure sets.

When you have finished selecting, press Mext. You wil then be prompted for more
infarmation for each feature you zelect. ¥ou can add or remove features at any time
by pressing Back until you return to this page.

Compile Installation Plan

] Flash System Memory Card

] Reaqister System

] Backup System Data Before Uploading Data
[ Upload Data To System

[ Upload Yoice Mail Data

[ lgrere Errars Durning |nstallation [ “rite Detailed Lag Information
o ......... Ne;.:t> .........
PR3 The device type displayed in Figure 11-2 is dependent on the system selected. For
= example, the UNIVERGE SV8500 options are:

[] Compile Installation Plan

[] Register System

[] Backup System Data Before Uploading Data
[J Upload Data To System

] Upload Yoice Mail Data
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Step 3 Select the features to use during installation.

—Compile Installation Plan
—Flash System Memory Card (SV8500 not supported)
—Register System
—Backup System Data Before Uploading Data
—Upload Data To System
—Upload Voice Mail Data
Step 4 Click the Next button to continue. Figure 11-3 displays for the
UNIVERGE SV7000. In the Select Installation Phase drop-down field,

choose the phased installation desired. Use the checklist on the dialog
box to ensure all restrictions are followed when using a phased

installations.
paY The Phased Installation Check List dialog box (Figure 11-3) will not display if the
= phased installation was not selected.
NOTE
= Click the Phased Installation Guide hyperlink for additional information on this
(’f;‘% procedure. A Microsoft Word document will display.
f/—\
REFERENCE
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Figure 11-3 Phased Installation Check List

Phased Installation Check List

The followving restrictions must be observed when using phased installations:

*  Phaze 1 (ie. "User Data + Hardvware Installation™) installstions must be performed on a clean initial “oice Server
databasze.

+ |tz recommended that all Yoice Server PIMsPIRs, Circult Cards, Media Gateways, Protocaol Hander (PH), and
Signaling Servers are mourted in phaze 1. Mounting additional hardware in later phases may have unpredictable
resutt.

+  Changing “oice Setver Fusion type (RMCRILCH] or Fusion Point code between phases is not permitted.

+  Additionasl updates and changes may be added using the MA4000 Management System or the MAT Tool betvween
installation phases.

*  Phaze 2 and higher inztallations reqguires synchronization with the Yoice Server before completing the compile
step.

Additional Resonrces: Phased Instalstion Guide

Select Installation Phaze |Phasze 1 Uzer Data + Hardware |nstallation j
- Type |
Internal FHD IMT PHD
£ BaCk _. ......... NEHt} ..........

Step 5 Click the Next button to proceed. Figure 11-4 displays providing the
progress status throughout the compiling process. It provides the status
of what is currently being compiled, a list of warnings, and a list of errors.
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Figure 11-4 Compile User Phone Assignments Progress

Compiling Installation Plan...

Azzigning Phone Button Data. ..

L[]

Install

Compiling Installation Plan._.

Removing Old Installation Plan. ..
Removing Old Installation Plan...

Compiling Inztallation Plan._.
Reszerving system ports. ..

Aszigning Aeserved Phone Humbers. .
Rezerved Phone Mumbers
Rezerved Stations Aszigned 0

Aszigning Manual Phone Humbers. .
b anual Station Humbers
Stationz dszigned 0

Aszigning Conference Station Humbers._ ..

Conference Station Humberz
Stations Aszigned [

Cancel

—If an error is encountered during the compiling process, Figure 11-5
displays.
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Figure 11-5 Installation Warning - Stop Installation Query

Installation Warning

A\

3

Inztallation Manager has encountered a data error.
Stop Installation?
e - Stop Inztallation [mmediately

Hao - lgnore Errar and Continue
Moto Al - Ignore &l Errors

Mo Mo bo Al

—Select the Yes button to halt the installation immediately.
—Select the No button to ignore the error encountered and continue.

—Select the No to All button to ignore this error and others
encountered.

Step 6

When the compiling process finishes, Figure 11-6 displays.
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Figure 11-6 Initialization of System Flash Card

Initialization of System Flash Card

The =ystem comes with an empty PCMCIA flazh card. Befare you can start using your system, you need to install the
necessary system software onto the Flash card. You will use the NEC Flash card toal (FLEY TR for this process.

Requirements:
PCWMCIA flash card
MNEC svstem software CD ROM
Irtel compatible laptop or desktop with PCMWCLA Card Slot

Initialization Procedure:
1. Inzert the Flash Card into the PC PCMCIS siot.
2. Inzert the MEC system software CDinto the 0 ROM Drive
3. Click onthe Inttizlize "Initialize Flash Card..." button

Initialize Flazh Card...

CD-ROM drive

PCKCIA slol

Flash Card
Bak - T
2 UNIVERGE SV8500 is not supported.
NO;TE
The flash card installation needs to be installed using the MPS System CD-ROM.
IMPORTANT

Step 7 To initialize a System Flash Card:

—Insert the Flash Card into the PC PCMCIA slot.
—Insert the SV7000 software CD into the CD-ROM drive.
—Click the Initialize Flash Card ... button.
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11-8 Install

—When complete exit the program. Figure 3-31 and Figure 11-7 or
Figure 11-8 displays.

PR3 When Figure 3-31 displays, perform the steps necessary to proceed with SV7000
= installation.
NOTE

Figure 11-7 Installing SV7000 Flash Card

Installing SV7000 Flash Card

Thiz zection explains the procedure to initialy stadup SW7000T. Prepare the Flash Card contsining
required program and software for the =% F000T side. Mote: your =¥ 70005 zide was prestaged before shipping.

Installation Procedure:

Remove the front cover using a Phillips screw driver.

et the switches onthe front panel referring to the settings below:

et the SEMZE wheel to position "2".

Firmly insert the prepared Flash Card into each PC card slot of S5 7000T.
Take notice not to mix up the Flash Card for SW7000T.

5. Powwer up system.

L

SYSTEM switch

SV7000T

SEMSE switch

",
-,

SVT000 T (Dual CPU

SV7000 5

< Back Mest »
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Figure 11-8 Installing IPX Flash Card

Installing IPX Flash Card

Thiz section explains the procedure toinitialy stadup MEAX IPX. Prepare the Flash Card cortaining reqguired program and
zofteware for the [PX.

Installation Procedure:

Remove the front cover using a Philips screwy driver.

Set the SERSE wheel to position "2".

Fitmly insert the prepared Flash Card into the Flazh Card slot.
Place the card guard in the up position.

Powver up system.

h = L)k —

DEP (PZ-DK2Z3T)

“, LANI{PZ-PCIS)  _ap (pZ-PC19)

L DB\ 1
=
Flash Card
Card Guard

SENSE

[ |
RJ45 Connaclor /
({Ta External LAMN) ISAGT (PLZ-(3T25/26)

< Back | Mext |

Step 8 Follow the installation procedures listed.

Step 9 When the system is powered up, click the Next button. Figure 11-13
displays.
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Figure 11-9 System Software Registration

System Software Registration

Al newy Yoice Server systems need to be registered with NEC. The registration process will activate the YWaoice Server
system. The MEC Registration tool swill callect customer information and then contact NEC's Registration Server 1o get the
license key required to activate the Vaoice Server.

Requirements:

+  Inztall System Software. Refer ta the system installation manual for instructions.
* |nternet Connection or Modem with external phone Line

Reqister System...

FG

R NEC
niarna Registration
Sanver
TCRIP
Modem
¢ Back et

Step 10 Activate the registration process by clicking the Register System button.

gonss See “If the Initial Installation Execute button is clicked, Figure 3-32 displays.” on

= page 3-26 for the steps required to collect the customer information, contact NEC'’s
Registration Server, and obtain license key required to activate the SV7000.

Step 11 When the Registration Wizard process finishes, Figure 11-10 displays.
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Figure 11-10 Backup/Restore Voice Server Data Memory

Backup System Data Memory

It iz recommended that you perfarm a spstem backupdrestore at thiz ime.  Chooze the appropriate option below and then zelect
System data memary area's bo backup.

YWhen finizhed click on the nesxt buttan,

" Skip System Backup/Bestore

i+ Backup System Data Memory onto PBX Hard Drive

[f thiz iz the first time pou are attemnpting to load data to the Syetem, |t iz recommended that you perform a Memory to
Hard Drive backup to prezerve the eristing pragram data in case of inztallation upload failure.

PBx Drata Areas
[v Data Memony [v Mame Dizplay
[ [
=
PB# Lozal Processar [LP) Data Areaz
[v Call Forwarding [v Logout Transfer LP IT
B B
[ [
B B
< Back Meut »

Step 12 Select the type of backup to perform then select the Next button. Figure
11-12 displays.
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Figure 11-11 Media Gateway Setup

One of more Media Gatesways have been configured.

If wou have not alteady done 2o, you must do the folloswing:
+ |nthe Hardware Information / Media Gateway & Circuit Cards tab select each Media Gatevay device and then

click the Setap AAG... button and follow the directions.
+ [n=zure that all Media Gatevways are connected to the network .

HOTE: Failure to configure these devices may render the voice system inoperable and may require additional
programming using the MAT.

Click the Hext > button to continue installstion

%;a:;—:ﬁf:_]j ?

o
MIEC LT WL
G

MNEC =
FTTA ! =
> = -
‘ MNEC - ‘
S -
.

Step 13 Ensure each Media Gateway has been configured and connected to the
network, then select the Next button. Figure 11-12 displays.

pA33) The Media Gateway Setup dialog box will not display if there is no Media Gateway
= circuit card inserted.
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Figure 11-12 Upload Data to System

Uploading Installation Plan...

Inztallation Manager connecting to System: 172.16.253.0 Port: 60000

Uploading Installation Plan...

Installation Manager connecting to System: 172.16.253.0 Port: GO000

£ >

Cancel

Step 14 After the installation plan upload finishes, Figure 11-13 displays.
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Figure 11-13 Voice Mail Server Setup

gk | [N ]

Step 15 Click the Next button. Figure 11-14 displays.
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Figure 11-14 Installation Complete

Installation Complete

Installation Manager has successfully completed all requested actions.
To complete the installation process you may need to perform the following:

+  Check the Detailed Log file to make sure no errors have occurted during the load
procedure to the YWaice Server

+  |tiz recommended that you back up yvour Woice Server and reset the system when all
the programiming is complete

+ Tointegrate the Woice Zerver into a Fuszion Metweaork, you will need to uzer Network
Manager located under the Tools menu.

Detailed balid fog at
CAProgram Files\MECnstallationkor B2 4\Buildl og.himl

< Back . Finish

Step 16 Click the Finish button to complete the installation process.
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Reports

This chapter describes the MA4000 Installation Manager’'s Reports
section (Figure 12-1).

The user will be able to print several useful reports. Many reports won't
be meaningful or useful until the information has been compiled. If
there is not sufficient information when a report is launched the user will
see a blank report.

Figure 12-1 Reports - General Tab

m Installation Manager,

File Edit Tools Help
Project
Infarmatian General | Technical | Desi Label
Hardware Extension Report
Infarmation = : i
Syztem =
Infarmation
i) Location Diversity Report
Features - Dizplays Pool Mumber Uzed List, Station and Station/Fey Template Report,
User
Azzignments
m==a | Station Range Report
Group —] [ 3 : ;
e = ) Dizplays Station Fange and Reserved Stations.
Circuit Card
Azzignments L3
m== | Task Report
= = Dizplayz Tagks
Install = =
Reports
m== ] UserAcceptance Sign Off Report
= Dizplayz a List of Reports for Sign O Acceptance Signatures.
Froductivity H
Features = bt

Table 12-1 lists all the reports available and provides a brief description
of each.
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Reports
Creating and Printing a Report or DESI Label
Step 1 Click a report to select it, then click Run. The report dialog displays.
Step 2 Click a radio button, drop-down list, or check box to specify the report's
scope, then click OK.
gonss The options available varies with each report.
NOTE

Installation Manager creates the report and displays it in a new window.

Table 12-1 Description of Reports

Extension Report

Location Diversity Report

Station Range Report
Task Report

User Acceptance
Sign Off Report

Voice Mail Report

General Tab Reports

Displays User Data - Users, Extensions, Phone Models,
Restrictions, Groups, Call Forwarding, Button, and Voice Mail
templates.

Displays Pool Number Used List, Station and Station/Key Template
Report.

Displays Station Range and Reserved Stations.
Prints a report of all tasks for a project.

Prints information to be used by CSR to obtain the customers
acceptance of the user and phone configuration. User selects which
reports to include: Extension Detail, Extension Summary, Groups,
Voice Mail Report.

Detail and Summary reports. Prints Mailboxes defined, extensions
associated to, templates assigned.

Call Forwarding Report

Access Codes and Speed
Calling Codes Report

Group Report

Hardware Report

Least Cost Routing and System
Feature Report

Phone Placement Report
Restriction and Feature Report

Technician Cut Sheet

Technical Tab Reports
Displays Call Forwarding Data - Users, Extensions, and Templates.
Displays Access Codes and Speed Calling Codes.
Displays Group Data - Circular Hunt, Pilot Hunt, UCD Hunt, and

Rollover.

Displays Hardware Data - Circuit Cards, Phone Models, and Phone
Adapters.

Displays Least Cost Routing and System Feature Data - Local and
Network LCR Patterns, Time of Day, and System Feature (ASYD).

Displays Phone Placement Data - Users, Extensions, Phone
Models, Cord Lengths, Organizations, and Locations.

Displays Restriction and Feature Data - Route Restriction (RSC),
Toll Restriction, and Service Feature Restriction (SFC).

Displays Hardware Installation Information - Extensions, IMGs,
PIMs, SLOTs, and LENS.

DESI Label for Series i
(DTR-16D)/DtermlP (ITR-16D)

DESI Label Reports

Prints Desi labels for a single user, for a range of users, or for all
users.
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DESI Label for Series E Prints Desi labels for a single user, for a range of users, or for all

(DTP-16D) users.

DESI Label for Series i Prints Desi labels for a single user, for a range of users, or for all
(DTR-2D) users.

DESI Label for Series E Prints Desi labels for a single user, for a range of users, or for all
(DTP-2D) users.

DESI Label for Series i Prints Desi labels for a single user, for a range of users, or for all

(DTR-32D)/DtermIP (ITR-32D) | users.

DESI Label for Series E Prints Desi labels for a single user, for a range of users, or for all
(DTP-32D) users.

DESI Label for Series i Prints Desi labels for a single user, for a range of users, or for all
(DTR-8D)/DtermIP (ITR-8D) |users.

DESI Label for Series E Prints Desi labels for a single user, for a range of users, or for all

(DTP-8D) users.
DESI Label for DtermIP Prints Desi labels for a single user, for a range of users, or for all
(ITR-4D) users.
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Productivity Features

This chapter describes the MA4000 Installation Manager’s Productivity
Features section (Figure 13-1) tabs.

Chapter Topic e Configuration Tab
e Management Tab
e Diagnostic Tab
e Maintenance Tab

Figure 13-1 Productivity Features Tab

m Installation Manager

File Edit Tools Help
Project : :
Infiormation Configuration b anagement Diagnostic M aintenance.
Hardisare UC Suite - MA4000 Manager
Information j e
Upload Installation Manager data to MA4000.
Syztem
Infiormation
i H
Advanced = Clipboard
Features The Clipboard application iz a simple to uze batch update prograrm supparting over 100
MAT commands for both buzineszz and hospitality sypstems,
[RE
Agzignmentz
o Location Diversity
Giraup ',f‘l“ y Frovides [P telephone Fail-over services in a P2P Fusion network,
Aszignments F a3
L 3‘:;-‘?
- T
ok e
Circuit Card
Agzignmentz
Irstall
Reparts
Productivity
Features
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The Productivity Features menu provides access to applications you
use in conjunction with Installation Manager. These applications launch
in a separate window and perform specific functions you need to
configure your system properly. Some of these applications are also

available from the Tools menu.

The Tools tab contains four sub-tabs:

Configuration
Management
Diagnostic
Maintenance

Some options within a tab may not display, or may not be available,
based on your system type and certain options you selected during your

system's installation.

Configuration Tab

The Configuration tab (Figure 13-2) consists of the following

applications:
e UC Suite - MA4000 Manager

e Clipboard

e Location Diversity

Allows the user to load existing
Installation Manager data to the
MA4000.

Provides the user with integrated
access to the MAT Clipboard
application (see Clipboard... for
additional information on this
option).

Provides fault tolerance for IP
telephones in an FCCS (Fusion)
network by providing stations the
ability to register with up to two
back-up IP-PBX nodes in the
network providing fail-over services
to the physical/virtual station in the
event of a communications failure
between the station and its primary
IP-PBX.

Note: While the IP terminals are
under the control of a backup node,
the station can continue to function
until the primary node becomes
available. Not all station
functionality is available while it is
operating on one of the backup
nodes (for example, appearance,
dependencies, etc.)
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Figure 13-2 Productivity Features - Configuration Tab

Configuration | {anagement Diagnostic M sintenarice.,

UC Suite - MA4000 Manager

Ipload Installation b anager data o k444000,

3 Clipboard
The Clipboard application iz a simple to use batch update program supparting aver 100
MAT commands for bath buziness: and hospitality systems.
f.r_t" Location Diversity
,-’r_,.fll‘h_ "-l Provides P telephone fail-over services in a P2P Fusion netwark.
|
=
;?H— ERS
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UC Suite - MA4000 Manager

Step 1  Select Tools — Configuration — UC Suite — MA4000 Manager, then
click the Run button. Figure 13-3 displays.

Figure 13-3 UC Suite - MA4000 Manager

MA4000 Configuration X
k&4000 Connection Settings k&A000 Transfer Settingz
Foot LURL | Fuzion Metwork, M ame |
v Uszer Infarmation | Button Templates
Uzer Mame |
[v PB Settings [ CF Templates
Pasaward | [v Qrganiztion Leyvel
D ezcription Date Uploaded to PEx | Phaze
FPhaze 1 User Data + Hardware Installa.. 1
£ >

Start | Stop Wiew Status Test Connectian R eturn

Step 2 Enter the MA4000 connection and transfer settings described in

Table 13-1.
gonss The server information entered in this section are added to the database and used
= when data is transferred to the MA4000.

—Click Start to load the Installation Manager data to a MA4000.

—Click Stop to end the data uploading process to the MA4000 before
the transfer finishes.

—Click View Status to display a dialog showing detailed progress
information about the current transfer. See Figure 13-4.

—Click Return to return to the Tool’s Configuration tab.

—Click Test Connection to ensure the MA4000 connection settings (for
example, Root URL, etc.) are correct and MA4000 is running properly.
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—Click Return to close the MA4000 Configuration dialog. This selection
does not stop a current upload in progress.

Table 13-1 MA4000 Configuration Connection and Transfer Settings

Field Description

MA4000 Connection Settings

Root URL Enter the URL address for the MA4000 (for
example, http://<host name>/MA4000).

User Name Enter the MA4000 user name to connect to the
MA4000 web services.

Password Enter the MA4000 password to connect to the

MA4000 web services.

MA4000 Transfer Settings

Fusion Network Name
M MA4000

Edit > OK —
— NCN

New — Create—% _

+
Edit > OK —

| LoN {
New — Error —e—

L Stand-alone

Enter the Fusion Network Name of which the PBX
is a part.

s [f the Fusion Network Name does not match the
MA4000 database, and the Fusion Point code is
a NCN, then create a new Fusion Network and
add the PBX.

« If the Fusion Point code is a LCN, an error will
return indicating the Fusion Network does not
contain a NCN / No Fusion Network Found.

« If the Fusion Network Name does match the
MA4000 database, and the Fusion Point Code is
a NCN, then if the PBX details match the NCN
node in the MA4000 Fusion Network, a PBX Def
ID of the existing PBX is returned. Otherwise, an
error displays indicting the Fusion Network
already contains a NCN.

If the Fusion Point code is a LCN, then the PBX
needs to be added to the matching Fusion
Network as a LCN node.

* If the Fusion Network is standalone, then create
a PBX.

PBX Settings

Select to ensure the transfer of the PBX settings
to the MA4000.

User Information

Select to ensure the transfer of the user
information. See User Assignments.

Note: The transfer of the PBX Settings option is
automatically selected if this option is
selected.

Organizational Level

Select to ensure the transfer of the Organizational
level information. See User Assignments.
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Figure 13-4 View Status Example

] USG Services Status

Stabuz of Projectz uplbaded ha M& 4000

Project M ame UC_Suked ...l

Save Report | ‘iaw Raport |

Stahuz Type
[v Summany [ Emee

I:lme|

MA4000
Information

[T Tiarciamed

Status for Project :UC_Suite1
Report Time: 1/10/2008 1:47:57 PM

Overall Status: Transferred

\Connection Information

MA4000 URL

User
MName

Error
Description

Fusion
MNetwork

hito: #rockstat testiab xvztest com/MA4000 || imsith

daa

PBX
. Status: Transferrad
Details
Summary
Total i
Records Transferred Error Pendmg
| 1 I 1 | 0 | 0 |

Oraanization
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Location Diversity

Location Diversity allows you to register an IP telephone with up to two
backup nodes when operating in a Fusion (FCCS) network. If the
telephone is unable to communicate with its primary IP-PBX, the
telephone automatically connects to one of the designated backup
nodes. The telephone can continue operating under the backup node
until the primary node becomes available. While connected to a backup
node, some node-specific features, such as appearances and
dependencies, are not available.

Step 1  Select Tools — Configuration — Location Diversity, then click the
Run button. The Figure 13-5 warning dialog displays.

Figure 13-5 Warning - CPU Occupancy Level

Running location diversity could raise CPU occupancy level.

Depending on the fusion network size, this process may take
longer to finish than normal.

This wersion of the Lacation Diversity supports P2P FCCS only.
Refer to [L-55] Lacation Diwversity in the Feature Programming

Manual or FCCS Lacation Diversity in the FCCS Metwark System
Manual far further details.

Step 2 Read the warning information then click Continue.

The IP Address is defined in Connect Type section. See Hardware Information.

) —

Connect Type
NOTE ~ TCRAP Addiess [172. 24 132, 21 User ID Test
L Port [60000 Pasonort Setup IP..
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Location Diversity - FCCS Tab

Before you can begin configuring Location Diversity you must scan your
Fusion network so Installation Manager can save node information to its
database. Installation Manager saves the following node information:

Extension

o TEC

LEN

Station Pool
Station Backup
Key Template

Figure 13-6 Location Diversity - FCCS Tab

Location Diversity

FCCS l Station Backup] Station Pool Data] Eey Template] A0V ] AFChM ] Upluad]

Fusion Entry Node C M 13 2 Get Network Data | B/4/2008 9:21:10 &M

| FFC | Spstern Mame | Address | Spztern Tope | Revizion | Last Synd
; 17224132 21 UMIVERGE S%7F000  [24.02.02.000

2 (P44 1722413244 NE&AX 1P 24.02.02.000

3 SWTo00_47 1722413347 UMMERGE 5w7000  24.02.02.000

£ ¥

Yiew Log [v Detaled Log Synch Highlight the PB*z and presz Synch

Step 2 In the FCCS tab, enter the IP address of your Fusion network's entry
point in the Fusion Entry Node field, then click Get Network Data.
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—Installation Manager scans your network and displays a list of its

nodes. For each node, the list displays the date and time it was last
synchronized (if any).

gani The Get Network Data option allows Installation Manager to retrieve the current
= NDM data (for example, a list of backup stations, pool data, key template data, efc.).
NOTE

Step 3 Select the node you wish to synchronize and click the Synch button.
Figure 13-7 displays.

Figure 13-7 Location Diversity - FCCS Tab - Getting Location Data

Location Diversity

FCCS 1 Station Backupi Station Pool Data | key Template1 ADWVE 1 AFCHM i L||:|I|:|a|:|1

Fusion EntyMode | 972 24 132 . 2 Gt Metwark Data ]5;432009 9:21:10 4M

| FIFIE I Spstem Mame _] Address Spstem Type l R evision ] Last Synci
1722413221 |UMIVERGE SW7000  |24.02.02.000
2 (a4 1722413244 ME&XIPH 24.02.02.000

3 SVT000_47 1722413347 UNIERGE SY7000  24.02.02.000

Installation Manager

Getting LENS
Information for FPC 1

Cancel

< | >
Yiew Log [+ Detailed Log Synich Highlight the PExz and prezs Synch
pa3%) Access to the Location Diversity feature tabs are blocked during the synchronization
= process.
NOTE

—After successful synchronization, the Extensions, TEC, LENS, Station

Pools, Station Backup and Key Templates are saved in the database.
See Figure 13-8.
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Location Diversity - Station Backup Tab

Selecting the Station Backup tab (Figure 13-8) results in a table listing
the existing backup nodes for visiting stations.

Figure 13-8 Location Diversity - Station Backup Tab

Location Diversity

FCCS  Station Backup | Station Pool Data | Key Template | ADVF | AFCMN | Upload |

Currently It Supparts TH-1 and LGH-1

| TELM | IP-KIND | TEC | Primary | 5TH-1 | LENS1 | THA1 | SFC1 | RSC | Secadl
5051 [IP+VPS 5051 : T F 2
071 Mane I E071 072241 1 1 1

052 IPAFS 61 052 073222 1 5 5 z
5072 Diem P 12 1 5072 073212 1 1 1 2
5072 Dtem P 12 1 5073 073213 1 1 1 2
E074  Diem P 121 B074 073214 1 1 1 2
B075  Dtem P 12 1 §075 073215 1 1 1 z
BO26  INASET 121 B026 07372 T 1 1 2
5076 Mone 18 1 5076 072242 1 1 1

E027  INASET 121 B027 0731731 1 1 2
050 IPAFS 61 050 073220 1 5 5 z
5000 Mane 1% 1 5000 072240 1 1 1

< »

=

Edit Delete
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Designating Primary, Secondary, and Tertiary Backup Stations

Users can select multiple Primary stations and assign them to the list.

Step 1  To designate Primary, Secondary, and Tertiary stations, click New.
Figure 13-9 displays a list of existing backup stations.

Figure 13-9 Location Diversity - Designating Backup Stations

M Station Backup

X]

Primary TELM Backup Modes Kind of IP Station
FPC |1 - Secondary - Tertiary - IP-KIND |
TELM | TEC | Backup Station
R028 3
o513 TELM | TEC | IP-KIND | TENANT | SFC | RSC |
AO41 12
ao4z 12
B043 12
R0a4 12
ROET 12
a0Ez 12 ==
RO0E3 12
ROGY 12 .
ROeaE 12 J
03 12
ROF0 12
R024 12
RO02R 12
053 26
L T R
L T
Ik MEW TELM Cancel
gonss The TELNSs listed in the Primary TELN section shown in Figure 13-9 only display
= when a PBX Fusion Point Code is selected from the FPC drop-down menu.
NOTE

MA4000 Installation Manager User Guide - Revision 7

Step 2 Use the FPC drop-down menu to select the Fusion Point Code of the
PBX containing the station you wish to configure for Location Diversity.

Step 3 Select the primary stations (multiple stations can be selected) from the
TELN/TEC list, then click >> to add it to the Backup Station section.

—Installation Manager’s location diversity automatically finds the
available pool numbers. If pools are not available, Location Diversity

creates new pools.
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Step 4

Step 5

Step 6

Step 7

Step 8

Click the backup stations (multiple stations can be selected) in the list to
select it, then use the IP-KIND drop-down menu to specify whether the
backup station is a Dterm IP, SIP phone, etc.

Click the Secondary drop-down menu to specify the PBX to which the
selected station will attempt to connect if communication with the primary
PBX fails.

(Optional) Click the Tertiary drop-down menu to specify the PBX to
which the selected station will attempt to connect if communication with
both the primary and secondary PBXs fails.

(Optional) Click New TELN to create a new extension number for the
backup station.

Use only if there is no TELN number listed in the Primary TELN section.

Click OK to accept the assignments.

—The new backup station displays in the list with a green background,
indicating the data has not yet been uploaded to the PBX.

Editing Existing Backup Stations

The editing process allows the Installation Manager user to modify the
following:

e Pool Number
e Tenant

e SFC
e RSC

e Name Display
e Key Template
e MAC Address

Step 1

Step 2

Use the FPC drop-down menu to select the Fusion Point Code of the
PBX containing the station you wish to edit.

Click a station in the TELN/TEC list, then click Edit. Figure 13-10
displays
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Figure 13-10 Location Diversity - Extended Backup Data

Extended Station Backup Data (TELN = 7028)

Primarsy

FPC PHUM

IP-KIMD LEMN
R3C | 3TN

M aFC

Ju

[ Remove Secondary Data
Secondary

FPC

PHUM |Mone hd IP-KIMD LEM | 000150
R5C 1 - | STM | 2077

M SFC

Ju

I Remove Tertiary Data

Jull e
i RRINEL

Tertiary
FPC |1 - PMUM |2 IP-KIND LEM
™ |1 - SFC RSC 1 - | STH 5077
Mame Display ey Template
Mame Display | [
[ Mo Mame Display Key Template J
[ Use Primary's Mame Display From ARDD MaC Address

_H
Master Extension | | III ﬂ Gek MAC
Master LGN Masker TELM [ Fax |

Flodify | Zancel

Step 3 (Optional) Use the Remove Secondary Data check box to delete
existing data for the secondary backup station.

Step 4 Use the drop-down menus in the Secondary pane to edit any of the
following items for the selected backup station when connected to the
Secondary backup PBX:

—FPC
—PNUM
—IP-KIND
—TN
—SFC
—RSC
—STN
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Step 5 (Optional) Use the Remove Tertiary Data check box to delete existing
data for the tertiary backup station.

Step 6 (Optional) Use the drop-down menus in the Tertiary pane to edit any of
the available items for the selected backup station when connected to
the Tertiary backup PBX.

Step 7 In the Name Display pane, do one of the following:

—Enter a name which will display when the backup station is connected
to the secondary or tertiary PBX.

—Select the No Name Display option button to specify that no name will
display when the backup station is connected to the secondary or
tertiary PBX.

—Select the Use Primary's Name Display option button to specify that
the selected backup station will display its primary name when
connected to the secondary or tertiary PBX.

Step 8 Use the Key Template drop-down menu to specify which key template
the backup station will use when connected to the secondary or tertiary
PBX you can specify that the station will use no template, or a key
template that was previously defined in the Key Template tab, or a
customized template with no name.

If you choose to create a template with no name then that template applies only to
the backup station you are editing and will not be available to other backup stations
or listed in the Key Template tab. In essence, you are creating a "one-time-only"
template.

Step 9 Use the MAC Address field to change the backup station's Machine
Access Code address.

Step 10 (Optional - for TEC type 26 only) In the VPS Settings pane, use the text
fields to enter the voice mail port number (VPSNO) and channel
(VPSCH).

Step 11 Click Modify to save the edited data. Installation Manager saves the
edited station data and displays the station name in the status list with a
blue background, signifying the data has been modified but not yet
uploaded.

Deleting Existing Backup Stations

Step 1 Use the FPC drop-down menu to select the Fusion Point Code of the
PBX containing the station you wish to delete.

Step 2 Click a station in the TELN/TEC list to select it, then click Delete.

—A confirmation dialog displays, asking if you wish to delete all the
station data.
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Step 3 Click Yes to delete all the station data, or No to delete only the backup
station from the list.

—The entry now displays in the backup station list with a red
background, indicating the station will be deleted during the next
Location Diversity data upload.

Step 4 Use the backup station list to select a station scheduled for deletion
(displaying a red background), right-click the name to display a context
menu, then select UnDelete.

—The station now will not be deleted during the next Location Diversity
data upload.
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Location Diversity - Station Pool Data Tab

Installation Manager Location Diversity allows users to reserve
extensions by creating station pool data. See Figure 13-11.

Installation Manager displays a list of station pool information showing
the last previously synchronized pool data. You can add new pool data
(if there is none existing and you configure a backup station, Installation
Manager creates it automatically), edit existing data, or delete an
existing entry. Station pool data includes:

¢ Pool Number

e FPC

e TEC Type

e Starting Station
e Starting LEN

e Sjze

e Ending LEN

Figure 13-11 Location Diversity - Station Pool Data Tab

Location Diversity

FCCS | Station Backup  Station Pool Data | Key Template | ADVF | AFCMN | Upload |

[PMUM | FPC [ TEC | STN | StatLENS | EndLENS | PoolS.. | Assigned | Stat

R R P T [ 013007 5 T |

2 3 12 3069 073000 073007 8 B

3 2 12 2077 000160 000167 8 3

4 3 12 3069 073030 073037 8 3

5 3 18 078 073240 073247 8 0

22 2 3 2000 013010 013017 8 0

33 3 3 3000 070000 070007 8 0

< | =
Mew Edit Delete

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



Productivity Features 13-17

The user can also add new pool data or edit/delete an existing pool.

Installation Manager displays the last previously synchronized pool data
in the table.

The Status column identifies the transaction. The fields are:
e <Blank>

P339 Indicates existing pool data that has not been modified/deleted.

—) ——

o New
e Modify
e Delete

Creating New Station Pool Data

Step 1 To create a new station pool data, click New. Figure 13-12 displays.

Figure 13-12 Location Diversity - Pool Data

Pool Data rz|

Paal Number ~|  FPC |1 ~| TECType |3DP/PE |  Starting Station

Size |8 - Skarting LEMS | goooy - Ending LENS

Maodify | Cancel

—The Pool Number field is automatically assigned with the first
available pool number.

Step 2 Using the FPC field, select the FPC where the pool will be created.
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Step 3

Step 4

Step 5

Step 6

Step 7

Use the TEC Type field to select the appropriate pool number.

—Installation Manager’s location diversity populates the available LENS
based on the TEC Type and Pool Size.

Enter the beginning station of this pool in the Starting Station field.

Select the size of the pool using the Size field. The size are in blocks of
eight.

Use the Starting LENS field to specify the first Line Equipment Number
to assign to the pool.

—The Ending LENS field is automatically calculated when the Starting
LENS is determined.

Click Modify. The information is saved to the database and the pool data
status is displayed as New.

Editing Station Pool Data

Step 1
Step 2
Step 3

Step 4

Use the list to locate the data you wish to edit, then click to select it.
Click Edit. The Pool Data dialog displays.

Use the drop-down menus and text fields to edit any of the following, as
necessary:

—FPC

—TEC Type

— Starting Station

—Starting LEN

—Size

Click Modify. Installation Manager saves the edited station pool data and

displays it in the status list with a blue background, signifying the pool
data has been modified but not yet uploaded.

Deleting Station Pool Data

Step 1

Step 2

Highlight the desired station pool data to be deleted from the table list,
then click Delete. The entry now displays in the station pool data list with
a red background, indicating the data will be deleted during the next
Location Diversity data upload.

Use the station pool data list to select a pool number scheduled for
deletion (displaying a red background), then right-click the name to
display a context menu. Select UnDelete. The pool data now will not be
deleted during the next Location Diversity data upload.

If the station pool is already being used in the Station Backup, an error message

= displays notifying the user of the condition. The user must delete all the Station
Backups that are assigned to the pool before removing it.

—After successful verification, the row status is marked as Delete.
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Location Diversity - Key Template Tab

Installation Manager Location Diversity allows users to create new Key
Templates and save the new template data to the database. See
Figure 13-13.

Figure 13-13 Location Diversity - Key Template Tab

Location Diversity

FCCS | Station Backup | Station Fool Data Key Template | ADVF | AFCMN | Upload |

| Template Mame | Line Key pattem | Statusg ||
1ELine/Function keps + 16055 Feys MODIFY

1EBTMwSubline 1ELine/Function keys + 16055 ey

24Button 24Line/Function Keys + 8055 Keps

JZ2Button F2Linez/Function Keys

M e Edit Delete
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Creating or Editing a Key Template

Step 1  To create a new Key Template, click New. Figure 13-14 and Figure 13-15
display.

Key Template Data E

Base Information l Funchion Key ]

Figure 13-14 Location Diversity - Key Template - Base Information Tab

Priarity af Answering Call

|Line Selection

Line Preference

Far Speaker butkan (SPK)

Message Waiting Display
|On the kop line ﬂ

|F'rime Line Preference

Faor Answering butbon (AR5 Soft-Key

ﬂ Line key Pattern
|1EuLine,|'Funu:tiu:un keys + 16035 Keys ﬂ

|F‘rime Line PreferencelButton Location Ascending Orderﬂ

For Criginating button (ORE)

Pattern

1 [

|F‘rime Line PrefrencefButton Location Ascending Crder) ﬂ v Don't Display Page Scroll Key [ =3] [PG]

Ik | Cancel

—Enter the template's name in the Name field or edit it, if necessary.

—Use the Priority of Answering Call drop-down menu to specify
whether incoming calls should be answered based on Line Selection,
Dial/Automatic/Manual Intercom lines, or a combination.

—Use the For Speaker button (SPK) drop-down menu to specify that
the SPK button selects the prime line. (Currently the only available
option.)

—Use the For Answering button (ANS) drop-down menu to specify
whether the ANS button accepts the Prime Line, Incoming Line, or
Ringing Line preference.

—Use the For Originating button (ORG) drop-down menu to specify
whether the ORG button accepts the Prime Line or Idle Line
preference, or a combination of the two.

—Use the Message Waiting Display drop-down menu to specify
whether a message waiting indicator displays on the top or bottom line
of a station's LCD display.
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—Use the Line Key Pattern drop-down menu to specify the number and
type of key patterns assigned to the station.

—Use the Pattern drop-down menu to specify one of 16 key patterns the
station will use.

—Use the Don’t Display Page Scroll Key [>>>] [PG] check box to
choose whether to display a Page Scroll Key [>>>] [PG] on the display.

Figure 13-15 Location Diversity - Key Template - Function Key

Key Template Data PX|

Base Information  Function Key ]

Marme Feature Type

|tation -

Station Yalue

k.en D escription L

1 SUBLINE |SUBLINE -]
2

3 156: Yisitor Indication TELM

4 142: Logout [for IP Enabled Dt...

5

3

7

2 Ringing Information
9

10

11

12

13

14 w

£ b3

Flex Keys |Disable Flex Keyvs ﬂ Clear Keys |

FEY 156 is recommended key ko be assigned in button template.

Ik | Cancel

—Use the Feature Type drop-down menu to specify whether you wish to
add a Function or Station to the selected function key.

—If you selected Station, use the Station Value drop-down menu to
specify whether the station is a MYLINE, PRIMELINE,
MYLINE=PRIMELINE, or SUBLINE. Options available for each are:
MYLINE Ringing Information

PRIMELINE TELN number, Restrict OG (Off Hook
Suppression), and Ringing Information

MYLINE=PRIMELINE Restrict OG (Off Hook Suppression),
and Ringing Information
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SUBLINE TELN number and Ringing Information

If you selected Function, use the Features By Name list to select the
feature you wish to assign to the selected function key. You can use
the drop-down menu to limit the list to specific feature categories.

—Use the Flex Keys drop-down menu to enable or disable Flex Keys.
—Click the Clear Keys to remove all function key assignments.

For field information, see “User Assignments - New or Edit User” on page 8-6.

paY Selecting Prime Line enables the Off Hook Suppression control for the user to
= select.
NOTE

Step 2 Click OK to save the key template data.

Deleting an Existing Key Template
Step Highlight the template to be deleted, then click Delete.

—Installation Manager schedules the key template for deletion during
the next Location Diversity data upload and displays the template
name with a red background.

Step 1  Use the key template data list to select a template scheduled for deletion
(displaying a red background), right-click the name to display a context
menu, then select UnDelete.

—The template now will not be deleted during the next Location
Diversity data upload.
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Location Diversity - ADVF Tab
Assignment of Default Value for FCCS Location Diversity

Installation Manager Location Diversity allows users to assign a default
value for the FCCS Location Diversity. This is the default value of the
basic information (UGN, TN, SFC and RSC) if these values are not
specified in the Location Diversity commands.

Step 1 Click the ADVF tab. Figure 13-16 displays.

Figure 13-16 Location Diversity - ADVF Tab

X

Location Diversity

FCCS ] Station Backup] Station F'u:u:uIData] Eey Template ADYF l.ﬁ.FEMN] Upluad]

ADYVE [Defaults for Location Diversity)

[v Use az default walue of Service Feature Class SFC |15 -

[v Use as default value of Foute Bestiction Class

Step 2 Use the check boxes to select/deselect the following options, and enter
their values in the related text field:

—Use as default value of User Group Number: UGN
—Use as default value of Tenant Number: TN

—Use as default value of Service Feature Class: SFC
—Use as default value of Route Service Class: RSC

Step 3 Click Save to save the ADVF data or Reset to restore the settings to
their last previously saved values.
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Location Diversity - AFCMN Tab
Assignment of FCCS Location Diversity Miscellaneous Data for NDM

Installation Manager Location Diversity allows users to assign FCCS
Location Diversity Miscellaneous data for NDM. There are three types of

default data set in this command.
Step 1 Click the AFCMN tab. Figure 13-17 displays.

Figure 13-17 Location Diversity - AFCMN Tab

Location Diversity

FCCS ] Station Backup] Statiorn F'u:u:uIData] K.en Template] A0WF  AFCMN lLlplu:uau:I]

AFCMM [Azzignment of Location Diverzsity Mizec Data for HOM]

Made D ata Settings MALC Addrezs Setting Pazsword
Mater Hode IP Address C2 132 A

Pazzword |

Sub Master Mode IP Address | 17224 132 44

Paort Mumnber(default: G0Z10] |EEIE1 0 Canfirnation |

b oritaring Lewvel

Confirmn connectioh establishement with Home node[60-300zec] &0

| Station data synchronization processing time 00: 00—

Time value ta re-connect to Home Mode

¢ After confirmation of connection establizhernent with the Home Node(lmmediate switchover]
£ After station data synchronization i completed(S pecified-time switchover)

" Only when[visitar Indication] button is pressed[Manual switchower]

Save Reset

X

Step 2 In the Node Data Settings pane, use the appropriate text field to enter

values for the following items:
—Master Node IP Address

—Sub Master Node IP Address
—Port Number (default port is 60210)

Step 3 Inthe MAC Address Setting Password pane, enter your password in

the appropriate field, then enter it again to confirm it.
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Step 4 In the Monitoring Level pane, enter a value between 60-300 seconds to
specify how long a backup station waits before attempting to re-establish
a connection to its original PBX.

Step 5 (Optional) In the Monitoring Level pane, use the check box to specify
whether you wish to specify a station data synchronization processing
time, then enter a value in the related text field.

Step 6 Use the check boxes to control how you wish a backup station to behave
when attempting to reconnect to its original PBX. The options are:

—Immediate Switchover
— Specified-time Switchover
—Manual Switchover

Step 7 Click Save to save the AFCMN data or Reset to restore the settings to
their last previously saved values.
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Location Diversity - Upload Tab

Installation Manager Location Diversity allows users to compile and
upload specific data or all of the Location Diversity data to the FCCS
network.

Step 1 Click the Upload tab. See Figure 13-18.

Figure 13-18 Location Diversity - Upload Tab

!

Location Diversity

FCCS | Station Backup | Station Fool Data | Key Template | ADVF | AFCMN  Upload |

Select Upload Data
[v Station Backup Data | Pool Data [+ Template Data v &DYFAAFCMM

Compile

Step 2 Use the Select Upload Data check boxes to specify the type of Location
Diversity data you wish to upload, including:
— Station Backup Data
—Pool Data
—Template Data
—ADVF/AFCMN Data
Step 3 Click Compile, the compiling process begins, identifying potential

problems or conflicts with the data before the Upload process. See
Figure 13-19.
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Figure 13-19 Location Diversity - Upload Compile

Location Diversity

FCCS | Station Backup | Station Pool Data | Key Template | 4DWF | aFCMN Uplaad

Select Upload Data
[v Station Backup Data [ Pool Data v Template Data v AD0FAAFCMM

Compiling Location Diversity
Compiling Station Backup Data
Found O Mew Stationz
Found O Modified Stations
Found O Deleted Stations
Compiling 5ettings Data
Compiling Station Pool Data
Faund O Mew Paoaols
Found 0 Modified Pocolz -
Found 0 Deleted Pools
Compiling K.ey Template Data
Found O Mew Key Templates
Found 1 Modified Key Templates

|[&

Step 4 Clicking the Upload button sends all new and modified data to the fusion
network.

MA4000 Installation Manager User Guide - Revision 7

Download from Www.Somanuals.com. All Manuals Search And Download.



13-28 Productivity Features

Management Tab

The Management tab (Figure 13-20) consists of the following
application:

e Fusion Network Manager Allows the user to add Fusion

network nodes and manage network
telephone number.

= Refer to the MA4000 Network Manager User Guide for additional information
fé??}\ concerning the Fusion Network Manager feature.
=
REFERENCE
¢ Registration Wizard Connects the system to the NEC

Registration Service and obtains an
Activation Code for the PBX (see
Registration Wizard ... for additional
information on this option).

Figure 13-20 Productivity Features - Management Tab

Configuratian Management Diagrozhic kM aintenance.

MNetwork Manager

Reqistration Wizard {(Yer.1.19.0.1)

The Reqistration ‘Wizard connects wour system bo the MEC Registration Service and
obtaing your Activation Code for your PEE,

To complete the wizard, your computer must be connected to your
system via direct serial cable, TCP/IP, or a modem. Also, your computer
must use a modem or a TCP/IP network connection to the Internet to
communicate with the NEC registration server.

During the registration process, you must provide information about
your installation and setup. Some information is optional, but you must
supply the required information to complete the registration process.
The following information is mandatory:

e Site Information

— Customer Site Name

— Associate Contact Name

— Associate Contact Phone Number
e License information

— Hardware Key Code
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— Software Key Code
pa3%) Dual CPU systems require key codes for both CPUs.

) —

During the registration process, the wizard will connect to your system to obtain the

NOTE key codes automatically.
After confirming your license information, the registration server sends
the Registration Wizard an activation code. When you complete the
wizard it copies this code to your system and activates it.
Diagnostic Tab

The Diagnostic tab (Figure 13-21) consists of the following application:

¢ License Verification Tool Provides a summary of the primary
licenses that are available, and in
use, on the PBX system (see License
Verification Tool ... for additional
information on this option).

Figure 13-21 Productivity Features - Diagnostic Tab

Configuration Management ~ Diagnostic | paintenance.

ion Tool pro brief summary of the primary lice

oh your PE;

ganas) UNIVERGE SV8500 is not supported and the Run button is disabled.

) —
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Maintenance Tab

The Maintenance tab (Figure 13-22) consists of the following

applications:
* Flash Card Wizard

= button will be greyed out.

Formats, writes, and provides backup
for PBX files to a PCMCIA flash
memory card (see Flash Card Wizard
... for additional information on this
option).

The Flash Card Wizard option is not available for UNIVERGE SV8500, and the Run

e This option is not available for UNIVERGE SV8500.

e PCPro

Provides centralized online HTML-
based programming access, allowing
administraators to manage terminals,
schedule maintenance and firmware
updates, and remotely make moves,
additions, or changes (see PCPro ...
for additional information on this
option).

Figure 13-22 Productivity Features - Maintenance Tab

Configuration b anagement Diagnostic~~ Maintenance.

wiites, and backups PBx program files to a PC
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